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I  BOB. RASTR TASVIRLARNI QAYTA ISHLASH

1.1. Kompyuter grafikasi haqida tushuncha

Shaxsiy kompyuter va uning dasturiy ta’minoti rivojlanishi ham- 
da takomillashuvi kompyuter yordamida aw allari bajarib b o ‘ lin- 
magan vazifa va ishlarni am alga oshirish imkoniga olib keldi. 
Buning natijasida, kompyuter yordam ida tasvirlarni yaratish va 
ularga ishlov berish, ya’ni kompyuter grafikasi tushunchasi vujudga 
keldi. Shuni aytib o ‘tish kerakki, bungacha ham kompyuter gra­
fikasi mavjud bo ‘ lgan, lekin u, asosan, dasturlash tillari yordam ida 
yaratiladigan geometrik shakllar va tasvirlar ko‘ rinishida bo ‘ lgan.

Tasvirni (dastlab matn, formula, so ‘ng oddiy rasm) kompyuter 
ekraniga chiqarish kompyuter grafikasining rivojlanishida birinchi 
qadam  b o lldi. Q isqa vaqt ichida (o ‘ tgan asrning 50-yillaridan 
boshlab) kompyuter grafikasi tez sur’atlarda rivojlandi va o ‘ziga 
e ’tiborni tortdi.

Kompyuter grafikasi mustaqil yo‘ nalish sifatida X X  asrning 
60-yillarida paydo bo ‘ ldi va buning uchun maxsus amaliy dasturlar 
paketi ishlab chiqildi. U lar kesmalar yordamida chizish, chiziq- 
larni o ‘chirish, murakkab sirtlarni akslantirish usullari, soyalarni 
shakllantirish, yoritilganlikni hisobga olish kabi tamoyillarni o ‘z 
ichiga oigan edi. Bu yo‘nalishdagi ishlar vektorli grafika, ya’ni tas­
virlarni kesmalar orqali chizishni rivojlantirishga yo‘naltirilgan edi.

70-yillardan boshlab nazariy va am aliy ishlarning aksariyati 
fazoviy shakl va obyektlarni o ‘ rganishga qaratildi. Bu yo‘nalish 
uch oMchovli (3D) grafika nomi bilan atala boshlandi. Uch o ‘ lchovli 
tasvirlarni modellashtirish fazoning va jism lam ing uch o ‘ lchovligini, 
kuzatuvchi va yoritish manbalarining'joylashishini hisobga olinishini 
talab qilar edi. Murakkab sirtlarni akslantirish, relyeflar va ularning 
yoritilganligini modellashtirish bilan bog‘ liq m asalalam ing paydo 
boMishi uch oMchovli grafikaga bo‘ lgan ehtiyojni yanada oshirdi.

90-yillarda kompyuter grafikasining qoMlanish sohalari yanada 
kengaydi, uni keng tatbiq qilish imkoniyatlari paydo bo‘ldi. Natijada 
kompyuter grafikasining yangi yo‘nalishlaridan biri — haqiqiy tas­
virlarni shakllantirish vujudga keldi va shunday tasvirlarga ehtiyoj 
dizayn, arxitektura, reklama va boshqa sohalarda paydo bo ‘ ldi.
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Kompyuterlar funksional imkoniyatlarining kengayishi kom- 
pyuter grafikasining rivojlanishiga asos yaratdi va tasvirlar ani- 
matsiyasining yaratilishiga olib keldi. Bu yo‘nalishni uchta guruhga 
ajratish mumkin:

— tibbiyot, kimyo va boshqa sohalardagi jarayonlarni ko‘rgaz- 
mali namoyish etish;

— kompyuter o ‘yinlari (imitatsiya);
— kino va televideniya uchun tasvirlar.
Hozirgi davr yangi texnika va texnologiyalami kompyuter texno- 

logiyalari asosida ishlab chiqarish va tashkil qilish asri hisoblanadi. 
Shuning uchun barcha sohalardagi kabi, tasvirlarni yaratish, qayta 
ishlash va muhandislik loyihalashda ham kompyuterlardan foy- 
dalanish hozirgi kunda dolzarb b o lib  qolmoqda.

Tasvir ko ‘ rinishida berilgan axborotlarni kompyuterda qayta 
ishlash texnologiyalari xilma-xil boMib, juda ko‘p amaliy masalalami 
hal qilishga tatbiq etiladi.

Tasvirlarni qayta ishlash masalalarining amaliy tatbiqlariga misol 
tariqasida uzatish tizimi xizmat qilishi mumkin. Bu tizimda m a’lu- 
motlami kichik hajmli qilib kodlashtirish, tasvirdagi ortiqcha xalaqit 
beruvchi unsurlarni kamaytirish m asalalari hal qilinishi kerak. 
Tasvirlar sifatini m a’lum bir mezon bo ‘yicha yaxshilash (m asalan, 
tasvimi tiklash, ranglami o ‘zgartirish, kontrastini oshirish), ularni 
tubdan o ‘zgartirib yuboruvchi maxsus almashtirishlar ham tasvir- 
lami qayta ishlash masalalari bo ‘ lishi mumkin.

Tasvimi qayta ishlashda, masalan, tasvirdagi ayrim elementlami 
olib tashlash (ovoz, rang, ...) yoki qo ‘shish, uning hajmini o ‘z- 
gartirish va hokazolarda kiruvchi va chiquvchi m a’lumotlar — tas­
virlar bo ‘ ladi.

Tasvir ko ‘rinishga ega b o im agan  axborotlarni vizuallashtirish 
(y a ’ ni tasvirni yaratish) m asalalari bilan kompyuter grafikasi 
(com puter graphics) shug‘ullanadi.

K om pyuter (m ash in a) grafikasi dastlabki, y a ’ ni kiruvchi 
axborotni (n om a’lum tabiatga ega) tasvir ko‘ rinishiga olib keladi. 
M asalan, m a’ lumotlarni grafik, diagramma yoki boshqa shakllarda 
vizuallashtirish. Bundan tashqari, shakllarni almashtirish, harakat- 
lantirish, virtual tasaw urga yaqinlashtirish.

Shuni ta ’kidlab o ‘tish joizki, grafiklar vaqtga nisbatan o ‘zgarmas 
bo‘ ladi. Ayrim kompyuter o ‘yinlari vaqt oralig‘ ida o ‘zgarib turadi. 
Boshqalarida esa real dunyo obyektlari bilan bo ‘layotgan o ‘zgarish- 
larni tasvirlovchi illuziya hosil bo ‘ ladi.

4



Vizual obyektlarni tanib olish qandaydir m a’noda kompyuter 
grafikasi masalasiga teskari masaladir. Chunki berilgan tavsiflar 
asosida tasvirni yaratish kompyuter grafikasining masalasi bo ‘ lsa, 
uning tavsiflarini hosil qilish tavsiflami tanib olish masalasi hisoblanadi.

1.2. Kompyuter grafikasi turlari

Kom pyuter grafikasi va dizayni, asosan, elektron rasm, tas- 
virlar va boshqa texnik vositalar orqali import qilingan rasmlar 
bilan ishlashni o ‘ rgatadi. Hozirgi kunda grafik dasturlarning soni 
juda ko‘p b o ‘ lib, ular ishlash prinsipiga ko‘ ra farqlanadi. Ushbu 
o ‘quv qoM lanmada kom pyuter grafikasining rastrli (nuqtali), 
vektorli (obyektli) va fraktal turlari h aq id a  b o sh la n g ‘ ich 
tushunchalar keltirilgan.

Rastrli grafika bilan ishlovchi dasturlar Paint, Adobe Photoshop, 
CorelPhotoPaint — bu dasturlarda har bir tasvir nuqtalar — piksellar 
to ‘plami asosida kolriladi. Bu dasturlar yordamida yaratilgan fayllar 
*.bmp, *.jpg, *.psd, *.tif form atlarida saqlanishi mumkin. Bu 
turdagi fayllarda saqlangan tasvirlar ranglarining yorqinligi bilan 
ajralib turadi. Ularning kamchiligi sifatida tasvirni kattalashtirish 
bilan uning sifati yo‘qolib borishi va xotirada ko‘p joy egallashini 
aytib o ‘tish lozim. Shuning uchun, ko‘pincha, bu formatlardan 
tayyor rasmlarni qayta ishlashda foydalanish tavsiya qilinadi.

Vektorli grafika bilan ishlovchi dasturlar CorelDRAW, Auto­
CAD, Adobe Illustrator, Macromedia Flash, 3DS MAX va 
boshqalar -  bu dasturlarda har bir tasvir m a’ lum shakl va chiziqlar 
asosida quriladi.

Bu dasturlarda ikki yoki uch oMchovli tasvirlar bilan ishlashning 
mumkinligi, obyektlarni kattalashtirish bilan ularning sifatining 
o ‘zgarmasligi va katta instrument (asbob)lar bazasining mavjudligi 
foydalanuvchilar uchun katta imkoniyatlar yaratadi. Yaratilgan 
fayllar *.cdr, *.dwg kabi formatlarda saqlanadi.

Ushbu dasturlarda yaratilgan tasvirlar turli chiziqlar va qiyshiq 
vektorlardan iborat bo ‘ladi. Vektorli grafikada yaratilgan rasmlardan 
logotip, illustratsiya va lavha (zastavka)lar yaratishda foydalaniladi.

Fraktal grafika — tasvirlarni matematik hisoblashlar asosida 
avtomatik yaratish uchun qoMlaniladi. Shuning uchun ham uning 
asosi sifatida shakl, tasvir hosil qilishning dasturlash usuli olingan.

Bu grafika, odatda, turli jarayonlarni modellashtirish, tahlil 
qilish, turli qiziqtiruvchi dasturlar yaratishda keng qo ‘ llaniladi.
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Ushbu qo ‘ llanmada o ‘quvchilar rastr grafikasi bilan ishlashdan 
mukammal bilim olishlari uchun, asosan, rastrli (piksel) grafikaga 
ko‘proq e ’tibor beriladi. Shu bilan birga, vektor grafikasidan ham 
qisqacha m a’ lum otlar beriladi, chunki bu grafika turida faqatgina 
tasvirlar bilan ishlashgina em as, balki shu tasvirlami yaratish im- 
koniyati ham mavjuddir.

1.3. Kompyuter grafikasi turlarining farqlanishi

Rastrli grafikaning vektorli grafikadan farqi shundaki, rastrli 
grafikada tasvir kattalashtirilgani sayin uning sifati yo‘qolib boradi 
va xotiradan ko‘p joy  egallaydi.

Fraktal grafikada hisoblashlam i am alga oshirish kerak bo ‘ lib, 
uning vektor grafikadan farqi shundaki, unda hech qanday obyekt- 
lar kompyuter xotirasida saqlanm aydi, chunki tasvirlar tenglam alar 
yoki ularning tizimlari orqali hosil qilinadi. Shuning uchun ham 
xotirada tenglamalargina saqlanadi.

1.4. Photoshop dasturida tasvirlami ochish

Adobe Photoshop dasturida tasvir (fayl)ni ochish uchun quyi- 
dagilam i bajarish kerak:

1. M enyuning File >  Open (Fayl >  О ткрыть) (File > Browse 
(Ф а й л  >  П р о с м о т р ) )  b u y ru g ‘ ini ta n la n g  yoki Ctrl+O 
(Shift+Ctrl+O) tugmalari majmuasidan foydalaning.

2. Ochilishi kerak b o ‘lgan faylni tanlang (1-rasm).

l-rasm. Open buyrug‘i yordamida fayllami ochish. 
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Agarda tasvir kichiklashtirilgan nusxada saqlangan b o ls a ,  
tasvirni ko‘ rish uchun Show Preview (Предварительный npoc- 
MOTp)ga sichqoncha bilan bosing. Agarda faylni File >  Browse 
yordamida ochgan bolsangiz, hamma tasvirlar kichiklashtirilgan 
formatda berilgan bo lad i, istalganini sichqoncha yordamida tanlab, 
kokrsa boMadi (2-rasm ).

File Uiowsei

2-rasm. Browse buyrug'i yordamida fayllami ochish.

Agarda katalogda tasvirlar soni kolp b o lsa , ularning miniatura- 
sini yaratish birmuncha vaqt olishi mumkin.

Bare ha formatdagi fayllarni ekranga chiqarish uchun Files of 
type (Типы файлов) ochilib chiqadigan menyusidan All Formats 
(Все форматы) variantini tanlash kerak.

Tasvir ochilgandan keyin, uni Photoshop dasturidagi mavjud 
formatlarda saqlash mumkin bo lad i.

Agarda fayl nomi fayllar robyxatidan chiqm asa, bu faylning 
formati uchun Photoshop dasturida uni ochuvchi maxsus modul 
mavjud emas deganini anglatadi. U holda bu modulni o brnatish 
kerak boMadi.
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3. Fayl nomini ajratib, Open (Открыть) tugmasini yoki fayl 
nomining ustiga ikki marta ketma-ket sichqonchaning tugmasi 
bosiladi.

Profillar m os kelmagan holda II bobda berilgan yo‘ riqnomadan 
foydalanilsa b o ‘ ladi.

B a ’zi form atlar uchun yana bir muloqot oynasi ochilishi m um ­
kin. M asalan, EPS, Adobe Illustrator yoki PDF formatida saq- 
langan fayllarni ochganda, tasvir vektor ko‘ rinishidan rastr ko‘ ri- 
nishiga o ‘tkazilmagan bo ‘lsa, u holda Rasterize Generic Format 
(Растеризация формата) oynasi ochiladi. (Bu haqda «EPS, PDF 
formatli yoki Illustrator dasturi fayllarini ochish» bo‘ limida kengroq 
m a’ lumot berilgan.)

B a ’zi formatlarni ochish uchun maxsus modullar kerak bo ‘ ladi. 
M asalan, Scitex Ctrl yoki PICT Resource formatli fayllar. Bu 
fayllarni ochish uchun File >  Import (Файл >  Импорт) buyru- 
g ‘ini bajarish talab etiladi.

Faylni ochishda aniq formatni ko‘ rsatish uchun menyuning 
File > Open As (Файл > Открыть как) buyrugini bajaring va 
ochilgan oynadan kerakli formatni tanlab, keyin Open (Октрыть) 
tugmasini bosing.

Joriy oynalar orasida bir-biriga tez o ‘tish uchun «qaynoq» 
tugma -  Ctrl+Tab dan foydalaning.

Yaqinda yopilgan faylni ochish uchun menyuning Hie > Open 
Recent (Файл > Недавно октрытые) buyrugldan foydalaning.

1.5. Yangi yaratilgan tasvirlarni xotiraga saqlash

Yangi yaratilgan tasvirlarni xotiraga saqlash uchun quyidagilami 
amalga oshirish kerak:

1. Hie >  Save (Файл > Сохранить) buyrug‘ ini tanlang yoki 
Ctrl+S tugm alar majmuasidan foydalaning.

2. Ochilgan muloqot oynasida File name (Имя файла) may- 
doniga fayl nomini kiriting.

3. Faylning diskdagi saqlanadigan joyini ko‘ rsating. Agarda 
faylni joriy papka yoki diskdan boshqa joyga saqlamoqchi bo‘ lsangiz, 
muloqot oynasining yuqori qismida joylashgan menyudan foyda- 
lanib, kerakli joyni ko‘rsating.

4. Save As (Сохранить как) ochilib chiquvchi menyusidan fayl 
formatini tanlang (3-rasm).



Agarda tasvir ko‘p qatlamli bo‘ lsa, ular Photoshop dasturining 
form atlari, Advanced TIFF yoki Photoshop PDF form atlarida 
saqlanishi mumkin.

5. Save Options (Параметры сохранение) guruhi maydon- 
lariga zarur bo ‘lgan bayroqchalam i q o ‘ying. Shuningdek, ranglar 
uchun ham bayroqcha q o ‘ysa b o ‘ladi, agarda faylda profillar 
mavjud bo‘ lsa, bu Color: Embed Color Profile (Цвет: Встроенный 
цветовой профиль) yordam ida bajariladi.

6. Save (Сохранить) tugmasini bosing.
K o ‘p qatlamli tasvirlam ing nusxalarini qatlam larsiz avtomatik 

tarzda saq lash  uchun Maximize backwards compatibility in 
Photoshop formats (Максимальная совместимость форматов 
Photoshop) m aydoniga bayroqchani qo ‘yish kerak b o ‘ladi. Bu 
tasvimi boshqa formatlarga eksport qilishda juda  q o ‘l keladi.

1.6. Rastrli tasvirlarning xususiyatlari

Rastr — bu juda  kichik yuzaga ega bo‘ lgan geom etrik figuralar 
(piksellar)dan, m asalan, kvadratchalardan tuzilgan matritsa. H ar 
bir piksel o ‘z rangiga ega b o ‘lishi mumkin. Turli rangdagi piksellar
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to ‘plami tasvim i tashkil qiladi. Piksellarning sirtda joylashishiga 
ko‘ ra rastrlar turli tiplarga bo ‘ linadi: kvadrat, to ‘g ‘ri to ‘ rtburchak, 
doira, geksagonal va boshqalar. Piksellar joylashishini tasvirlash 
uchun turli xil koordinata tizimlaridan foydalaniladi. Bu tizim- 
larning barchasi uchun umumiy bo ‘ lgan xossa — ularda piksel 
koordinatalari qiymatlar diskret qatorini (butun son bo ‘ lmasligi 
mumkin) tashkil qilishidir.

K o ‘pincha butun sonlar koordinata tizimidan foydalaniladi. 
Bunda piksellarning boshlang‘ ich koordinatasi chap tomondagi 
yuqori burchakdan boshlanadi.

Resolution (разрешение) — kattalashtirish ko‘rsatkichi bo1 lib, 
bir duymli kvadratda nechta piksel joylashganini yoki bir nuqtani 
necha m arta kattalashtirish mumkinligini kokrsatuvchi kattalik 
hisoblanadi. U , asosan, rastr grafikasi uchun xosdir. Kattalashtirish 
ko‘ rsatkichi ortib borishi bilan tasvir sifati va hajmi ham ortib 
boradi. Chop etiladigan fayllar uchun u 150 dpi (dots per inch -  
bir duymdagi nuqtalar soni)dan kam boMmasligi kerak. Internet 
sahifalari uchun yaratilgan fayllar uchun esa 72 dpi qilib belgilangan.

Rastm ing geometrik xossalari quyidagilardan iborat:
•  ruxsat etiladigan qobillik;
•  o ‘lcham;
•  piksel shakli.
Rastrda ruxsat etiladigan qobillik (разрешающая способность)

o ‘zaro q o ‘shni (yonma-yon) joylashgan piksellar orasidagi masofa 
bilan xarakterlanadi. Ruxsat etiladigan qobillik bir o ‘lchov birligidagi 
piksellar soni bilan oMchanadi. Eng ko‘p tarqalgan oMchov birligi 
bo ‘lib dpi xizmat qiladi. U bir duym (2,54 sm yoki 25,4 mm) 
uzunlikdagi piksellar sonini anglatadi. Piksellar o ich am i bilan qa- 
dam  kattaligini tenglashtirib bo ‘lmaydi. Pikselning o ich am i qa- 
damning kattaligiga teng, undan kichik yoki katta bo‘ lishi mumkin.

Rastrning oMchami, odatda, gorizontal va vertikal o ‘qlar bo ‘ - 
yicha joylashgan piksellar soni bilan o ‘ lchanadi. Shuni aytish 
mumkinki, kompyuter grafikasi uchun har ikki o ‘qlar uchun bir 
xil qadamli (ya’ni dpiX=dpiY) rastr qulay hisoblanadi. Bu ko‘pgina 
grafik obyektlarni chiqarish algoritmlari uchun qulaydir. Aks holda 
m uam m o yuzaga kelishi mumkin.

Rastr piksellarining shakli tasvirni chiqarish qurilm asining 
xususiyatlari bilan aniqlanadi. Piksellar quyidagi shakllarga ega 
bo ‘ lishi mumkin:
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1. Kvadrat (yoki to ‘g ‘ ri to ‘ rtburchak shaklidagi piksellar). U lar 
o lch a m i bo ‘yicha rastr qadam iga teng b o iad i (suyuq kristalli 
displeylarda).

2. D oira shaklidagi piksellar. U lar o lch am i bo ‘yicha rastr qa­
damiga teng bo ‘lmasligi mumkin (printerlar).

1.7. Rastrning ruxsat etiladigan qobilligini baholash

Norm al ko‘rish qobiliyatiga ega bo‘ lgan odamning k o ‘zi 1" ga 
yaqin burchak o lch am iga  ega obyektlami farqlashi mumkin. Agar 
obyektgacha bo ‘ lgan masofa R uzunlikka teng bo‘ lsa, u holda bu 
oMcham (dP) ni a  • R ga teng yoy uzunligi sifatida quyidagicha 
baholash mumkin:

dP =  a - R ,  (1)
bu yerda a  =1,7453293 • 10"2/60  =  2,90888 ■ 10“4 (rad).

Faraz qilish mumkinki, odam rastr diskretligini (qadam ini) 
ana shu minimal farqlash mumkin b o ‘lgan oMchamga m os ravishda 
farqlaydi. Boshqacha aytganda, alohida olingan nuqta (piksel) mini­
mal uzunlik dP dan kam bo‘ lgan m asofaga siljitilsa, u siljitilgan 
bo ‘lib hisoblanmaydi. Unda ruxsat etiladigan qobillikni rastr si­
fatida qabul qilinmaydigan quyidagi kattalik bilan baholash mumkin:

dpi = 25,4/d P  (m m ). (2)
1-misol. Agar odam  qog‘oz hujjatdagi yozuvni o ‘qishi uchun 

odatda 30 sm uzoqlikdagi m asofadan qaraydi deb hisoblansa, u 
holda printer uchun ruxsat etiladigan qobillik qanday b o ‘lishi 
kerak?

Berilgan: R =  30 sm =  300 mm. 

dpi — ?
Yechish. (1) va (2) formulalardan foydalanib yechamiz: 

dp =  a  R =  2,90888 ■ 10"4 • 300 =  8,726646 ■ 10 2; 
dpi =  25,4/(8,726646 ■ 10~2) =  291,06 -  292.

2-misol. Odatda, displey ekranidan 0,5 m dan kam b o ‘ lmagan 
uzoqlikda o ‘tirish tavsiya etiladi. U holda displey ekrani uchun 
ruxsat etiladigan qobillik qancha bo ‘ lishi kerak?

Berilgan: R =  0,5 m =  500 mm. 

dpi — ?
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Yechish. Xuddi 1-misoldagi kabi amallar bajariladi:
dp =  a  • R =  2,90888 ■ 10“4 ■ 500 =  1,454441 • 10 

dpi =  25,4/(1,454441 ■ 1 0 1) =174,6375 *  175.
Agar tasvir o ‘ lchamlari keragidan katta bo ‘ lsa, hajmi ham katta 

boiish i aniq. Tasvir hajmining katta boMishi qattiq diskda ko‘p 
joy egallanishi va kompyuter tom onidan sekin qayta ishlanishiga 
olib keladi.

Rastrli grafikada foydalanuvchi har bir pikselga ishlov berish 
imkoniga ega bo‘ ladi. Tasvirdagi piksellar soni qanchalik ko‘p boMsa, 
tasvir shunchalik sifatli bo‘ ladi.

Tasvirdagi piksellar zichligi dpi bilan belgilanadi. G azeta va 
shu kabi nashrlarda mazkur ko‘ rsatkich odatda 150 dpi, rangli 
jumallarda 300 dpi, fotosurat va kompozitsiyalarda 600—1200 dpi ni 
tashkil etadi. Ekranda tasvirlanadigan rasmlar uchun esa 72 dpi 
sifat ko‘ rsatkichi yetarli hisoblanadi.

Shuni ta ’ kidlash va eslatib o ‘tish joizki, mazkur ko‘rsatkichni 
belgilash yoki tanlashda ratsional yondashuv talab qilinadi, chunki 
har bir nuqta xotirada bir bit (agar tasvir oq-qora b o ‘ lsa) joy  
egallaydi va ularning soni tasvirda qancha ko‘p b o isa , tasviming 
xotirada egallaydigan hajmi ham shuncha katta bo ‘ ladi. M asalan, 
300 dpi sifatga ega bo ‘lgan 2 "x 3 ,5 "  (" belgisi duymni bildiradi) 
(5 x 9  sm 2) o ich am dagi kulrangning gradatsiyasida berilgan tasvir 
taxminan 630 000 bitni tashkil etadi.

1.8. Rastr tasvirlami saqlash uchun qo‘llaniladigan 
formatlar

Rastr tasvirlar odatda siqilgan holda saqlanadi. Sifatni yo‘qot- 
masdan siqishda ortiqcha axborotni kamaytirishga asoslangan siqish 
algoritmlari qoilan ilad i.

BMP (Windows Bitmap) formati — odatda tasvirni siqmagan 
holda q o ‘llaniladi, biroq R L E  algoritmini q o ‘llash mumkin. BM P 
formati shaxsiy kompyuter (PS) platformasida qoMlaniladigan eng 
ommaviy grafik fayl formati.

BM P fayllarida tasvirni siqish mavjud emas, am m o rastr tas­
virlami ifodalashning bunday formati (Device Independent Bitmap), 
RLE (Run Length Encoding) siqish algoritmlari qoMlaniladigan 
DIB tipidagi fayllami saqlash uchun qo ‘ llaniladi. R L E  algoritmi, 
shuningdek, boshqa ommalashgan rastrli grafika formatlarida, m a­
salan PC X  da ham q o ‘llaniladi.
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GIF (Graphics Interchange Format) -  eskirayotgan format 
tu ri boMib, bir vaqtning o ‘zida 256 dan ortiq boMmagan ranglar 
haqidagi m a’ lumotni saqlashi mumkin. Animatsiyada q o ‘ llanil- 
ganligi uchun hali ham om m abopdir. G IF  form atidan asosan 
Internetda foydalaniladi.

PNG (Portable Network Graphics) formati — Internetda ishlati- 
ladigan eng yangi tasvir formatlaridan biri bo‘lib, unda G IF  formati 
kabi yaxshi siqish darajasi va JP E G  formati kabi cheklanmagan 
miqdordagi ranglar palitrasi mujassam bo‘lgan. Biroq G IF  dagi 
kabi animatsiyani qo ‘ llash imkoniyati yo‘q.

PCX formati — eski format turi b o iib , asosan, oddiy chizilgan 
tasvirlarni yaxshi siqishga imkoniyat beradi (bunda bir rangda ketma- 
ket kelayotgan piksellarning guruhi haqidagi m a’lumotlar ushbu 
piksellarning soni va rangi haqidagi m a’lumot bilan almashtiriladi).

Sifatni yo‘qotish bilan siqishda quyidagi formatlar qollan iladi:
JPEG formati — juda keng qollaniladigan tasvir formati. Siqish 

qo ‘shni piksellar ranglarini o krtachalashtirish (yorqinlik haqidagi 
axborot o ‘ rtachalanmaydi) va tasvir fragmentining fazo spektridagi 
yuqori chastotali tashkil etuvchilarini chiqazib tashlashga asoslan- 
gan. Qattiq siqilgan tasvirni yaqinlashtirib, yaxshilab kuzatilganda 
aniq chegarlaming xiralashishi va ular oldidagi muami sezish mumkin.

TIFF formati — ranglar chuqurligi o ‘zgarishining katta dia- 
pazonini, turli rangli fazolarni, siqishning turli usullarini (sifatni 
yo‘qotish bilan va yo ‘qotmasdan) va h.k.larni o ‘zida mujassam etadi.

RAW formati (raw -  inglizcha so ‘z bo‘ lib, «tabiiy», «hali o lzgar- 
tirilmagan», ruscha «сырой» degan m a’noni bildiradi) — bu ka- 
mera, fotoapparat yoki skanerdan olinadigan, deyarli hech qanday 
o lzgartirish kiritilmagan tasvirni saqlash formati (4-rasm ). RAW

Qayta ishlashdan oldin Qayta ishlashdan so ‘ng

4-rasm. RAW formatida saqlangan tasvir.
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formatli tasvirga hali hech qanday o ‘zgartirish kiritilmaganligi va 
grafik tahrir dasturi tom onidan bosm aga tayyor emasligi sababli 
shunday nomlanadi. RAW formatli rasmda har bir piksel rangi 
juda ham aniq va tabiiy holda bo ‘ ladi; shuning uchun ulam i ko‘p 
ishlatiladigan jpeg, tiff formatlariga o ‘girishdan oldin ranglarga 
sifatni yo‘qotm agan holda turli o ‘zgartirishlar kiritish mumkin 
bo ‘ ladi (5-rasm ).

Wifcr.-.

2 .-am

JPEG formati, as! holati JPEGformati, avtomatik 
o'zgartirishlardan keyingi holati

RA W formati, asl holati RA Wformati, avtomatik 
o'zgartirishlardan keyingi holati

5-rasm. Ayni bir rasmning RAW va JPEG formatlarida saqlangan 
nusxalarining bir-biridan farqlanishi.

14



Boshqa grafik formatlar haqidagi m a’lumotlami tegishli ada- 
biyotlar, Internet tarmog‘idagi manbalardan topib, mustaqil o ‘rga- 
nishingiz mumkin.

^ y J Nazorat savollari

1. Kompyuter grafikasining rivojlanish tarixini aytib bering.
2. Kompyuter grafikasining qanday turlarini bilasiz?
3. Rastr grafikasi to‘g‘risida tushuncha bering.
4. Vektor grafikasi to‘g‘risida tushuncha bering.
5. Fraktal grafikasi to‘g‘risida tushuncha bering.
6. Kompyuter grafikasi turlari qanday farqlanadi.
7. Rastrli tasvirlaming xususiyatlari nimalardan iborat?
8. Rastr, kattalashtirish ko‘rsatkichi tushunchalari nimani bildiradi?
9. Ruxsat etiladigan qobillik, rastming oMchami, rastr piksellarining 

shakli haqida ma’lumot bering.
10. Rastr tasvirlami saqlash uchun qanday formatlardan foydalaniladi?
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II  BOB. ADOBE PHOTOSHOP DASTURNING 
INTERFEYSI

2.1. Asosiy tushunchalar

Adobe Photoshop dasturi — rastrli tasvirlar (rastr grafik fayllar, 
fotosuratlar va h.k.) bilan ishlashga moljallangan eng ommabop 
grafik muharrir hisoblanadi.

Photoshop dasturi ishchi oynasi quyidagilarni o ‘z ichiga oladi 
(6-rasm):

1. Dastur qatori — dastur va fayl nomini ko‘ rsatadi.
2. Menyu qatori — bunda dastur tarkibiga kiruvchi barcha 

buyruqlar shu menyu bo‘limlari tarkibiga guruhlangan.
3. Options (Форматирование) paneli — tanlangan asbob yoki 

belgilangan obyektga oid buyruqlarni ko‘rsatadi.
4. Tools (Инструменты) — uskunalar paneli, dasturda mavjud 

bo‘lgan barcha asboblarni o ‘z ichiga oladi.
5. Status bar (Строка состояния) — holat satri, tanlangan 

uskunaga oid ko‘rsatmalami ko‘rsatadi.
Qo‘shimcha panellar Window menyusidan panel nomini tanlash 

orqali ekranga chiqarilib, foydalanuvchiga quyidagi qo‘shimcha 
imkoniyatlami yaratadi:

6. Styles (Стили) — стиллар, chizilgan obyektlar uchun tayyor 
stillardan foydalanib rang berish imkonini beradi.

7. History (История) — bajarilgan ishlar ketma-ketligini ko‘r- 
satib, biror-bir bosqichga qaytish imkonini beradi.

8. Layers (Слои) — qatlamlar, faylda mavjud barcha qatlamlar 
haqida m a’lumot berib, ularni o ‘chirish, nusxa olish va xossalarini 
o ‘zgartirish imkonini beradi.

9. Navigator (Навигатор) — ko‘ rish kattaligi (masshtab)ni 
belgilaydi, varaqning bir qismidan ikkinchi qismiga tez o‘tish im­
konini beradi (7-rasm).

Har safar yangi faylni yaratish jarayonida New (Новый) mulo- 
qot oynasi ochilib, foydalanuvchidan quyidagi parametrlarni kiritish 
talab qilinadi (8-rasm):

Name (Имя файла) — fayl nomi, uni ishni boshlashdan oldin 
yoki faylni xotiraga saqlash vaqtida ko‘rsatish mumkin;

Preset (Размер бумаги) — qog‘oz o ‘ lchami, uni berilgan 
standart asosida tanlash yoki Custom rejimida ixtiyoriy o ‘lchamda 
o ‘rnatish mumkin;
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6-rasm. Adobe Photoshop dasturining ishchi oynasi.

ГЛ5ШIf) Adobo Photoshop 16011 III @ 1002 (RGB))



8-rasm. Yangi faylni yaratish jarayonida chiqadigan 
New (Новый) muloqot oynasi.

Width (Ширина) — ishchi qog‘oz bo ‘yi;
Height (Высота) — qog‘oz eni, o ‘ lchov birligi sifatida mm, 

sm , piksel yoki boshqa birliklar ko‘rsatilishi mumkin;
Resolution (разрешение) — kattalashtirish ko‘rsatkichi;
Background contents (Цвет фона) — orqa fon rangi, u oq 

(White (Белый)), o ‘m atilgan orqa fon rangi (Backround color 
(Цвет заднего фона)) yoki shaffof (Transperense (Прозрачный)) 
b o ‘lishi mumkin.

Image Size (Размер изображения) sohasida yaratilgan faylning 
diskda egallaydigan hajmi ko‘ rsatiladi.

2.2. Asboblar paneli

Asboblar (Tools (Инструменты)) panelidagi asboblam i faol- 
lashtirish uchun ulam ing piktogram m alariga sichqoncha bilan 
bosish kifoya qiladi. Piktogram m alam ing yon tom onida joylashgan 
kichkina yo‘ naltirgich (strelka)ga bosilsa palitra ochiladi va shu 
guruhga kiruvchi asboblam i tanlash imkoniyatiga ega b o ‘linadi.

Asboblar bilan ishlashning yana bir qulay tom onlaridan bin — 
klaviatura yordamida istalgan asbobni unga mos «qaynoq» tugmalar 
(tugm alar kom binatsiyasi) yordam ida ekranga chiqarish imko- 
niyatining mavjudligi (buning uchun kerakli asbobga m os keluvchi 
harfni yodda saqlash kerak bo ‘ladi). Agarda siz kerakli tugm alar
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10-rasm. Parametrlar paneli.
Move Tool (V)

9-rasm. Opsiya 
paneli.

kombinatsiyasini yoddan chiqargan bo ‘ lsangiz, u 
holda kerakli bo ‘ lgan asbob ustida bir necha 
sekund sichqoncha ko ‘rsatkichini ushlab tursan- 
giz, tugmalar kombinatsiyasi haqidagi m a’ lumot 
chiqadi (9-rasm). Guruhdagi asboblami ketma- 
ket chiqarish uchun Shift va shu guruhga mos 
tugma bosiladi. Shu jarayonni Alt tugmasi bosilgan 
holda mos asbobning ustiga sichqoncha bilan 
bosish orqali ham am alga oshirsa boMadi.

Parametrlar ( Options (Параметры)) panelida 
(10-rasm ) har bir asbobga mos holda uning pa- 
rametrlari beriladi (m asalan, aralashtirish rejimi, 
tiniqlilik qiymati). Parametrlar paneli ekranning 
yuqori qismida joylashgan boMadi (bu haqda qo‘l- 
lanmaning «Parametrlar paneli» qismida batafsilroq 
m a ’ lum ot b erilad i). Param etrlar pan elid ag i 
parametrlar qanday asbob tanlashiga bog‘ liq ra- 
vishda o ‘zgaradi.

Parametrlar panelining chap tom onida joriy asbobning pikto- 
grammasi joylashgan bo ‘ladi. Agarda piktogramma yonidagi yo ‘nal- 
tirgichga bosilsa, menyucha paydo b o ‘ ladi, bu yerdan boshqa 
asbobni tanlash imkoniyatiga ega bo ‘ linadi. Bu menyuchadagi ro‘y- 
xatni tahrirlasa bo ‘ladi, ya’ni kam foydalaniladigan asboblarni olib 
tashlasa va ko‘p foydalanadiganlarini unga joylashtirsa b o ‘ ladi. 
Unda har bir asbobning parametrlari, agar u o ‘zgartirilmagan yoki 
qaytadan kiritilmagan bo ‘ lsa, o ‘zgarm ay saqlanadi. Bu menyuga 
yangi asboblarni yuklash, qo ‘shish va saqlash am allari m axsus 
tugmalar yordamida yoki panel menyuchasi yordamida am alga 
oshiriladi (1 1-rasm). Ham m a asboblar uchun oldindan belgilangan 
parametrlami tanlash uchun Reset All Tools (ham m a asboblam i 
avvalgi holiga qaytarish) buyrug‘ i yoki Edit > Preferences >  
General (Правка > Установки > Общие) oynasidagi Reset All 
Tools ga sichqoncha bilan bosiladi.

Edit > Preferences >  Display& Cursors (Правка > Установки >  
Отображение и курсоры) oynasidan kursor va asboblar paneli 
piktogrammalarining ko‘ rinishini belgilash mumkin.
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New Tool Preset..

Rename Tool Preset... 
Delete T ool Preset

* Sort By Tool 
v Show AI Tool Presets 

Show Curent Tool Presets

Text Or*»
¥  Smal List 

Large Litt

Reset Tool 
Reset Al Took

Preset Manager...

Reset Tool Preset*...
Load Tool Presets...
Save Tool Presets... 
Replace Tool Presets...

Art History 
Brushes
Crop and Marquee 
Text

11 -rasm. Parametrlar paneliga asbobni kiritish menyusi.

Agarda asbobdan noto‘g ‘ri foydalanilsa, taqiqlash piktogrammasi 
chiqariladi. Sichqoncha yordamida joriy oynaga chertish orqali nima 
uchun joriy asbobdan foydalanib bo ‘ linmasligi haqida m a’ lumot 
olasiz.

12—28-rasmlarda Photoshop dasluii asboblar panelidan asbob- 
larni chiqarishga oid tasvirlar berilgan. Har bir guruh asboblari 
yonida ularni chiqarishga mos «qaynoq» («горячая клавиш а») 
tugmalar berilgan. Dastur bilan ishlash jarayonida biror-bir as- 
bobga sichqonchani olib borib uni faollashtirishni unga mos «qay­
noq» tugmani bosib am alga oshirsa ham bo iad i. Bu foydalanuv- 
chini ortiqcha harakatlarni bajarishdan xalos etadi va buning nati- 
jasida vaqtining tejalishiga olib keladi. Yuqorida aytib o ‘tilganidek, 
biror guruh asboblarini Shift tugmasini bosib turib va shu guruhga 
m os tugm ani ketma-ket bosish bilan shu guruhdagi asboblarni 
tartib bilan chiqarsa b o iad i.

Quyida Asboblar panelidagi asboblam ing bajaradigan ishlariga 
izohlar berib o ‘tamiz (to ‘g ‘ ri qavslar ichida izohlanayotgan asbobga 
mos «qaynoq» tugma berilgan):

$  Huing Brush 21 ptxtb 

^  МцрмОс Usso 24 pbttb 

■Ц  Crop 5 Inch X  4 Inch 300 dpi 

ф  F I wtth Bubbles P«ttam 

f  Horizont i l  Typ« Myriad Roman 24 pt
JB__________________

Г  C rron t Tool Only
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12-rasm. Move Tool
asbobini tanlash.

13-rasm. Marquee Tool to'rtburchak 
yoki oval shaklidagi biror sohani ajratish 

asboblari paneli.

1. Move Tool (Перемещение) [V] -  tanlash — obyektlami 
belgilash, bir joydan ikkinchisiga ko‘chirish, aylantirish imkonini 
beradi (12-rasm ).

2. Marquee Tool [M ] — belgilash — to ‘rtburchak yoki oval
shaklidagi biror-bir sohani belgilash uchun ishlatiladi. Bu asbob tan- 
langanda Parametrlar panelida Selection oynasi faollashadi (13-rasm). 

Bu yerda:
1 — New Slection — yangi soha 

belgilash;
2 — Add to selection — belgilangan 

sohaga yangi belgilangan sohani qo ‘shish;
3 — Subtract from selection — belgilangan sohadan yangi belgi­

langan sohani kesib olish;
4 — Intersect with Selection — belgilangan sohalam ing kesish- 

masini olish.
5 — Feather — belgilash yoki kesish chizig‘ i qalinligini belgilash. 

Kesish chizig‘ i qalinligini o ‘zgartirish orqali asta-sekin yo ‘qolib
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14 -rasm. Lasso Tool belgilash 
asboblari paneli.

15-rasm. Tasviming defektlarini 
o‘chirish asboblari paneli.

boruvchi tasvirlam i hosil qilish mumkin. Bu param etm i kesishni 
boshlashdan oldin yoki keyin Select menyusiga murojaat qilish 
orqali o ‘zgartirish mumkin.

3. Lasso Tool (Jlacco) [L] — ixtiyoriy belgilash — joriy 
qatlam da ixtiyoriy sohani belgilash imkonini beradi (14-rasm ).

Uning uch tun mavjud:
birinchisi -  erkin qo ‘l harakati bilan u q , L

belgilash; ikkinchisi — k o ‘pburchakli 
belgilash; uchinchisi — magnetik lasso — 
rang chegaralari bo ‘yicha belgilash.

4 - m  Crop tool (Обрезка) [С ] — kesib olish — joriy qatlam dan 
belgilangan sohani yoki o ‘lchamlari ko‘rsatilgan sohani kesib olish. 
Qatlamning bu sohadan tashqaridagi qismi o ‘z-o ‘zidan o ‘chib ketadi.

s . m  Magic Wand Tool (Инструмент волшебной палочки)
[W] — «sehrli tayoqcha» — qatlam dagi biror rangdagi sohani 
belgilaydi. Ranglam ing yaqinlik darajasini o ‘matuvchi Tolerance 
(Допуск) parametriga ega bo‘lib, uning qiymati qanchalik katta bo ‘lsa, 
biror rangning shuncha ko ‘p ottenkalariga m os soha belgilanadi.
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16-rasm. Klonlashtirish
asboblari paneli.

17-rasm. Eraser Tool
asboblari paneli.

6. \ f  \ Healing Brush Tool (Восстанавливающая кисть) [J] —
tiklash m o‘yqalami — rasmning biror qism idan piksellar nusxasini 
olib, yangi joyga qo ‘yish uchun ishlatiladi. Bunda yangi hosil 
bo ‘ ladigan piksellar yaqin atrofdagi boshqa piksellaming xususiyat- 
laridan kelib ehiqib yaratiladi. Bunda kiritilayotgan o 'zgartirishlar 
m ayinroq ch iqadi. N usxalanayotgan  piksellar ularning ustiga 
kursomi keltirib, Alt tugmasini bosib turgan holda sichqonchani 
bosish orqali tanlanadi (15-rasm ).

7. | Q  Clone Stamp Tool (Копирующий штамп) [S] — nusxa 
oluvchi shtam p — rasmning biror qism idan piksellar nusxasini 
olib, yangi joyga qo ‘yish uchun ishlatiladi. Tiklash m o‘yqalami 
kabi ishlaydi, biroq undan farqli, yangi hosil bo ‘ladigan piksellar 
aynan nusxalanayotgan piksellam ing o ‘zidek bo ‘ ladi. N usxala­
nayotgan piksellarni tanlash xuddi tiklash m o‘yqalam idagi kabi 
bajariladi (16-rasm ).

Eraser Tool (Ластик) [E ] — o ‘chirg‘ ich — joriy qatlamda 
biror sohani o ‘chirish. Shift tugmasini bosib tuigan holda sichqon­
chani bosib nuqtalam i bir-biri bilan bog‘ lash mumkin (17-rasm ).



Quyidagi turlari mavjud:
| Background Eraser Tool (Ластик фона) [E] — orqa rang 

o ‘chirg‘ichi — orqa rangni o kchiradi.
|-g%| Magic Eraser Tool (Волшебный ластик) [E] -  «sehrli» 

o ‘chirg‘ich — o ‘xshash rangli sohalarni o ‘chirish uchun ishlatiladi.
Ushbu asbob guruhiga kiruvchi asboblar tanlanganda Parametr- 

lar panelida quyidagi parametrlarni kiritish mumkin boladi:
Mode (Режим) — o ‘chirg‘ ich ko‘rinishini tanlash, bunda 

quyidagi ko‘rinishlar tanlanishi mumkin: mo‘yqalam (Paintbrush — 
Кисть), aerograf (Airbrush — Аэрограф), qalam (Pensil— Каран­
даш), blok (Block -  Блок). Blok ko‘rinishida sichqoncha kursori 
16x16 pikselli kvadrat shaklida bo‘ ladi. Blok kattaligi o ‘zgarmaydi, 
shuning uchun tasvirni 1600% li masshtabda ko‘rganimizda ushbu 
blok rasmning 1 piksel kattaligiga teng bo‘ladi;

Tolerance (Допуск) — sezuvchanlik, rang okchirishda sezuv- 
chanlikni o ‘zgartirish;

Protect Foreground Color (Основной цвет) -  asosiy rangni 
o ‘chirilishdan himoyalash;

Limits (Ограничения) — cheklashlar, quyidagi parametrlari 
mavjud: Discontiguous (Все пикселы) — mo‘yqalam ostida uchray- 
digan tanlangan rangdagi barcha piksellami o ‘chirish; Contiguous 
(Смежные пикселы) — tanlangan rang va unga bo‘gliq sohalarni 
o ‘chirish; Find Edges (Выделение краев) — tanlangan rangga 
ega sohalarni o lchirish, bunda shaklning chegaralari yaxshi saqlanadi;

Sampling (Семплинг) — o ‘chiriladigan rang tanlash holatini 
o ‘zgartirish;

Anti-Aliased (Сглаживание) — chegaralarning yoyilishi, o ‘chi- 
riladigan soha chegaralari holatini o ‘zgartirish;

Use All Layers (Семплировать все слои) — «sehrli» o ‘chir- 
g ‘ichning hamma qatlamlarga yoki faqat asosiy qatlamga ta’sir 
etishini ta’minlaydi;

Opacity (Непрозрачность) — o ‘chirish kuchini belgilaydi: 
100% da barcha piksellar o ‘chiriladi, undan kam bo‘lganda foiz 
miqdoriga qarab ayrim piksellargina o ‘chiriladi.

9. Blur Tool (Размытие) [R] — kontrastni kamaytirish 
yoki ranglami yoyish uchun ishlatiladi (18-rasm).

|Д |  Sharpen Tool (Резкость) [R] — kontrastni ko‘paytirish 
yoki ranglarni aniqlashtirish asbobi.
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18-rasm. Tasvir chegaralari 
aniqligini nazorat qiluvchi 

asboblar paneli.

19-rasm. Tasvir ranglarining och- 
to'qligini o ‘zgartirish asboblari 

paneli.

|.^>j Smudge (Размыватель) [R] — rang yoyish yoki tortish asbobi.

Parametrlar panelida quyidagi parametrlami kiritish mumkin 
bolladi:

Brush (Кисть) -  qalam (m o ‘yqalam) turi va qalinligini tanlash;
Mode (Реж им) — ranglarni o ‘zgartirish holatini sozlash;
Pressure (Н аж им) — yoyish kuchini o ‘zgartirish;
Use All Layers (Семплировать все слои) — yoyilish hamma qat- 

lamlaiga yoki faqat asosiy bo‘lgan qatlamga ta’sir etishini ta ’minlaydi;
Finger Painting (Рисование пальцем) — rangga botirilgan 

barmoq bilan chizish effektiga o ‘tish.

10. | iU  Dodge Tool (О светитель) [О ] — tasvir ranglarini 
ochartirish asbobi (19-rasm ).

| ^ |  Burn Tool (Затемнитель) [О ] — tasvir ranglarini to ‘qar- 
tirish asbobi.

|Щ  Sponge Tool (Губка) [О ] — biror soha ranglarining och- 
to ‘qligini mayin o ‘zgartirish asbobi.
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20-rasm. Chiziqlar chizish 21-rasm. Tasvirni awalgi holatga
asboblari paneli. qaytarish asboblari paneli.

11. Ш Pensil Tool (Карандаш) [В] — qalam — qalam yordamida 
chizish (20-rasm ).
В Brush Tool (К исть) [В] — m o‘yqalam — asosiy chizish 

asbobi. M o ‘yqalamdan foydalangan vaqtda Shift tugmasini bosib 
turgan holda sichqoncha bilan chizsak, u holda to ‘g ‘ ri chiziqlar 
chiziladi. Shift tugmasi yordamida sichqonchani bosib, hosil bo‘lgan 
nuqtalam i bir-biri bilan to ‘g ‘ ri chiziqlar orqali bog‘lash mumkin. 
M o ‘yqalam  bilan chizilgan chiziqlarning chegaralari qalam da 
chizilgan chiziq chegaralariga qaraganda aniq bo ‘ lmaydi.

Parametrlar panelida quyidagi param etrlam i kiritish mumkin:
Brush (К исть) — qalam  turi va qalinligini tanlash;
Mode (Режим) — chiziqlami rasm ustiga qo ‘yilish turini tanlash;
Opacity (Н епрозрачность) -  chiziqlarning ko‘rinish darajasini 

o ‘zgartirish;
Auto Erase (Автостирание) — old fon rangini o ‘z ichiga oluvchi 

sohalar ustidan orqa fon rangida chizish imkonini beradi;
Wet Edges (М окры е края) -  «ho ‘l chegaralar» — m o‘yqalam 

chetlarida ranglami kuchaytirib, xuddi akvarel bilan chizish effekti- 
ni beradi.
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12. ygy History Brush Tool (Архивная кисть) [Y] — avvalgi 
holatga qaytish — bu asbobni tanlashdan oldin qaytish kerak bo‘lgan 
holatni History (История) yordamchi sohasida belgilashingiz kerak. 
S o ‘ngra ushbu asbob bilan shu holatdan keyingi hamma harakat- 
larni ko‘ rsatilgan sohada o ‘chirishingiz mumkin bo‘ladi (21-rasm).

1Ж1 Art History Brush Tool (Архивная художественная кисть)
[Y] — awalgi holatga badiiy qaytish — awalgi holatga qaytish 
asbobiga o ‘xshash bo ‘ lib, farqi oldingi holatga qaytishda turli 
maxsus effektlardan foydalanish imkoniyati mavjud.

Parametrlar panelida quyidagi parametrlarni kiritish mumkin:
Brush (Кисть) — qalam turi va qalinligini tanlash;
Mode (Режим) — chiziqlami rasm ustiga qo‘yilish turini tanlash;
Opacity (Непрозрачность) -  chiziqlarning ko‘rinish darajasini 

o ‘zgartirish;
Style (Стиль) — maxsus effektni tanlash;
Tolerance (Допуск) — ranglardan foydalanish, 100% da — 

tasvirdagi ranglar, 0% da — ranglar ixtiyoriy olinadi;
Area (Диаметр) — asbobning ta ’sir etish sohasini tanlash;

Airbrush (Аэрограф) [J] — puliverizatorga o ‘xshash chizish 
asbobi. Agar aerografdan foydalanish vaqtida Shift tugmasini bosib 
sichqoncha bilan chizsak, u holda to‘g ‘ ri chiziqlar chiziladi. Shift 
tugmasi yordamida sichqonchani bosib, nuqtalami bir-biri bilan 
bog‘lash ham mumkin.

13. |Hpfl Gradient Tool (Градиент) [G] — gradiyent rang berish 
yoki bitta rangdan boshqasiga o‘tish rangi bilan tanlangan sohani 
to ‘ ldirish (22-rasm).

Parametrlar panelida quyidagi parametrlarni kiritish mumkin:
Gradient Editor (Редактирование градиента) — mavjud gra­

diyent turlarini tanlash va yangi gradiyent rang hosil qilish paneli;
Linear Gradient (Линейный градиент) — ajratilgan sohani 

chiziqli gradiyent bilan bo‘yash;
Radial gradiyent (Радиальный градиент) — ajratilgan sohani 

radial gradiyent bilan bo‘yash;
Angle gradiyent (Конусовидный градиент) — ajratilgan sohani 

konussimon gradiyent bilan bo‘yash;
Reflected gradiyent (Зеркальный градиент) — ajratilgan sohani 

oynadagi kabi akslantirish gradiyenti bilan bo‘yash;
Diamond gradiyent (Ромбовидный градиент) -  ajratilgan 

sohani rombsimon gradiyent bilan bo‘yash;
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22-rasm. Ajratilgan sohani bo‘yash 23-rasm. Tasvimi awalgi holatga
asboblari paneli. qaytarish asboblari paneli.

Reverse — gradiyentdagi ranglami teskari akslantirish;
Dither — gradiyentdagi ranglaming bir-biriga kamroq sondagi 

o ‘tishlari evaziga tekisroq gradiyent olish;
Opacity (Непрозрачность) — gradiyentning shaffofsizligi 

miqdorini o ‘matish.
m  Paint Bucket Tool (Заливка) [G] — ajratilgan sohani 

bitta rang yoki naqsh bilan bo‘yash.
Parametrlar panelida quyidagi parametrlami kiritish mumkin:
ЯП (Заливка) — rang bilan bo‘yash turini tanlash;
Opacity (Непрозрачность) -  rang bilan bo‘yalgan sohaning 

ko‘rinish darajasini o ‘zgartirish;
Tolerance (Допуск) — sezuvchanlik — rang bilan bo‘yashda 

chegaralar sezuvchanligini o ‘zgartirish;
Mode (Режим) — rangning tasvir ustiga qo‘yilish turini tanlash;
Anti-AHased (Сглаживание) — chegaralaming yoyilishi — rang 

bilan bo‘yaladigan soha chegaralarining mayinroq chiqishi;
Contiguous (Смежные пикселы) — faqat ajratilgan sohani rang 

bilan bo‘yash;
All Layers (Все слои) — ajratilgan soha chegarasida barcha 

qatlamlami bo‘yashni amalga oshirish.
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24-rasm. Izohlar qo'shish 
asboblari paneli.

25-rasm. Notes asbobi yordamida 
yaratilgan izoh.

14. Щ  Pen Tool (Перо) [P] — pero — sichqoncha yordamida 
nuqtalar orqali shakl yaratish imkonini beradi (23-rasm).

I ff-J Freeform Pen (Произвольное перо) [P] — ixtiyoriy pero — 
sichqonchani bosib turib ixtiyoriy harakatlar bilan shakl yaratiladi.

|-$±j Add Anchor Point (Добвить точку) — yangi nuqta q o '­
shish — sichqoncha yordamida shaklga yangi burilish nuqtasi qo‘shiladi.

I Delete Anchor Point (Удалить точку) — nuqtani o ‘chirish — 
sichqoncha yordamida shakldagi burilish nuqtasi o kchiriladi.

I [ \ |  Convert Point (Преобразовать точку) — nuqtani o lzgar- 
tirish — shakl nuqtalarining joylashishini o ‘zgartirish (cho‘zish).

15. Notes (Заметки) [N] -  izoh (eslatm a) q o ‘shish — 
rasmning ixtiyoriy sohasiga matnli izoh qo ‘shish (24-rasm ). Bunda 
Adobe Acrobat dasturi formatiga ega bo4gan matnli izohlar kiritish 
mumkin.

Bu eslatmalar bosmadan chiqarilmaydi. Ular faqat buyurtma- 
chiga, tipografiyaga va h.k. kerakli bo‘lgan m a’lumotlami berish uchun 
xizmat qiladi. Izoh belgisiga bosish orqali paydo boMgan oynada 
(25-rasm) berilgan izoh matnini ko‘rish, uni qayta tahrirlash mumkin.
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26-rasm. Matn bilan ishlovchi 27-rasm. Turli geometrik shakllar
asboblar paneli. chizish asboblari paneli.

m Audio Annotation (Звуковое описание) [N] — ovozli 
izohlar -  rasmning ixtiyoriy sohasiga ovozli izoh qo ‘shish.

16. Щ  Type (Т екст) — matn — matnlar bilan ishlovchi asbob 
paneli (26-rasm ).

17. В  Rectangle (Прямоугольник) [U] — to ‘rtburchak — 
to ‘rtburchak chizish (27-rasm ).

В  Rounded Rectangle (Скругленный прямоугольник) [U] — 
aylanasim on to ‘rtburchak — aylanasim on to ‘ rtburchak chizish. 
Bu asbob tanlanganda Parametrlar panelida chiqadigan Radius 
maydonida burchaklar radiusini kiritish mumkin.

В  Ellipse (Эллипс) [U ] — aylana — aylana, oval chizish.

В  Polygon (Многоугольник) [U ] — ko‘pburchak — ko‘p- 
burchak chizish. Bu asbob tanlanganda Parametrlar panelida chi­
qadigan Sides (Стороны) maydonida ko‘pburchak tomonlarining 
sonini ko‘ rsatish mumkin.
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Щ  Line (Линия) [U] -  chiziq — 
to‘g‘ri chiziq chizish. Chiziq qalinligini 
Weight (Толщина) maydonida ko‘r- 
satish mumkin.

■  Custom Shape (Произволь­
ная фигура) [U] — maxsus shakllar, 
turli tayyor shakllar chizish. Para- 
metrlar panelida chiqadigan Shape 
(Фигура) maydonida kerakli shaklni 
tanlash mumkin.

18. |Я1 Eyedropper (Пипетка)
[I] — tomizg‘ich — tasviming istalgan 
joyiga bosib, shu joyga mos keluvchi 
piksel rangini asosiy rang qilib tanlash 
imkoniyatini beradi (28-rasm). Agar 
tanlangan rangni fon rangi qilib ta- 
yinlash kerak bo‘lsa, u holda rang tan- 
lanayotganda Alt tugmasini bosib tu- 
rishingiz shart bo‘ladi.

Ш  Color Sampler (Сравнение 
цветов) [I] — ranglami solishtirish -  
Info (Инфо) yordamchi oynasida 4 tagacha nuqtaning ranglari 
haqidagi ma’lumotlami ko‘rish imkoniyatini beradi. Nuqtalami 
sichqoncha yordamida qo‘yamiz, biror qo‘yilgan nuqtani o‘chirish 
uchun esa Alt tugmasini bosib turib, sichqonchani shu nuqta 
ustiga olib kelib (bunda kursor qaychi shaklini oladi) bosish kerak.

m  Measure (Измеритель) [I] -  chizg‘ich — rasmdagi maso- 
falami aniqlash uchun qo‘llaniladi. Sichqonchani bosib biror nuq­
tani kesmaning boshi qilib, oxirini Alt tugmasini bosib belgilasa 
bo‘ladi, bunda hosil bo‘lgan kesmaning vertikal bilan hosil qilgan 
burchagini Info (Инфо) yordamchi oynasida ko‘rish mumkin. 
Shu amalni ikki marta takrorlab, ikki chiziqli siniq chiziq hosil 
qilish mumkin. Bunda hosil bo‘lgan siniq chiziq transports vazi- 
fasini bajarib, hosil bo‘lgan burchakning o‘lchamini ko‘rsatadi. 

Parametrlar panelida quyidagi ma’lumotlami ko‘rish mumkin: 
tanlangan boshlang‘ich nuqta koordinatalari (X, Y); 
birinchi nuqtadan ikkinchisigacha bo‘lgan masofa — vertikal 

va gorizontal bo‘yicha (W, H);
31



X o‘qi bo‘yicha egilish burchagi (A); 
birinchi nuqtadan ikkinchisigacha bo‘lgan masofa (Dl); 
birinchi nuqtadan uchinchisigacha bo‘lgan masofa (transpor- 

tirdan foydalanilganda) (D2);
Clear (Очистка) — chizgichni o‘chirish tugmasi.
19. Hand (Рука) [H] — qo‘l — agar rasm ekranga to‘liq 

sig‘masa, u holda bu asbobni tanlab sichqoncha yordamida rasmni 
siljitish mumkin bo‘ladi. Rasmni ekranning o‘ng va pastki qismida 
joylashgan kolrib chiqish yo'naltirgichlari orqali ham siljitish mum- 
kin, biroq /ifam/asbob i yordamida buni amalga oshirish qulayroq. 
Uni xohlagan vaqtda (garchi boshqa asbob ishlatilayotgan bo‘lsa 
ham) probel tugmasini bosib turib vaqtincha faollashtirish mum- 
kin. Probel tugmasi qo‘yib yuborilishi bilan yana avvalgi asbob 
faollashadi.

Parametrlar panelida quyidagi ma’lumotlarni kobrish mumkin 
bo‘ladi:

Actual Pixels (Реальный размер) [Ctrl+Alt+0] — rasmni 100% 
hajmda ko‘rsatish holatiga o4ish tugmasi, ushbu holatda rasmning 
1 pikseli ekrandagi 1 pikselga mos keladi.

Fit On Screen (Во вес экран) [Ctrl+0] -  rasmni butun 
ekranga sig‘dirish holatiga o‘tish tugmasi. Bu tugma yordamida 
rasm oyna hajmigacha sig‘adigan qilib o‘zgartiriladi (kattalashtiriladi 
yoki kichiklashtiriladi).

Print Size (Размер оттиска) -  printerdan bosmaga chiqqanda 
qanday chiqishini ko‘rsatuvchi tugma.

20. Zoom (Лупа) [Z] — lupa — bu asbob orqali ekrandagi 
tasvirni ko‘rish masshtabini o‘zgartirish mumkin. Tasvirni 
kattalashtirish uchun sichqoncha bilan tasviming kerakli qismiga 
kursorni olib borib bir marta bosish kerak yoki kattalashtirish 
kerak bo‘lgan sohani sichqonchani bosib turib tanlash kerak. Agar 
kichiklashtirish kerak bo‘lsa, u holda Alt tugmasini bosib turib 
sichqoncha bilan rasmga bir marta bosamiz. Ushbu harakatlami 
«qaynoq» tugmalar orqali ham bajarish mumkin: Zoom In 
[Ctrl+Plus] — rasmni kattalashtirish, Zoom Out [Ctrl+Minus] — 
rasmni kichiklashtirish, Actual Pixels [Ctrl+Alt+0] — rasmni 100% 
hajmda ko‘rsatish holatiga o‘tish tugmasi, Ctrl+Alt+Plus — rasmni 
oyna bilan birgalikda kattalashtirish, Ctrl+Alt+Minus — rasmni 
oyna bilan birgalikda kichkinalashtirish, Fit On Screen [Ctrl+0] — 
rasmni butun ekranga sig‘dirish holatiga o‘tish.
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Resize Windows To Fit (Настраивать размер окон) — rasmni 
o‘zi ochilgan oyna bilan birga o‘zgartirish holatini tayinlash.

Ignore Palettes (Без умета палитр) -  oyna kattalashganda 
o‘ng tomondagi yordamchi sohalar orqasiga o4ish mumkinligi 
yoki mumkinmasligini tayinlash.

Parametrlar panelida quyidagilarni kiritish mumkin:

21. m  Ushbu tugma bir nechta amallarni bajaradi:
1) Set Foreground Color (Выбрать цвет передного плана) —

asosiy rangni tanlash — yuqorida turgan kvadrat shaklidagi rang 
ko‘rsatkichini bir marta bosib, hosil boMgan oynadan asosiy rangni 
tanlaymiz.

2) Set Background Color (Выбрать цвет фона) — fon (orqa 
plan) yoki ichki rangni tanlash — orqada turgan rang ko‘rsatkichini 
bir marta bosib, hosil bolgan oynadan fon rangini tanlaymiz.

3) Switch Foreground and Background Colors (Переключить 
цвет переднего плана и цвета фона) [X] — asosiy va fon ranglarini 
olzaro olzgartirish — asosiy va fon ranglari ko‘rsatkichlari ustida 
joylashgan strelka yordamida asosiy va fon ranglarini o‘zaro o‘zgar- 
tirish mumkin.

4) Default Foreground and Background Colors (Установить 
цвет переднего плана и цвета фона по умолчанибю) [D] —
asosiy va fon ranglarini, mos ravishda, qora va oq rangga o‘tkazish — 
asosiy va fon ranglari ko‘rsatkichlari tagida joylashgan kichkina 
belgilar yordamida asosiy rangni — qora, fon rangini esa oqqa 
o'tkazish mumkin.

22. iB ld P I  Screen Mode (Режим экрана) [F] -  ekran holati —
ekran holatini o‘zgartirish tugmasi. Birinchi holat — Standard 
Screen Mode (Страндартный) — standart ekran holati — rasm 
oynasi, menyu satri, asboblar paneli va yordamchi panellar ko‘ri- 
nadigan holat; ikkinchi holat -  Full Screen Mode with Menu Bar 
(Полноэкранный со строкой меню программы) — dastur menyusi 
bor to‘liq ekran holati — dastur qatori, oyna chegaralari, ma’lu- 
motlar satri va ko‘rib chiqish yo‘naltirgichlari ko‘rinmaydi; uchinchi 
holat — Full Screen Mode (Полноэкранный) — menyusiz toMiq 
ekran holati — bu holatda ikkinchi holatga ko‘rinmaydigan ele- 
mentlarga qo‘chimcha yana menyu satri ham ko‘rinmaydigan ek­
ran holati.
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23. Jump to ImageReady (Переключиться в Image-
Ready) [Ctrl+Shift+M] — ImageReady dasturga o‘tish — joriy 
rasmni ImageReady dasturiga o‘tkazadi va uni ushbu dasturda 
tahrirlashni davom ettirishga imkoniyat beradi.

Ls-J Nazorat savollari

1. Adobe Photoshop dasturi ishchi oynasi qaysi elementlardan tashkil 
topgan?

2. Qo‘shimcha panellarning vazifalari haqida aytib bering.
3. Asboblar panelidagi birinchi qator asboblarining ishlash prinsipini 

tushuntiring.
4. Asboblar panelidagi ikkinchi qator asboblarining ishlash prinsipini 

tushuntiring.
5. Parametrlar paneli qanday vazifani o‘taydi?
6. Adobe Photoshop dasturida necha xil ekran holatlari mavjud? Ularga 

izoh bering.
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I l l  BOB. TASVIR SO H A SIN I BELG ILA SH  УА 
QAYTA ISH LA SH

Sohani belgilash (ajratish) — bu fotomontajning eng asosiy 
amallaridan bin hisoblanadi. Sohani belgilash asboblari bilan awalgi 
mavzularda tanishganmiz.

Sohani belgilash asboblari bilan rasmning ixtiyoriy sohasini 
belgilaganimizda, u punktir chiziqlar bilan chegaralangan holda 
ko‘rinadi. Shu tanlangan sohaga yana boshqa ixtiyoriy sohani 
qokshish uchun Shift tugmasini bosib turgan holda qokshimcha 
sohani belgilaymiz (bunda ushbu asbobga mos kursor holatining 
pastki o‘ng burchagida «+» ishorasi paydo boMadi). Shu tanlangan 
sohadan bir qismini chiqarib tashlash uchun Alt tugmasini bosib 
chiqarilishi kerak boMgan sohani belgilaymiz (bunda ushbu asbobga 
mos kursor holatining pastki o‘ng burchagida «—» ishorasi paydo 
bo‘ladi).

Endi bu amallarga doir boMgan Select (Выделение) menyusi 
buyruqlari bilan yaqinroq tanishib chiqamiz.

All (Bee) [Ctrl+A] — barchasini belgilash -  rasm egallagan 
butun sohani belgilash.

Deselect (Разотменить) [Ctrl+D] — belgilashdan chiqarish — 
belgilangan sohani bekor qilish.

Inverse (Инверсия) — tanlashni o‘girish — tanlangan sohani 
belgilashdan chiqarib, belgilanmagan sohani belgilash.

Color (Диапазон цветов) — rang asosida belgilash, «sehrli 
tayoqeha» asbobiga olxshash ishlaydi.

Feather (Растушевка) — chegaralar — belgilangan sohaning 
chegaralari qalinligini tayinlash.

Modify (Изменить) — o‘zgartirishlar — belgilangan sohani turli 
holatlarda o‘zgartirish. Asosiy holatlar: Border (Рамка) — chega­
ralar — belgilangan soha chegaralari bo‘yicha siz ko‘rsatgan hajmda 
belgilangan ramkali sohani yaratadi. Smooth (Сглаживание) — 
chegaralarni silliqlashtirish — belgilangan sohaning burchaksimon 
(zinapoya shaklidagi) chegaralarini silliqlashtiradi. Expand (Растя­
нуть) -  kattalashtirish -  belgilangan sohani siz ko‘rsatgan uzun- 
likda proporsional ravishda kattalashtiradi. Contract (Свернуть) — 
kichiklashtirish — belgilangan sohani siz ko‘rsatgan masofada pro­
porsional ravishda kichiklashtiradi.
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Grow (Смежные пикселы) — yonidagilarni qo‘shish — 
belgilangan soha yonida joylashgan o‘xshash ranglarni ham belgi- 
langan sohaga qo‘shish.

Similar (Схожые пикселы) — o‘xshashlarni qo‘shish — 
ixtiyoriy joyda joylashgan o‘xshash ranglar sohalarini belgilangan 
sohaga qo‘shish.

Transform Selection (Преобразовать выделение) — belgilangan 
sohani o‘zgartirish — belgilangan sohani ixtiyoriy holatda o‘zgar- 
tirish.

Tanlangan sohaning shaklini o‘zgartirish va u bilan turli amal- 
larni bajarish mumkin. Buni Edit (Редактировать) menyusi 
buyruqlari yordamda amalga oshirsa boiadi. Masalan, belgilangan 
sohani xotiraga olish yoki qirqib olish uchun Copy (Копировать), 
Cut (Вырезать), xotiradan qo‘yish uchun esa Paste (Вставить) 
buyruqlarini bajarish kerak.

Qolgan buyruqlar bilan tanishaylik:
Free Transform (Свободное преобразование) — erkin olzgar- 

tirish — ushbu buyruq tanlanganda belgilangan soha yoki rasm 
chegaralarida maxsus nuqtalar paydo bo‘ladi. Ular yordamida bel­
gilangan sohani cho‘zish, qiyshaytirish, aylantirish va boshqa hara- 
katlarni bajarishimiz mumkin.

Transform (Преобразование) — o‘zgartirish — ushbu band 
tanlanganda unga kiruvchi quyidagi buyruqlar chiqadi:

Scale (Масштабирование) — gorizontal va vertikal bo‘yicha 
o‘lchamlarni olzgartirish;

Rotate (Поворот) — aylantirish;
Skew (Наклон) — burchaklardan birini tortish;
Distort (Искажение) — bir nechta burchakni tortish;
Perspective (Перспектива) — perspektiva effektini qo‘llash;
Numeric (Искажение) — berilgan chiziqlar yordamida o‘zgar- 

tirish;
Rotate 180° (Поворот на 180°) — 180° ga burish;
Flip Horizontal (Отразить по горизонтали) — gorizontal 

bo‘yicha akslantirish;
Flip Vertical (Отразить по вертикали) -  vertikal bo‘yicha 

akslantirish.
Endi, sohani belgilashga doir topshiriqning bajarilishini ko‘rib 

chiqamiz, ya’ni otkritka yasaymiz. Bu topshiriqni bajarish algoritmi -  
ketma-ketligi bo‘yicha quyidagi amallarni bajaramiz:
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1) fayllarni ochish buyrug‘i (File > Open) yordamida mavzuga 
doir ikkita tasvirni ochamiz (29-rasm);

29-rasm. Topshiriq uchun tanlangan tasvirlar.

2) 2-fayl (ayiqli rasm)da ["] Marquee Tool asbobini tanlab, 
parametrlar panelida paydo bo‘lgan Feather (Растушевка) may- 
doniga belgilangan sohaning chegaralari qalinligini 20 pik qilib 
belgilaymiz, Style (Стиль) maydonida normal holatiga o‘tib, kerakli 
sohani belgilaymiz;

3) uni nusxalaymiz {Copy) va 1-faylga qo‘yamiz (Paste);
4) nusxalagan obyektni kerakli joyga joylashtiramiz;
5) Adjust (Корректировка) buyrug‘i yordamida rasmning rang- 

lari ustidan turli tahrirlash amallarni bajaramiz;
7) gorizontal matn asbobini tanlab, parametrlar panelida paydo 

bo‘lgan maydonlarga kerakli ma’lumotlami kiritib, yoysimon kolri- 
nishdagi matn yaratamiz;

8) Brush [B] asbobini tanlab, Brush maydonidan 74-raqamli 
barg ko‘rinishidagi mo‘yqalamni tanlab, uning yordamida tasviri- 
mizning ba’zi joylariga barglar rasmini qo‘yib chiqamiz;

9) ko‘rinadigan qatlamlarni birlashtiramiz (faol bo‘lgan barcha 
palitralarni, asboblar panelini Tab tugmachasi bilan vaqtincha ek- 
randan olib turish mumkin, bu hosil bo‘lgan tasvirimizni yaqqol 
ko‘rish imkonini beradi; Tab tugmasi qayta bosilsa, palitralar yana 
chiqadi);

10) hosil boMgan tasvirni jpg formatida saqlash bilan topshi- 
riqni yakunlaymiz (30-rasm).

Photoshop dasturining birinchi darajali vazifalaridan biri belgi- 
lash funksiyasidir, u kerakli tasvir sohasini boshqalaridan ajratish 
imkonini beradi, ya’ni faqat belgilangan obyektni qoldirib, bosh-
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30-rasm. Hosil bo‘ lgan otkritka tasviri.

qalarini olib tashlaydi. Odatda, sohalarni belgilash uchun asboblar 
panelida joylashgan maxsus belgilash asboblaridan foydalaniladi. 
Biroq berilgan operatsiyani Extract (Извлечь) — chiqarib olmoq 
filtri yordamida ham bajarish mumkin. Filtrni ishlatishdan oldin 
tasvimi keyinchalik o‘zgartirishga imkon bo‘lishi uchun Layers 
(Слои) qatlamlar palitrasida qatlamning piktogrammasi qarshisida 
yopilgan qulf shaklidagi taqiqlash belgisi bo‘lsa, u holda ikki marta 
sichqonchaning chap tugmachasini bosib, paydo bo‘lgan muloqot 
oynasida OK tugmasini bosing. Shundan so‘ng, Filter (Фильтр) > 
Extract (Извлечь) buyrug‘ini tanlang. Ushbu filtr obyektning 
biror sohasini ajratishga yordam beradi, bunda shu obyektning 
qolgan qismi o‘chirib tashlanadi. Filtming muloqot oynasi oynaning 
chap qismida joylashgan belgilash va tasvir bo‘yicha navigatsiya 
asboblarini hamda o‘ng qismida joylashgan filtrni sozlash panelini 
o‘z ichiga oladi.

Yuqorida ko‘rib chiqqan filtr bo‘yicha ikkita tasvimi birlashtirib, 
bir holatdan boshqa holatga (qish faslidan yoz fasliga) o‘tishni 
misol tariqasida ko‘rib chiqamiz. Buning uchun quyidagi amallar 
algoritmini bajaramiz:
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31-rasm. Topshir iq  uchun tanlangan qish va yoz fasllari aks ctgan tasvirlar.

1. Ikkita tasvir olamiz, ya'ni import qilamiz (31-rasm).
2. Qish faslidagi ayiqni yoz fasliga o'tkazamiz. Ayiq rasmiga 

turli tuzatishlar kiritish lozim, chunki unda nuqsonlar mavjud. Bosh 
ko‘rinishni belgilab, orqa fonni olib tashlash va ayiq rasmini yoz 
fasliga qolyish kerak boMadi. Buning uchun Fiber (Филыр) > Extract 
(Извлечь)ЬиупщЧш tanlaymiz (32-rasm) va yuqoridagi ishlarni 
amalga oshiramiz. Shuni eslatib o‘tish kerakki, tasvir ustidan ishlov 
beriladi, shuning uchun qatlamdagi qulfni olib tashlash kerak boMadi.

3. Extract (Извлечь) filtrining muloqot oynasidagi asboblar 
va sozlash panelidan foydalanib, bosh kokrinishni orqa kokrinishdan 
ajratamiz (33-rasm).

4. Preview (Предварительный просмотр) -  oldindan kobrish 
tugmachasini bosib, bajarilgan belgilash ma’qul boMsa, OK tug- 
machasini bosamiz va hosil boMgan tasvirni olamiz (34-rasm).

5. Ikki obyekt (ayiq va daraxt)ga ishlov beramiz -  yoz fasliga 
mos kelmagan nuqsonlarni, masalan, qorni olib tashlaymiz. Buning 
uchun asboblar panelidagi asboblardan foydalanib, tegishli tuza- 
tishlarni amalga oshiramiz (35-rasm).

6. So‘ngra hosil boMgan tasvirning fonini — yoz faslining tasvirini 
yaratamiz, buning uchun yoz faslini ayiq joylashgan faylga yangi 
qatlam qilib oMkazamiz (36-rasm).

7. Tasvirni jpg formatida saqlaymiz (37-rasm).
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33-rasm. Bosh ko'rinishni orqa ko'rinishdan ajratish. 

40
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Файл Редастироеамие Изображение Спои Выделение Фильтр Анализ 3D Просмотр Окно Справа

36-rasm. Ayiq va daraxt tasviri ostiga yoz fasli tasvirining qo'yilishi.

Nazorat savollari

1. Adobe Photoshop dasturida 
biror sohani belgilash qandav amalga 
oshiriladi?

2. Select menyusi buymqlari lia- 
qida ma’lumot bering.

3. Free Transform buyrugMning 
vazifasi nimadan iborat?

4. Extract buyrugM yordamida 
qanday amallarni bajarish mumkin?

37-rasm. N ati jad a  hosil boMgan

lasv irn ing  k o ‘ rinishi.
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IV BOB. M O ‘YQ A LA M  VA R A S S O M C H IL IK  
A S B O B L A R I

4 .1 . M o ‘yqalam lam i tan lash , yuklash va saq lash

Brush Tool (Кисть) [В] — mo‘yqalam — asosiy chizish
asbobi. Molyqalamdan foydalangan vaqtda Shift tugmasini bosib 
turgan holda sichqoncha bilan chizsak, u holda to‘g‘ri chiziqlar 
hosil boMadi. Shift tugmasi yordamida sichqonchani bosib, hosil 
bo‘lgan nuqtalarni bir-biri bilan to‘g‘ri chiziqlar orqali bog‘lash 
mumkin. Mo‘yqalam bilan chizilgan chiziqlarning chegaralari aniq 
boklmaydi.

Parametrlar panelida quyidagi parametrlarni kiritish mumkin:
Brush (Кисть) — qalam turi va qalinligini tanlash;
Mode (Режим) -  chiziqlarni rasm ustiga qo‘yilish turini 

tanlash;
Opacity (Непрозрачность) -  chiziqlar ko‘rinish darajasini 

o‘zgartirish;
Auto Erase (Автостирание) — old fon rangini o‘z ichiga oluvchi 

sohalar ustidan orqa fon rangida chizish imkonini beradi;
Wet Edges (Мокрые края) — «ho‘l chegaralar» — mo‘yqalam 

chetlarida ranglarni kuchaytirib, xuddi akvarel bilan chizish ef- 
fektini beradi.

Brush (Кисть) asbobini tanlash, yuklash va saqlashni quyidagi 
ketma-ketlikda ko‘rib chiqamiz:

1) Brush (Кисть) asbobini bosamiz (38-rasm).

Fie Edt Image Layer Select Flter view Window

Farther: |o px | OAntt-iH.a

38-rasm. Brush (Кисть) asbobini tanlash.
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2) Brush (Кисть) paneliga kiramiz (39-rasm).

J  Adobe Photoshop

Файл Редактирование Изображен« Слой Выделен« Фшьтр Просмотр Окно Сгравка 

^  *  | Кисть:  ̂ Р  | Реюм: | Норшльный ,У

(  Гпвныйди^тр \  | 4 пиксГ

- з а

Жест косты  | 100% |

■------------------------- J
j  Ж а с тк»  кр у гл »  1 пике. Л

j  Жесткжи кр у гл и  3 пике,

j  Жссткая круглая S пике,

о Жесткая кр у гл »  9 пике.

39-rasm. Brush paneli oynasi.

3) Keyin Brush (Кисть) panelining yuqori olng burchagida 
joylashgan strelkani bosib, mo‘yqalamlarni boshqarish menyusiga 
kiramiz. U yerdan Brush Load (Загрузить кисти) — molyqalamlami 
yuklash bandini tanlaymiz va mokyqalamlarni yuklaymiz (40-rasm).

Д  Adobe Photoshop
Файл Редакпфовагме Изображен« Слои Выделение Фильтр Просмотр Окно Справка

^  ■* | Кисть: * | j Режим: | Нормальный у  | Нвпрозр.: | 100М > ] | Нажим: | IOOS ► ]

40-rasm. M o 'y qa lam larn i  yuklash.
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4) Photoshop dasturi yopilgandan sokng yuklangan molyqa- 
lamlar rolyxatdan yo'qolib ketmasligi uchun yana birbor mo‘yqa- 
lamlarni boshqarish menyusiga kirib, Brush Save (Сохранить 
кисти) bandini tanlab, mo‘yqalamlarni saqlab qo‘yamiz (41-rasm).

J  Adobe Photoshop
Файл Редакпроеаше Изображение Слои Бьшелете Фи/ьтр Просмотр Окно Справка

Кисть:

41 -rasm. Mo'yqalamlarni saqlash.

4 .2 . M o ‘yqalam lam i sozlash

Mo‘yqalamni sozlash uchun Brushes palette (Палитра кистей) —
mokyqalamlar palitrasini parametrlar panelidagi unga mos tugmani 
bosib faollashtiramiz (42-rasm).

Uchta asosiy mokyqalamlarni sozlash bandlarini ko‘rib chi- 
qamiz (43-rasm):

1. Динамика формы — shakl dinamikasi.
2. Рассеивание — sochilish.
3. Динамика цвета — rang dinamikasi.
Sochilish bilan shakl dinamikasi bandlarini birga qollash kerak, 

aks holda sozlash samarasiz boMib qoladi. Shakl dinamikasi bandiga 
tegishli sozlashlardan ikkitasi kolproq qoMlaniladi (44-rasm):
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ид Окно Помощь

йю*3| loo* ill Г ъ ы ~\с
Н а б о р ы  к ^ о е * "

Форм КИСТИ 

Г~|Л|«ШЧЦ формы ft
[ Ц Р К С « « М 1 * St
□  Текстур» St
О Д ю А и яки стъ tt
В д и ш м и  ЦМТ4 si
П Д руги* ш и н к и fir
□  Шуи St
□  Мокры* 1ф м Si
□  Пульмриытор St

■:м«гч«нт Q
О З кц и т*  текстуры St

•  Ф •  -
12

•  Ф Ф  •  Ф #
13 17

•  ф Л  •  • •
к 18

•  ф A  •  • •  |
18 21 i

•  ф Л  •  • •  4
1Э 24

•  ф A  •  •
24 28

Ф  ф A  *  • •
28 35

Ф  ф A  •  • •
32 « M

Глш ы й ди*м*тр | 24гкс

42-rasm. Brushes palette -  mo‘yqalamlar palitrasini faollashtirish.

ид Окно Помощь

100* у  | Т п и ш  | 100* П  ¡& Q  | " \с

фор>х t i
Форм* кисти

^  Р«семч и 1«

□  Тжстур* ^

□  Д Ю Й К Н  КИСТЬ а

О Други* « м м м ки  а
□  Шум ft
□  Мокры* кр м

□  Пульмриытор Ц
. : н , г , * н . , ,  Q

[ I Змцит* текстуры

•  ф •  •  • •  -
12

•  ф •  •  • •
13

•  ф ф  •  • •
16

Ф  ф ф  •  •
18

•  ф •  •  • ф J
19

•  •
•  а  •

•
24

•  Ф •  •  • •
28

Ф ф •  •  • •
32 45 У

Гл**ньА диммтр | 24 пк с

43-rasm.
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Наборы кистей 1 ГДЖИТТ*Р рцн»р |

Форм) кисти

М асш таб наклона

□р»
□  т*кстура £

П  Даойная кисть  ^
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□  Другие ж»*ш *жи ^  ,----------------------
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9  а |.::|
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.------------------------------------------------------------------------------------------------------------------------------------------- ^1 1
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100* Jgj | TmMl I 100« ~в ж : Q  1
Н*6оры кистей П*р*дний^»оно*ый джиттер | 44%

,-------------------------------------------------------------Л---------------------------------------
Ф орм  кисти 

Г~1 ДьМИИК* ф ор»|

□  Piccewwew

□  Т ж стур ! ft
□  Д*ойнм кисть Ц

Упр**л«ни* 1  | Выкл. VI11

Джиттер оттанк* | 88%

J
Джиттер н ю ш и н «  | 5 7%
(------------------------------------------------------------------------------- J -----------------------------
Джиттер *ж о с ти  | 50%

J ----------------------------------
П Ш У "  ft
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П П ульм рим тор  ft
□  Сижч*ни*

□  Змцита текстуры Ц
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J

...........  ............^

46-rasm. Rang dinamikasi bandiga oid sozlashJar oynasi.

1) Джиттер размера — oklcham djitteri — mo‘yqalam o‘lcham 
darajasi o‘rnatiladi, ya’ni mo‘yqalam kichkina, o‘rta, katta bo‘lishi 
mumkin.

2) Джиттер угла — burchak djitteri — tegishli ravishda mo'y- 
qalam burchagi o‘rnatiladi.

Sochilish bandining asosiy sozlashlari quyidagilardan iborat 
(45-rasm):

1) Рассеивание — sochilish — sochilish darajasi olrnatiladi;
2) Счет — hisob — ushbu sozlash yordamida mo‘yqalam sochi­

lish zichligi darajasi o‘rnatiladi.
Rang dinamikasi bandiga oid sozlashlarning barchasini sozlab 

chiqish kerak bo‘ladi (46-rasm).

—=—II Nazorat savollari

1. Mo‘yqalamlami tanlash, yuklash va saqlash amallari haqida ma’lumot 
bering.

2. Molyqalamlarni sozlash qanday amalga oshiriladi?
3. 0 ‘zingiz mustaqil ravishda biror mo‘yqalamning parametrlarini sozlab 

chiqing.
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V B O B . K O N T U R L A R N I Y A R A T ISH  VA 
T A H R IR L A S H . S H A K L L A R  B IL A N  IS H L A S H

5.1 . R asm larni tahrirlash

Rasmlar, tasvirlar, fotosuratlar va h.k.larni tahrirlash uchun 
Photoshop dasturining quyidagi asboblaridan foydalaniladi:

1* l&J Clone Stamp Tool (Копирующий штамп) [S] -  nusxa 
oluvchi shtamp — rasmning biror qismidan piksellar nusxasini 
olib, yangi joyga qo‘yish uchun ishlatiladi. Nusxalanayotgan pik­
sellar ularning ustiga kursorni keltirib, Alt tugmasini bosib turgan 
holda sichqonchani bosish orqali tanlanadi. Yangi hosil boMadigan 
piksellar aynan nusxalanayotgan piksellarning o‘zidek boMadi.

Pattern Stamp (Узорный штамп) [S] -  naqsh qo'yuvchi
shtamp — Patterns (Узоры) palitrasida tanlangan naqsh bilan 
ko‘rsatilgan sohani toMdirish. Agar olzingiz yangi naqsh yaratmoq- 
chi bo‘lsangiz, u holda quyidagilarni bajarish kerak: 1) Rectangular 
Marquee Tool asbobi yordamida naqsh joylashgan sohani belgi- 
laymiz; 2) Edit > Define Pattern (Правка > Назначить узор) 
buyrug‘ini tanlaymiz va uni Patterns palitrasiga saqlab qo‘yamiz.

Parametrlar paneliga quyidagi parametrlarni kiritish mumkin:
Brush (Кисть) — qalam turi va qalinligini tanlash;
Mode (Режим) — chiziqlami rasm ustiga qolyilish turini tanlash;
Opacity (Непрозрачность) — chiziqlar ko‘rinish darajasini 

o‘zgartirish;
Auto Erase (Автостирание) — old fon rangini o‘z ichiga oluvchi 

sohalar ustidan orqa fon rangida chizish imkonini beradi;
Aligned (Выравнивание) — naqsh chizayotganda naqsh qism- 

larining bir-biriga ulanishini ta’minlovchi parametr. Agar bu para- 
metr tanlangan bo‘lsa, u holda, siz qancha vaqt chizishdan to‘x- 
taganingizdan qat’i nazar, chizishni davom ettirganingizda naqsh 
to‘xtagan qismidan boshlab uzluksiz davom etib ketadi. Aks holda, 
naqsh yana boshlang‘ich qismidan boshlab chiziladi.

2. [jgj History Brush Tool (Архивная кисть) [Y] — avvalgi 
holatga qaytish -  bu asbobni tanlashdan oldin qaytish kerak bo‘lgan 
holatni History (История) yordamchi sohasida belgilashingiz kerak. 
Solngra ushbu asbob bilan shu holatdan keyingi hamma harakat- 
larni ko‘rsatilgan sohada o‘chirishingiz mumkin bo‘ladi.
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| ЛИ Art History Brush Tool (Архивная художественная кисть)
[Y] — awalgi holatga badiiy qaytish — awalgi holatga qaytish 
asbobiga o‘xshash bo‘lib, farqi oldingi holatga qaytishda turli 
maxsus effektlardan foydalanish imkoniyati mavjud.

Parametrlar panelida quyidagi parametrlami kiritish mumkin:
Brush (Кисть) — qalam turi va qalinligini tanlash;
Mode (Режим) -  chiziqlami rasm ustiga qo‘yilish turini tanlash;
Opacity (Непрозрачность) — chiziqlar ko‘rinish darajasini 

o‘zgartirish;
Style (Стиль) — maxsus effektni tanlash;
Tolerance (Допуск) — ranglardan foydalanish, 100% da — 

tasvirdagi ranglar, 0% da — ranglar ixtiyoriy olinadi;
Area (Диаметр) — asbobning ta’sir etish sohasini tanlash.
3. Airbrush (Аэрограф) [J] — puliverizatorga o‘xshash 

chizish asbobi. Agar aerografdan foydalanish vaqtida Shift tugmasini 
bosib sichqoncha bilan chizsak, u holda to‘g‘ri chiziqlar chiziladi. 
Shift tugmasi yordamida sichqonchani bosib, nuqtalarni bir-biri 
bilan bog‘lash ham mumkin.

Parametrlar panelida quyidagi parametrlami kiritish mumkin:
Brush (Кисть) — qalam turi va qalinligini tanlash;
Mode (Режим) — chiziqlami rasm ustiga qo‘yilish turini tanlash;
Pressure — bo‘yoqni sepish kuchini tanlash.
4. ЦП Blur Tool (Размытие) [R] — kontrastni kamaytirish 

yoki ranglami yoyish uchun ishlatiladi.
П  Sharpen Tool (Резкость) [R] — kontrastni ko‘paytirish 

yoki ranglami aniqlashtirish asbobi.
Щ  Smudge (Размыватель) [R] — rang yoyish yoki tortish asbobi.
Parametrlar panelida quyidagi parametrlami kiritish mumkin 

bo‘ladi:
Brush (Кисть) -  qalam (mo‘yqalam) turi va qalinligini tanlash;
Mode (Режим) — ranglami o‘zgartirish holatini sozlash;
Pressure (Нажим) — yoyish kuchini o‘zgartirish;
Use AH Layers (Семплировать все слои) — yoyilish hamma qat- 

lamlarga yoki faqat asosiy bo‘lgan qatlamga ta’sir etishini ta’minlaydi;
Finger Painting (Рисование пальцем) -  rangga botirilgan 

barmoq bilan chizish effektiga o‘tish.
5* [Щ Dodge Tool (Осветитель) [О] -  tasvir ranglarini 

ochartirish asbobi.
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|-{gj Burn Tool (Затемнитель) [О] — tasvir ranglarini to‘qar- 
tirish asbobi.

\Ш\ Sponge Tool (Губка) [О] — biror soha ranglarining och- 
to‘qligini mayin o‘zgartirish asbobi.

Parametrlar panelida quyidagi parametrlarni kiritish mumkin 
bo‘ladi:

Brush (Кисть) -  qalam (mo‘yqalam) turi va qalinligini tanlash;
Range (Диапазон) — ta’sir ko‘rsatish lozim bo‘lgan ranglar 

diapazonini tanlash (Shadows — to‘q ranglar; Midtones — hamma 
ranglar va Highlights — och ranglar);

Exposure (Экспоз.) — ranglami ochartirish kuchini o‘zgartirish;
Mode (Режим) -  ranglaming to‘yinganligini sozlash (Desaturate 

(Снизить насыщенность) — kamaytirish yoki Saturate (Повысить 
насыщенность) — ko‘paytirish).

Pressure (Нажим) — asbobning ta’sir kuchini o‘zgartirish.

5.2. Image, Select va Edit menyu bo‘limlari

Tasvir ranglarini, hajmini va boshqa xususiyatlarini o‘zgartirish 
uchun Image (Образ) menyu bo‘limiga kiruvchi buyruqlardan 
foydalaniladi. Bulardan eng asosiylari bilan tanishib chiqaylik: 

Mode (Режим) -  holat buy rug1 i -  tasvirni qaysi ranglarda 
ifoda etish holatlarini o‘zgartirish uchun ishlatiladi, unga quyidagi 
holatlar kiradi: Grayscale (Градации серого) -  kulrang holatiga 
cVtkazish; Indexed Color (Индексированные цвета) — ko‘rsatilgan 
ranglar holatiga o‘tkazish (256 gacha rang); CM YK Color — to‘rtta 
asosiy ranglar (Cyan (C) — moviy, Magenta (M) — qizg‘ish, Yellow 
(Y) — sariq, Black (K) — qora rang) orqali ifoda etish holatiga 
o‘tkazish; RGB Color -  uchta asosiy ranglar (Red (R) -  qizil, 
Green (G) — yashil, Blue (B) — ko‘k rang) orqali ifoda etish 
holatiga o‘tkazish.

Adjust (Корректировка) — ranglarni tahrirlash -  bu buy- 
ruqning aksariyat bandlari ranglar ustidan turli tahrirlash amallarini 
bajarish uchun yordam beradi.

Awalgi mavzularda o‘tilgan bilimlami o‘z ichiga qamrab oluvchi 
biror mashqning bajarilishini ko‘rib chiqalik. Faraz qilaylik, mashq 
daftari uchun muqova tayyorlash kerak. Bu muqovaning tayyor 
holati 47-rasmdagi kabi ko‘rinishda bo‘ladi.
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47-rasm. Muqovaning tayyor holdagi ko'rinishi.

Muqova tayyorlash algoritmini ketma-ket bajaramiz:
1. Photoshop dasturini ishga tushiramiz va 500x300 piksel 

o‘lchamda yangi fayl ochamiz hamda uning fonini xohlagan rangga 
(bizning misolda, #6e6e6e) ЫУуаЬ olamiz (48-rasm).

48 -rasm. Yangi fayl ochish  va uning foniga rang berish.
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2. Yangi qatlam (layer) ochainiz (C trl+ A lt+ Sh ift+ N ) va 
Rectangular Marquee (M ) asbobini tanlaymiz.

Ushbu asbob yordamida 49-rasmda ko‘rsatilgandek shakl 
chizamiz va ushbu shaklni (#eeeeee) rangiga bokyaymiz (49-rasm).

49-rasm. Shakl chizish.

3. Belgilangan joyni o‘z holatiga qaytarish uchun C trl+D  
tugmalarini bosamiz va ushbu qatlamni nusxalaymiz (C tr l+ J)  
hamda o‘ng tomonga olib ofctamiz (50-rasm).

50-rasm. Shaklni nusxalab, ong tomonga olib o‘tish. 
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4. So‘ngra muqovaning betlarini bir-biriga bogMaydigan uch 
oMchamli shakl tayyorlaymiz. Buning uchun joriy qatlamni Select > 
Load Selection buyrugini tanlash orqali belgilaymiz.

Yangi qatlam ochamiz (C trl+A lt+Sh ift+N ), Gradient (G ) 
asbobini tanlab, ranglarni qoradan shaffofga moslaymiz va chap 
tomondan okngga qarab gradiyent chizamiz (51-rasm).

51-rasm. Gradiyent chizish.

Belgilangan joyni o‘z holatiga qaytarish uchun C trl+D  tugma- 
larini bosamiz va C tr l+ J tugmalarini bosish orqali ushbu qatlamni 
nusxalaymiz hamda qatlam hajmini kichraytiramiz (52-rasm).

52-rasm. Q atlam  hajmini kichraytirish.
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5. Ushbu qatlamni pastdagi qatlam bilan birlashtirish uchun 
C trl+E  tugmalarini bosamiz. Endi esa ushbu qatlamni nusxalaymiz 
(C t r l+ J )  va bu qatlamni gorizontal o‘girish uchun Edit > 
Transform > Flip Horizontal buyrug‘ini tanlaymiz va hosil boigan 
qatlamni muqovamizning chap tomoniga akslantiramiz (53-rasm).

53-rasm. Qatlamni chap tomonga gorizontal akslantirish.

6. Endi ushbu qora shakl yoniga oq shakl chizib olishimiz 
kerak. Buning uchun yangi qatlam ochamiz (Ctrl+AIt+ Shift+N ), 
Rectangular Marquee (M ) asbobi yordamida 54-rasmdagi kabi 
shakl chizib, sokngra Gradient (G) asbobini tanlab, ranglarni oq- 
dan shaffofga moslab, shaklimizning chap tomonidan o‘ng to­
monga qarab gradiyent chizamiz (54-rasm).

54-rasm. G radiyent  chizish.
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7. Belgalangan joyni o‘z holatiga qaytarish uchun C trl+D  
tugmalarini bosamiz va belgilangan sohaga Filter > Blur > Motion 
Blur buyrugini qoMIaymiz (55-rasm).

0  M»* 0  

Angle: |B |°

Cbtance: [26 pbceb

55-rasm. Filter > Blur > Motion Blur buyrug i oynasi.

8. Yuqoridagi bosqichni muqovamizning chap qismiga ham 
qoilaymiz (56-rasm).

56-rasm.
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9. Ushbu boqichda ikkita muqovani bir-biriga bogMab chiqamiz. 
Line (U) asbobni tanlaymiz (Weight: 3 px) va 57-rasmda ko‘r- 
satilgan joyga oq rangli shakl chizamiz (57-rasm).

57-rasm. Shakl chizish.

Ushbu qatlamni tanlaymiz va Layer > Rasterize > Shape va 
Select > Load Selection buyruqlarini bajaramiz.

10. Yangi qatlam ochamiz (C trl+A lt+Sh ift+N ), bu qatlamni 
«sim l» deb nomlab olamiz. Gradient (G) asbobini tanlab, ranglarni 
qoradan shaffiofga moslab, shaklning qog‘ozga birlashadigan joy- 
lariga gradiyent chizamiz (58-rasm).

58-rasm. Shaklning qog‘ozga birlashadigan joylariga gradiyent chizish.
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11. Belgilangan joyni o‘z holatiga qaytarish uchun C trl+D  
tugmalarini bosamiz va Edit > Free Transform buyruglni tanlab, 
shaklni ozgina o‘ng tomonga qiyalatamiz (59-rasm).

12. Shaklga quyidagi efïektlarni ketma-ket qo‘llaymiz:
Layer > Layer style > Inner Shadow effektini quyidagi para- 

metrlar bilan qo‘llaymiz (60-rasm):

Sty lts

BtarMfing Options: D*f*urt

□  Drop Shtdov

0 O u t * r  <3ov 

Q h M r  G o v

□  B«vtJ and Emboss

□  Contow

□  T «x tir«

□  Satin

□  Coter Ov«rUy

□  G r« fitn t O w ia y

□  P*tt«rn O v trU y

□  Strok«

Immt Sk«é>v
— S f r a d v c  -

Band Mod*: | muIW y & j | |

O p*d ty : I A  -

Q ( s z 3 *
Dirttnce: ^  

Chokt:

•■<5=

U l U *

□  Um  <3ob*l Light

= h fr*
= [5 1«
=  lo  |px

Q oaH ty

Contour: \Æ  □Antf-«l*s«d

1° I*

OK

Cancel

New Style... 

0  Preview

60-rasm. Layer > Layer style >  Inner Shadow oynasi.
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Outer Glow effektini quyidagi parametrlar bilan qollaymiz 
(61 -rasm):

Styles

Bandhg Options: Default

□  Drop Shadov 

[7 |lm a r Shadow

□  inner O o v

□  Bevel and Emboss

□  Contotr

□  Texture

□  SaUr

□  Color Overlay

□  <jratfent Overlay

□  Pattern Overlay

□  Stroke

O a ta r  O a v  ---------
-  S t n c t o r a  .........

Btand Mod«: | Normal 

O padty: i _ \ _

©I

ÆSpread:̂  
S k a : ,5 = 0 Z >

Qorfty

Contour:

Range: c  

J i t t e r : ^

g

New Style... 

0  Preview

61-rasm. Layer > Layer style > Outer Glow oynasi.

Shundan keyin bizda quyidagicha natija hosil bo‘ladi (62-rasm):

62-rasm. Shaklga effektlar qo'llagandan keyingi natija.
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13. Endi sim muqovaning ikkala betini birlashtirib turishi uchun 
qog‘ozlarda u kirib turadigan teshiklarni tayyorlaymiz Buning 
uchun «siml» qatlamining ostidan yangi qatlam ochamiz (C trl+  
A lt+Shift+N ) va Elliptical Marquee (M ) asbobi yordamida quyi- 
dagicha shakl chizib, uni qora rangga bo‘yab olamiz (63-rasm).

63-rasm. Qog‘ozlar uchun teshik tayyorlash.

14. Belgilangan joyni o‘z holatiga qaytarish uchun Ctrl+D tug- 
malarini bosamiz va ushbu qatlamni nusxalaymiz (C tr l+ J)  hamda 
muqovaning o‘ng tomoniga olib o‘tamiz (64-rasm).

64-rasm. Teshikni nusxalab, o‘ng tomonga qo'yish. 
60



15. Endi simli qatlam va ikkita qora aylana chizilgan qatlamlarni 
birlashtiramiz (C trl+E ) va ushbu qatlamni bir necha bor nusxalab 
(C tr l+ J) , quyidagicha ketma-ketlikda qo‘yib chiqamiz (65-rasm).

65-rasm.

16. Simli qatlamlarni birlashtirib chiqamiz (C trl+E) va hosil 
boMgan qatlamga Layer > Layer style > Drop shadow effektini 
qoMlaymiz (66-rasm):

Layer Stylo
Stytes

Binding Option«: Dafault

Q  Dr o|> S h itd o v

[~~1 I m r  Shadow

□  O u ttr G*ov 

nirw Qov
[~1 Bavaf and Emboss 

I 1 Contour 

□  Taxtura

□  Satin

P I Color Ovariay 

f~ l Gradwnt Ovariay 

f~ l Pattam Ovariay

□  Stroka

D rop Shadow 
-- S t r ic t o r «  -

Q tu U ly

Contov 

Nofsa: ^

*  D u n  Glob»l Light

|3 |PX

a i  I I Antl-alŵl
------J 15 I*

1^1 L *y «r Knocks O ut Drop Sh«dov

New Style... 

0  Preview

66-rasm. Layer > Layer style > Drop shadow oynasi. 
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17. Ushbu qatlam ustiga sichqonchaning o‘ng tugmasini bosib, 
Create Layer buyrug‘ini tanlaymiz (67-rasm).

[!•

kuterGtow...
Bevel and Emboss... —

Satii...
Color Overlay
Gradient Overlay... —

Pattern Overlay...
Stroke...

Copy Layer Style
Paste Layer Style
Clear Layer Style

Global Ught..

Hide A1 Effects
Scale Effects...

67-rasm. Create Layer buyrug'ini tanlash.

Ko'rib turganingizdek, yana bitta qatlam paydo bo‘ldi (68- 
rasm). Ushbu qatlam ostida turgan qatlamni tanlaymiz.

68-rasm. Yangi qatlam ko‘rinishi.

Eraser (E ) asbobini tanlaymiz, 13 px li yumshoq mo‘yqalamni 
tanlab, yon tomondagi soyalami o‘chirib chiqamiz.
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18. Nihoyat oxirigi bosqichni bajaramiz. Simli qatlamni tanlab, 
Create Layer (C tr l+ J)  buyrugki orqali uni nusxalaymiz. Bu qat- 
lamga Edit > Transform > Flip Horizontal buyruglni qoMlab, 
Move (V) asbobi yordamida ozgina yuqoriga ko‘taramiz.

Ushbu nusxalangan qatlamni barcha qatlamlar ostiga olib 
oktamiz, ya’ni qatlamlar palitrasida orqa fon (background) pikto- 
grammasining yuqorisiga ushbu qatlam piktorammasini qo‘yamiz.

Endi Layer > Layer style > Color Overlay buyrug'ini bajaramiz 
(69-rasm).

Styte*

Btandng Option«:

□  Drop Shadow 

O ln m r  Shadow

□  O uU r <3ow

□  inn*- Q o v

f~ l B*v«l and Embou 

I " !  Contcnj*

□ Ttxtir»
□  S*«n

□  OvarUy

□  P»H«m OvtrUy

□  Strok*

OK

Cancel

New Style... 

0  Preview

69-rasm. Layer > Layer style > Color Overlay oynasi.

Nihoyat mashqimiz tugadi. Ushbu muqovaga matn yozishimiz 
ham mumkin. Natija 70-rasmdagi kabi ko‘rinishda boladi. Shuni 
aytish mumkinki, ushbu yoM bilan siz nafaqat muqova, balki buk- 
letlar ham yasashingiz va uni yaqinlaringizga sovg‘a qilishingiz 
mumkin.

Hozirgi kunda sodda va murakkab rastrli grafikani tahrirlash 
dasturlarining soni juda ko'pdir. Shunday dasturlardan biri — 
Windows operatsion tizimi tarkibiga kiruvchi Paint dasturidir. 
Mazkur dastur oddiy amallarni bajarish imkoniyatini beradi, lekin 
professional darajadagi imkoniyatlardan foydalanish uchun maxsus 
rastrli grafik dasturlaridan foydalanish kerak bo‘ladi.
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70-rasm. Muqovaning natijaviy ko'rinishi.

Adobe Photoshop dasturi hozirgi kunda eng mashhur va butun 
dunyo mutaxassislari tomonidan tan olingan grafik dastur hisob- 
lanadi. Bunga asosiy sabablar — tasvir bilan ishlashdagi keng im- 
koniyatlarning mavjudligi, qulay va oson interfeys, deyarli barcha 
grafik formatlar va tizimlar bilan ishlay olishi.

Adobe Photoshop dasturining oxirgi versiyalari Adobe 
Photoshop CS, Adobe Photoshop CS5 bo‘lib, ular rastrli grafika 
bilan ishlovchi deyarli barcha zamonaviy texnologiyalarni qamrab 
oigan.

Photoshop dasturida oddiy shakllarni chizish quyidagi asboblar 
orqali amalga oshiriladi:

1. [Ey Rectangle (Прямоугольник) [U] — to‘rtburchak — 
to‘rtburchak chizish.

I o j  Rounded Rectangle (Скругленный прямоугольник) [U] —
aylanasimon to‘rtburchak — aylanasimon to‘rtburchak chizish. 
Bu asbob tanlanganda Parametrlar panelida chiqadigan Radius 
maydonida burchaklar radiusini kiritish mumkin.

[Ö] Ellipse (Эллипс) [U] — aylana — aylana, oval chizish.

5.3. Shakllar bilan ishlash
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1 Polygon (Многоугольник) [U] — ko‘pburchak — ko‘p- 
burchak chizish. Bu asbob tanlanganda Parametrlar panelida chi- 
qadigan Sides (Стороны) maydonida ko‘pburchak tomonlarining 
sonini ko‘rsatish mumkin.

Line (Линия) [U] -  chiziq — to‘g‘ri chiziq chizish. Chiziq 
qalinligini Weight (Толщина) maydonida ko‘rsatish mumkin.

■  Custom Shape (Произвольная фигура) [U] — maxsus 
shakllar, turli tayyor shakllar chizish. Parametrlar panelida chiqa- 
digan Shape (Фигура) maydonida kerakli shaklni tanlash mumkin.

Наг qaysi shakl chizish asbobi uchun parametrlar panelida 
quyidagi parametrlarni kiritish mumkin:

shakl chizilish holatini o‘zgartirish tugmalari (Create New 
Shape Layer — shakl yangi qatlamda chiziladi; Create New Work 
Path — shaklning konturi bo‘yicha yangi yo‘llar paydo bo‘ladi; 
Filled Region — shakl joriy qatlamda chiziladi);

shakl chizish yo‘llari (Unconstrained — ixtiyoriy; Square — 
teng tomonli; Fixed Size — o‘matilgan oichamli; Proportional — 
proporsional).

Layer Style (Стиль) — rang bilan b o ‘yash turi.
2 .Щ  Pen Tool (Перо) [P] — pero — sichqoncha yordamida 

nuqtalar orqali shakl yaratish imkonini beradi.
■  Freeform Pen (Произвольное перо) [P] -  ixtiyoriy pero — 

sichqonchani bosib turgan holda ixtiyoriy harakatlar bilan shakl 
yaratiladi.

Add Anchor Point (Добвить точку) — yangi nuqta qo‘- 
shish — sichqoncha yordamida shaklga yangi burilish nuqtasi qo‘shiladi.

Delete Anchor Point (Удалить точку) -  nuqtani o‘chirish — 
sichqoncha yordamida shakldagi burilish nuqtasi o‘chiriladi.

Convert Point (Преобразовать точку) — nuqtani o‘zgar- 
tirish — shakl nuqtalarining joylashishini o‘zgartirish (cho‘zish).

3. [Щ| Notes (Заметки) [N] -  izoh (eslatma) qo‘shish — rasm- 
ning ixtiyoriy sohasiga matnli izoh qo‘shish.

Ш  Audio Annotation (Звуковое описание) [N] — ovozli 
izohlar — rasmning ixtiyoriy sohasiga mikrofon orqali ovozli izoh 
qo‘shish. Paydo bo‘lgan oynada .Ste/ftugmasini bosib ovoz yozishni
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boshlaymiz, yozishni to‘xtatish uchun Stop tugmasini bosamiz. 
Ovoz yozish oynasidan chiqib ketish uchun Cancel tugmasini 
bosamiz.

L=yJl Nazorat savollari

1. Qalam, mo‘yqalam va shtamp asboblarining bajaradigan vazifalarini 
aytib bering.

2. Dasturda o‘chirg‘ichning qanday xillari mavjud?
3. Gradiyent bo‘yash va ajratilgan sohani biror rang bilan bo‘yash 

asboblarining farqini tushuntiring.
4. Tasvirga matn qaysi asbob yordamida qo‘shiladi?
5. Shakl yaratish asboblarining xillarini sanab o‘ting va ularga izoh 

bering.
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VI BOB. RANG BILAN ISHLASH

6.1. Yetti xil asosiy nurlarning kelib chiqishi

Rastrli kompyuter grafikasida ranglar modeliga katta e’tibor 
qaratish kerak. Grafikada, asosan, 2 xil rang modeli ishlatiladi: 
RGB (red, green, blue) va CMYK (Cyan, Magenta, Yellow, blacK).
RGB rang modeli, asosan, monitorlarda tasvirni ko‘rsatish uchun, 
CMYK rang modeli esa bosmada ishlatiladi.

Rang — bu bizning yorug‘lik nurini sezishimizning omillari- 
dan biridir. Olimlar azaldan nur va rang bilan qiziqib kelganlar. 
Bu sohadagi birinchi olamshumul yutuqlardan biri Isaak Nyuton- 
ning oq yorugMik nurini tashkil etuvchilarga ajratish bo‘yicha 1666- 
yilda o‘tkazgan tajribalaridir. Bungacha oq nur eng sodda nur 
degan tasavvur mavjud edi. Nyuton buni inkor etdi.

Nyuton tajribalarining mohiyati quyidagicha: oq yorugMik nuri 
(quyosh nuridan foydalanildi) uchburchakli shisha prizmaga yo‘- 
naltiriladi. Prizmadan o‘tgan nur sinib, ekranga yo‘naltirilganda 
ranglar sohasi — spektrni hosil qiladi. Spektrda asta-sekinlik bilan 
biridan ikkinchisiga o‘tuvchi kamalakning barcha ranglari mavjud 
edi. Bu ranglar boshqa qismlarga ajralmaydi. Nyuton spektrni 
yaqqol ko‘rinadigan turli ranglarga mos keluvchi yetti qismga aj- 
ratdi. U ushbu yetti rangni, ya’ni qizil, zarg‘aldoq, sariq, yashil, 
havorang, ko‘k va binafsha ranglarni asosiy ranglar deb hisoblardi. 
Ba’zilar buni Nyutonning yetti sonining sirli xususiyatiga ishon- 
ganligi bilan tushuntiradilar.

Tajribalarning ikkinchi qismi quyidagicha o‘tkazildi: bir priz­
madan o‘tgan nurlar ikkinchi prizmaga yo‘naltirildi va u orqali 
yana oq nur olishga erishildi. Shunday qilib, oq rang ko‘plab 
boshqa ranglarning qorishmasidan iborat ekanligi isbotlandi. Yetti 
asosiy rangni Nyuton halqa bo‘ylab joylashtirdi (71-rasm).

Nyuton biror rang ma’lum nisbatda olingan asosiy ranglarni 
aralashtirish natijasida hosil bo‘ladi, deb faraz qildi.

Spektri birgina to‘lqin uzunligiga mos kelgan bitta chiziqdan 
iborat boMgan nurlanish monoxromatik nurlanish deyiladi. Nyuton 
tomonidan olingan kamalak (shuningdek, yomg‘irdan keyin kuza- 
tiladigan kamalak ham) cheksiz ko‘p monoxromatik nurlanish- 
lardan tashkil topgandir. Lazer monoxromatik nurlanishning ancha 
sifatli manbayi hisoblanadi.
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H avorang

71-rasm. Yetti asosiy rang halqasi.

Monoxromatik nurlanishning rangi to‘lqin uzunligi bilan aniq- 
lanadi. Ko‘zga ko‘rinadigan nurlar uchun to‘lqin uzunliklari dia- 
pazoni 380—400 nm (binafsha)dan to 700—780 nm (qizil)gacha 
oraliqda bo‘ladi. Bu diapazonda inson ko‘zining sezuvchanligi bir 
xil emas. Eng yuqori sezuvchanlik yashil rangga to‘g‘ri keluvchi 
to‘lqin uzunliklarida kuzatiladi.

Rangni tavsiflash uchun quyidagi belgilardan foydalaniladi:
— rang tusi (toni), uni nurlanish spektrida ustunlik qiluvchi 

to‘lqin uzunligi bilan aniqlash mumkin. Rangning tusi bir rangni 
boshqasidan ajratish imkonini beradi, masalan, yashilni qizildan, 
sariqdan yoki boshqa ranglardan;

— yorqinlik, yorug‘lik nurining energiyasi, intensivligi bilan 
aniqlanadi. Qabul qilinayotgan yorug‘lik nurining miqdorini 
ifodalaydi;

— to‘yinganlik yoki tusning tiniqligi, oq rangning mavjudligining 
ulushi bilan ifoda etiladi. Ideal sof rangda oq rang aralashmasi 
bo‘lmaydi. Masalan, sof qizil rangga ma’lum nisbatda oq rang 
qo‘shilsa, och qizil rang hosil bo‘ladi.

Aytib o‘tilgan ushbu uch belgi barcha ranglar va ulaming yor- 
qinliklari (ottenkalari)ni ifodalashga imkon beradi. Belgilarning 
uchta ekanligi rangning uch o‘lchamlilik xususiyatiga egaligidan 
darak beradi.
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6 .2 . R G B  rang modeli

RGB rang modelidan nurlanish prinsipi asosida ishlovchi quril- 
malar yordamida olinadigan ranglarni ifodalash uchun foydalaniladi. 
Asosiy ranglar sifatida qizil (Red), yashil (Green) va ko‘k (Blue) 
olingan.

RGB modelining qisqacha tarixi shunday: Tomas Yung ( 1773— 
1829) uch dona fonar oladi va ularga qizil, yashil hamda kolk 
yoruglik filtrlarini olrnatadi. Shu tarzda ushbu ranglarga mos 
keluvchi nur manbalari olindi. Olim oq ekranga bu uch manbadan 
chiqqan nurlarni yo‘naltirib, mana shunday tasvirni oldi (72-rasm). 
Ekranda manbalardan chiqqan nurlar rangli doiralar shaklini hosil 
qildi. Doiralarning kesishish joylarida ranglarning qo‘shilishi kuza- 
tildi. Sariq rang qizil va yashil ranglarning qokshilishidan, qizg‘ish 
rang qizil va kokk ranglarning qo'shilishidan, havorang kokk va 
yashil ranglarning qobshilishidan, oq rang esa uchta asosiy rangning 
qokshilishidan hosil bo'ladi.

Boshqa ranglar va uning nozik turlari yuqorida aytilgan asosiy 
ranglarni bir-biriga ma’lum miqdorda qo‘shilishi bilan olinadi.

Qizil

Oq Havorang

72-rasm. RGB modelining asosiy ranglari va ulaming qo'shilishidan 
hosil bollgan qo'shimcha ranglar.
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Hozirgi paytda RGB modeli rasmiy standart bo‘lib hisoblanadi. 
Yoritish bo‘yicha Xalqaro komissiyaning — YXK (C IE  — 
Comission International de Eclairage) qaroriga ko‘ra, 1931 -yiIda 
asosiy ranglar standartlashtirilib, ulardan R, G va В sifatida foy- 
dalanish tavsiya etildi. Bular yorug‘lik nurlanishining quyidagi 
to‘lqin uzunliklariga mos keluvchi R — 700 nm; G — 546,1 nm, 
B — 435,8 nm monoxromatik ranglardir: qizil rang filtr o‘matilgan 
cho‘g‘lanma lampa yordamida olinadi. Sof yashil va ko‘k rang- 
larni olish uchun simobli lampa qoMlaniladi. Shuningdek, har bir 
asosiy rang uchun yorug‘lik oqimining qiymati ham standartlash- 
tirilgan.

RGB tizimi uchun yana bir muhim parametr — bir xil miqdorda 
olingan uch xil rangning aralashuvidan hosil bo‘ladigan oq rangdir.

RGB tizimi hozirgi vaqtda, birinchi navbatda, rangli televizorlar 
va kompyuterlaming displeylarida keng qo‘llanilmoqda. Ranglaming 
ba’zi yorqinliklarining yetishmasligi uncha ham sezilmaydi.

RGB tizimining ommabopligini ta’minlovchi yana bir omil 
uning yaqqol ko‘rinishidir: asosiy ranglar ko‘rish spektrining yaqqol 
farqlanadigan qismlarida joylashgandir.

Bundan tashqari, insonning rangli ko‘rishini tushuntiruvchi 
gipotezalardan biri — uch tashkil etuvchili nazariya odamning ko‘- 
rish tizimida uch turdagi yorug‘likni sezuvchi elementlar borili- 
gini ta’kidlaydi. Bir tur elementlar yashil rangni, boshqa turi qizil 
rangni, uchinchi turi esa ko‘k rangni sezadi. Bunday gipotezani 
Lomonosov aytib o‘tgan, uni asoslash bilan T. Yungdan boshlab 
ko‘plab olimlar mashg‘ul bo‘ldilar. Uch tashkil etuvchili nazariya 
odamning rangli ko‘rishining yagona nazariyasi emas.

RGB-palitra — tabiatdagi barcha ranglar uch asosiy rang: Red — 
qizil, Green — yashil, Blue — ko‘k ranglaming aralashmasidan 
yuzaga keladi. Bu ranglaming qo‘shilish miqdorlariga qarab turli 
rang yorqinliklari kelib chiqadi. RGB-palitradagi ranglar juda yorqin 
va ko‘zga tashlanuvchan boigani sababli, ulardan Internet sahi- 
falarini bezashda foydalanish qulaydir.

6.3. CMYK rang modeli

CMY rang modeli ranglaming yutilish (ayirish) prinsipi amalga 
oshiriladigan qurilmalarda tasvirni hosil qilishda rangni ifodalash 
uchun qo‘llaniladi. Bu prinsip, birinchi navbatda, qog‘ozga bosuv-
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Qirmizi

73-rasm. CMY modelining asosiy ranglari va ularning qo'shilishidan 
hosil bo'lgan qo‘shimcha ranglar.

chi qurilmalarda qollaniladi. Ushbu modelning atalishi asosiy 
subtraktiv ranglar -  havorang (Cyan), qirmizi (M agenta) va sariq 
(Yellow) ranglarning nomlanishidan tuzilgan (73-rasm).

Oq qog‘ozga sariq bo‘yoqning surtilishi qaytgan ko‘k rang 
yutilishini bildiradi. Havorang bo‘yoq qizil rangni, qirmizi bo‘yoq 
yashil rangni yutadi. Bo‘yoqlar kombinatsiyasi qolgan yashil, qizil, 
ko‘k va qora ranglarning olinishini ta’minlaydi. Qora rang barcha 
ranglarning qaytishdagi yutilishini bildiradi.

Amaliyotda ranglarning idealmasligi sababli ularning aralash- 
masidan qora rangni olish qiyin, shuning uchun bosma qurilma- 
larida yana qora rang (blacK) ham ishlatiladi. Unda bu model 
CMYK modeli deb ataladi.

Shuni ta’kidlash lozimki, har qanday bo‘yoq ham yuqorida 
kolrsatilgan CMY ranglarining yutilishini ta’minlayvermaydi.

1-jadvalda RGB va CMY modellaridagi ba’zi ranglar haqida 
ma’lumot keltirilgan.

Bu yerda tashkil etuvchilar 0 dan 1 gacha boMgan diapazondagi 
sonlar bilan kodlanadi, deb hisoblanadi. Sonlaming boshqa diapa- 
zoni uchun ularga mos keluvchi nisbatlami yozish mumkin.

Hozirgi kundagi rangli printerlar CMYK-palitradagi ranglar 
(C — cyan, M — magenta, Y — yellow, K — blacK, Blue -  ko‘k
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l-jadval

Rang RGB modeli CM Y modeli

R G в С м Y

Qizil 1 0 0 0 1 1

Sariq 1 1 0 0 0 1

Yashil 0 1 0 1 0 1

Havorang 0 1 1 1 0 0

Ko‘k 0 0 1 1 1 0

Qirmizi 1 0 1 0 1 0

Qora 0 0 0 1 1 1

Oq 1 1 1 0 0 0

bilan adashtirmaslik uchun oxirgi harfi olingan) bilan ishlaydi. 
Printerlarda qog‘ozga rang tushirish quyidagi tartibda amalga oshi- 
riladi:

Qog‘oz I 1

RX„bf h © © © ©
CMYK tizimidagi ranglar nisbatan xira, ammo tabiiyga yaqin 

bo‘lganligi uchun undan ko‘pincha tayyor rasmlar bilan ishlashda 
foydalaniladi. Agar tasvir RGB modelida ishlangan bo‘lsa, chop 
etishdan oldin printer uni avtomatik tarzda CMYK ranglarga ajra- 
tadi, natijada chiqqan tasvir ekrandagidan farq qilishi mumkin.

6.4. Ranglaming boshqa modellari

RGB modelida mavjud bo‘lgan manfiy koeffitsiyentlar muam- 
mosini hal etish uchun Yoritish bo‘yicha Xalqaro komissiya (CIE) 
tomonidan XYZ kolorimetriya tizimi qabul qilindi. YXK XYZ 
tizimida ham asosiy ranglar sifatida uch rang qabul qilindi, ammo 
bular shartli, real bo‘lmagan ranglardir.
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Qora

Yuqorida ko‘rib chiqilgan rang modellari u yoki bu tarzda ba’zi 
asosiy ranglarning qo‘shilishidan foydalanadi. Endi esa ulardan 
o‘zgacha, alternativ rang modelini ko‘rib chiqamiz.

H SV  modelida rang tus (ton) H (Hue), to‘yinganlik S  (Satu ­
ration), yorqinlik V (Value) kabi parametrlar bilan ifodalanadi. 
H ning qiymati 0 dan 360 gacha bo‘lgan graduslarda o‘lchanadi, 
chunki bu yerda kamalak ranglari aylana bo‘yicha quyidagi tartibda 
joylashtiriladi: qizil, zarg‘aldoq, sariq, yashil, havorang, ko‘k, 
binafsha. S  va V ning qiymati 0—1 oraliqda joylashadi.

H SV  model uchun ranglarning kodlanishiga misol keltiramiz. 
S = 0  qiymat (ya’ni V o‘qida) kulrang tuslarga, V=0 qiymat esa 
qora rangga to‘g‘ri keladi. Aylana bo‘yicha bir-birining qarshisida 
joylashgan, ya’ni bir-biridan H bo'yicha 180° ga farq qiluvchi 
ranglar qo‘shimcha ranglardir. Rangni H SV  parametrlari orqali 
tasvirlashga topshiriqlar grafik tizimlarda tez-tez uchrab turadi. 
Bu model odatda ochilgan konus shaklida ko‘rsatiladi (74-rasm).

H SV  ga o‘xshash qurilgan boshqa rang modellari ham mavjud, 
masalan, H L S (Hue, Lighting, Saturation) modeli ham rang konu- 
sidan foydalanadi.

Modellaming turli-tumanligi ulardan turli sohalarda foydalanish 
bilan bogliq. Rang modellaridan har bin tasvimi kiritish, uni ek- 
randa ko‘rinadigan holatga keltirish (vizualizatsiya), qog‘ozga chop 
etish, tasvir ustida ishlash, fayllarda saqlash, kolorimetrik hisob-

74-rasm. H S V  m ode lin in g  tasvirlanishi.
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kitoblar va oichovlar kabi ayrim operatsiyalarni samaraliroq baja- 
rish uchun ishlab chiqilgan. Bir modelning boshqasiga almashti- 
rilishi tasvirdagi ranglarning buzilishiga olib kelishi mumkin.

Rastr tasvirlar quyidagi tiplarga bo‘linadi: binar, kulrang, palit- 
rali, to‘liq kulrang. Bunda tasvirning elementlari faqat ikki qiymatni 
(0 yoki 1) qabul qilishi mumkin. Bu tasvirlar turlicha paydo bo‘lishi 
mumkin. Ular ko‘p hollarda kulrang, palitrali va turli rangli tas- 
virlarni o‘zgarmas yoki adektiv chegaraviy son bilan binar tasvirga 
almashtirish natijasida paydo boiadi. Binar tasvirlarni saqlash 
uchun juda katta joy talab qilinadi. Ularning har bir elementi 
uchun 1 bit joy kerak bo‘ladi. Kulrang tasvirning elementlari ma’- 
lum bir rang intensivligining turli xil qiymatlarini qabul qiladi. 
Odatda, bu tasvirlarning har bir elementini saqlash uchun 8 bit 
ishlatiladi. Kulrang tasvirlar turli xil amaliy masalalarini hal qilishda 
eng ko‘p qo‘llaniladigan tasvirlardan biri hisoblanadi.

Palitrali tasvirlarning har bir elementiga ranglar palitrasining 
bir yacheykasidagi rang mos qo‘yiladi. Palitra — bu ikki oMchovli 
massiv bo‘lib, uning satrlariga turli ranglar, har bir ustunlariga 
esa ma’lum bir rangning intensivligi joylashtiriladi.

To‘liq rangli tasvirlar elementlari rangni tashkil etuvchi yor- 
qinliklar haqidagi axborotni o‘zida saqlaydi. Shu bilan u palitrali 
tasvirlardan farq qiladi.

Amaliy masalalar yechishda qaysi turdagi tasvirni tanlash masa- 
laning o‘ziga xos xususiyatlaridan kelib chiqib, tasvirdagi zarur 
axborotni qanchalik toMiq ifodalanishi bilan xarakterlanadi. Bundan 
tashqari, to'liq rangli tasvirlardan foydalanish katta hajmdagi hisob- 
lash resurslarini talab qilishini e’tiborga olish kerak.

Rastrli grafika bilan ishlash dasturlari bir nechta vazifalarni 
bajarish imkonini beradi:

— tasvirni import qilish — tasvirni skaner, raqamli fotoappa- 
ratdan kiritish, boshqa formatdagi rasmlarni kiritish (bmp, jpg, 
png, tif, gif, psd, pdf, wmf va boshq.);

— tasvirni tahrirlash — tasviiga o‘zgartirishlar kiritish, ranglar bilan 
bo‘yash, chizish, o‘chirish, yorqinlik va aniqlik darajasini o‘zgartirish;

— rang tizimini o‘zgartirish;
— chop etish;
— boshqa nom va format bilan saqlash;
— turli efTektlarni qoMlash.
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6 .5 . P alitra lar bilan ishlash

Photoshop dasturidagi kolp amallar siljitiladigan palitralar yor- 
damida bajariladi. Ekranda palitralar ko‘p joy egallamasligi uchun, 
palitralar quyidagi guruhlarga biriktirilgan: Navigator/Info (Нави­
гация/Информация) -  Navigatsiya/Ma’lumot, Color/Swatches/ 
Styles (Цвет/Образцы/Стили) -  Rang/Ko‘rsatmalar/Stillar, 
History/Actions/Tool Presets (История/Действия/Набор 
инструментов) -  Tarix/Amallar/Asboblar majmuasi, Layers/ 
Channels/Paths (Слои/Каналы/Контуры) — Qatlamlar/Kanallar/ 
Konturlar va Character/Paragraph (Шрифт/Абзац) -  Shrift/Abzas.

Xohlagan palitrani ochish uchun asosiy menyuning Window 
(Окно) bo‘limi buyruqlaridan foydalanamiz. Ko‘rsatilgan palitra 
shu guruhga kiradigan boshqa palitralar ustiga joylashtiriladi.

Ba’zi palitralarni biror asbobni tanlaganda Parametrlar pane- 
lida paydo boMadigan shu asbobga tegishli bo‘lgan palitrani ochish 
tugmasi yordamida, masalan, Type (Текст) asbobidan Character/ 
Paragraph palitrasini ochish mumkin. Tab tugmasini bosish orqali 
barcha ochiq palitralarni, asboblar panelini ko‘rinadigan/ko‘rin- 
maydigan hollarga keltirish mumkin. Shift+Tab tugmalari bosilsa, 
asboblar panelidan tashqari ochiq turgan palitralarni ko‘rinadigan/ 
ko‘rinmas hollarga keltirish mumkin.

Agarda biror palitralar guruhidagi qandaydir palitrani faollash- 
tirish kerak boMsa, o‘sha palitra nomiga sichqoncha yordamida 
bosish kifoya qiladi. Palitrani guruhdan ajratib olish imkoniyati 
ham bor, buning uchun palitra nomidan ushlab uni tashqariga 
olib chiqish kerak (75-rasm). Agarda guruhga palitra qo‘shmoqchi 
bo‘lsangiz, palitra nomidan ushlab turib uni shu guruhga tashlash 
kerak bo‘ladi (76-rasm), shu yo‘l bilan birga guruhga boshqa 
guruhni ham qo‘shsa boMadi. Sichqoncha yordamida palitra o‘l- 
chamlarini o‘zgartirish (kattalashtirish yoki kichiklashtirish) mum­
kin, buning uchun uning o‘ng pastki burchagidan tortish (tashqariga 
yoki ichkariga) kerak boMadi.

Palitrani yig‘moqchi/yoymoqchi (свернуть/развернуть) bo‘l- 
sangiz, palitra nomiga ikki marta sichqoncha bilan bosing yoki oyna- 
ni o‘ng yuqori qismidagi mos yigkish/yoyish tugmachalarini bosing.

Palitra oMchami dasturda oldindan o‘matilgan (по умолчанию) 
holdagisidan boshqacha boMsa, Minimize tugmasiga sichqoncha 
bilan bosib, palitra o‘lchamini dasturda oldindan o‘rnatilgan 
holdagiga qaytarish mumkin.
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75-rasm. Palitralar guruhidan palitrani ajratish.

76-rasm. Palitralar guruhga palitrani qo'shish.

Agarda Edit > Preferences > General (Правка > Установки > 
Общие) muloqot oynasidagi Save Palette Locations (Сохранить
расположение палитр) maydoniga bayroqcha qo‘yilgan bo‘lsa, 
Photoshop dasturidan chiqib ketishdan oldin palitralar qanday joylash- 
gan bo‘lsa, dasturga qaytadan kirganda shu holda ekranga chiqariladi.

Palitralar guruhlarini dasturda oldindan o‘rnatilgan holdagi 
joylashuvini qayta tiklash uchun Window > Workspace > Reset 
Palette Locations (Окно > Рабочее поле > Восстанавить распо­
ложение палитр) buyrug‘idan foydalanish lozim.

Swatches palitrasi

Swatches (Образцы) palitrasida (77-rasm) tayyor ranglarning 
namunalari keltiriladi. Swatches palitrasini ranglar palitrasiga 
qo‘shgan yoki alohida holda ishlatish mumkin. Palitraning menyusi 
buyruqlari orqali ranglar namunalarini yuklash yoki xotiraga saqlab 
qo‘yish mumkin.
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77-rasm. Swatches palitrasi va menyusi.

Kiritish/chiqarish qurilmalari, kompyuter dasturlari ranglami 
turli ko‘rinishda qayta ishlaydi, shuning uchun ranglar bilan 
ishlashda ko‘plab muammolar yuzaga kelishi mumkin. Masalan, 
biror grafik obektni turli dasturlarda, masalan, tasvirlami qayta 
ishlash dasturlarida yoki Web-brauzerlarda ko‘rganimizda undagi

qilingan tasvir uning asl tasviridagi ranglari bilan mos kelmaydi. 
Tasvimi bosmaga chiqarishdagi natija esa awalgi variantlaming 
birortasiga ham mos kelmasligi mumkin. Ba’zi paytda bu farq 
hech qanday ahamiyatga ega bo‘lmaydi. Ikkinchi tomondan, rang- 
laming o‘zgarishi tasvirdagi biror buyumning «sirli» holda yo‘q 
bo‘lishiga olib kelishi mumkin.

Ushbu muammolarni yechishda ranglami boshqarish katta 
ahamiyatga ega bo‘ladi. Yaxshi tizim kirish/chiqish qurilmalari, 
turli dasturlardagi ranglaming o‘zgarishini oldini oladi. Rangli profil 
qurilmaning rangni tanishida matematik berilishiga e’tibor beradi. 
Illustrator 10 va Photoshop dasturlari ICC (International Color 
Consortium —Международный консорциум цвета) profilini 
ishlatadi, demak, tizimingizda ranglami boshqarish, qurikna qanday 
qilib rangni qayta ishlashi haqida ma’lumotlar bo‘ladi.

77



Photoshop dasturida ranglarni boshqarish Edit (П равка) 
menyusi orqali chaqiriladigan Color Settings (Характеристики 
цвета) oynasidan boshqariladi. Bu oynada turli holatlar: nashriyot- 
dagi muharrirlik ishlari uchun, kompyuter tarmog‘i orqali tasvir- 
larni uzatish va bosmaga chiqariladigan tasvirlarni qayta ishlashga 
moljallangan qurilmalar uchun ro‘yxat berilgan.

Adobe kompaniyasining biror dasturida (masalan, Illustrator 10) 
rang parametrlari o‘zgartirilgan bolsa, u holda Photoshop dasturini 
yuklash paytida bu haqda ma’lumot beruvchi oyna paydo boladi 
(78-rasm). Bu oynani yo‘qotish uchun Synchronize (Синхрони­
зовать) tugmasiga sichqonchani bosish kerak, shundan sokng 
Photoshop dasturi boshqa dasturning ranglar parametrlari bilan 
moslashtiriladi.

Bu tizim dasturda grafik fayllarni ochganda ranglar bilan qanday 
ishlash haqida ma’lumot beradi, rang profillari bor-yolqligini tek- 
shiradi.

Adobe Gamma

O The selected file is not an RGB Monitca Profile.

г~~ж l

78-rasm. Rang profili o‘zgragani haqida ogohlantiruvchi oyna.

Adobe Gam m a

This control panel wl alow you to cafbrate 
you monitor and create an ICC profle for ¡L

Which version would you Hie to use? 
<• ¡Step By Step [Wizard]
С  Control Panel

i * \  This ICC profle wfl be compatible 
\ Л /  ColorSync® on Macrtosh® and I 
^  Z0 on Wndows.

with 
and ICM

< Цазаа | Далее > | Отмена J

79-rasm. Adobe Gamma utilitasi oynasin ing k o lrinishi.
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Agarda biror tasvirni ikki xil maqsadda ishlatmoqchi boMsangiz, 
masalan, tarmoq va bosmaga chiqarish uchun, u holda bunda 
sizga Adobe Gamma ranglarni boshqarish utilitasi yordam beradi 
(79-rasm).

6.6. Gradiyent va rang bilan bo‘yash (zalivkalar) 

Gradiyent asbobi

Photoshop dasturidagi Gradient (Градиент) -  gradiyent asbo- 
bini sozlashni ko‘rib chiqamiz.m adient Tool (Градиент) [G] — gradiyent rang berish 
yoki bitta rangdan boshqasiga o‘tish rangi bilan tanlangan sohani 
toMdirish.

Parametrlar panelida quyidagi parametrlarni kiritish mumkin:
Gradient Editor (Редактирование градиента) — mavjud 

gradiyent turlarini tanlash va yangi gradiyent rang hosil qilish 
paneli;

Linear Gradient (Линейный градиент) — ajratilgan sohani 
chiziqli gradiyent bilan bo‘yash;

Radial gradiyent (Радиальный градиент) — ajratilgan sohani 
radial gradiyent bilan bo‘yash;

Angle gradiyent (Конусовидный градиент) — ajratilgan sohani 
konussimon gradiyent bilan bo‘yash;

Reflected gradiyent (Зеркальный градиент) — ajratilgan sohani 
oynadagi kabi akslantirish gradiyenti bilan bo‘yash;

Diamond gradiyent (Ромбовидный градиент) — ajratilgan 
sohani rombsimon gradiyent bilan bo‘yash;

Reverse — gradiyentdagi ranglarni teskari akslantirish;
Dither — gradiyentdagi ranglarning bir-biriga kamroq sondagi 

o‘tishlari evaziga tekisroq gradiyent olish;
Opacity (Непрозрачность) -  gradiyentning shaffofsizligi 

miqdorini o‘rnatish.
Bu asbob tanlanganda Parametrlar panelida chiqadigan gra- 

diyentlar tanlash panelining o‘ng tarafida joylashgan strelkani bo- 
sib, gradiyent namunalari aks etgan to‘plamni ochamiz (80-rasm).

Yangi gradiyent yaratish uchun 80-rasmda strelka bilan ko‘r- 
satilgan tugma bosilsa, gradiyentlarni boshqarish menyusi ochiladi 
va u yerdan gradiyentlar ustida yangi gradiyent yaratish, unga nom 
berish yoki o‘chirish kabi turli operatsiyalami bajarish mumkin.
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80-rasm. G rad iy ent lar  to 'p lam i.

Misol ko‘rib chiqamiz.
1. Biror rasm ochamiz. Keyin qatlam palitrasida yangi qatlam 

yaratamiz. Gradiyent asbobini tanlab, Parametrlar panelidan ke- 
rakli gradiyentni tanlaymiz. Shu qatlamga gradiyent bo‘yashni qo‘l- 
laymiz (81-rasm).

Onn ■
0 6 w h h w *

m
CnoAO

■r

81-rasm. Yangi qatlam yaratish.

2. Qatlamlar palitrasida ushbu qatlamga 30% lik shaffiofsizlik 
parametrini qo‘llasak, quyidagi tasvimi olamiz (82-rasm).

Original rasm. 30% lik shafTofsizlik parametrini 
qo‘llagandan keyingi rasm.

82-rasm. Gradiyentlar to'plami. 
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Photoshopda yangi gradiyent yaratish

Yangi gradiyent yaratish uchun quyidagilarni bajaramiz: 
Gradiyent asbobini tanlaymiz. Parametrlar panelida chiqadigan 

gradiyentlar tanlash maydonining ustiga bosib (83-rasm, to‘rt- 
buchak bilan o‘ralgan soha), Gradient Editor — gradiyentlarni 
tahrirlash oynasini ochamiz (84-rasm).

a  - D d b b d

83-rasm. Gradiyentni sozlash paneli.

¡-tenpoJt.: i P-]0''” rtosuHfi: j [ yûa/iKTb
Ueît [__][►] rn?.hum i l°/> yaaniiTb

84 -rasm. Gradient Editor muloqot oynasi.

Oynadagi gradiyentning ranglarini sozlash polosasi pastidagi 
siljitgichlar (rasmda bittasi o‘rab qo‘yilgan) gradiyentning rang­
larini, yuqoridagilari esa gradiyentning shaffofligini o‘matishga mo‘l- 
jallangan.

Ortiqcha siljitgichni uning ustiga bosib, chetga chiqarib tashlash 
bilan olib tashlash mumkin. Yangi siljitgich qo‘shish uchun esa 
ranglarni sozlash polosasining istalgan bo‘sh joyiga sichqoncha 
bilan bosish kerak. Gradiyentning bosh nuqtasini belgilab, unga 
rang bersak, ranglarini sozlash maydonida kerakli rangni olishimiz 
mumkin.

Gradiyentning ranglarini sozlash polosasida istalgan ikkita rang 
o‘rnatuvchi siljitgich orasida rang o‘rta nuqtasi mavjud boMadi. 
Uni chap-o‘ngga siljitib, gradiyentning ushbu oraliqdagi rang che- 
garalarini boshqarish mumkin (85-rasm).
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Shajfoflikni о ‘matuvchi Ikki rang siljitgichi
siljitgichlar orasidagi nuqtalar

Rangni о ‘matuvchi 
siljitgichlar

85-rasm. Gradiyentning ranglarini sozlash polosasi.

86-rasm. Gradiyentning shaffofsizligini o‘matish.

Rangning shaffofsizligini o‘zgartirish uchun sichqonchani gra­
diyentning shafFofligini о ‘matuvchi siljitgichga bosib, Непрозрачность 
(shaffofsizlik) maydonida kerakli qiymatni (misol uchun 50%) 
qo‘yish kerak. Shunda gradiyent ranglarini sozlash polosasida shax- 
mat doskasi shakliga o‘xshash tasvir paydo bo‘ladi, bu gradiyent­
ning ushbu qismda shaffofsizligini bUdiradi (86-rasm).

Yangi yaratilgan gradiyentni saqlash uchun Imya (nom) may­
donida unga nom beramiz va Новый (yangi) tugmachasini bosamiz.

Gradiyentlar ko‘rinishi

Photoshop dasturida gradiyentlar ko‘rinishining quyidagi turlari 
mavjud (87-rasm): 1) linear Gradient (Линейный градиент) —
ajratilgan sohani chiziqli gradiyent bilan bo‘yash; 2) Radial gradiyent
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87-rasm. Gradiyent ko‘rinishlari.

88-rasm. Gradiyent asbobi parametrlari.

(Радиальный градиент) — ajratilgan sohani radial gradiyent bilan 
bo‘yash; 3) Angle gradiyent (Конусовидный градиент) -  ajratilgan 
sohani konussimon gradiyent bilan bo‘yash; 4) Reflected gradiyent 
(Зеркальный градиент) — ajratilgan sohani oynadagi kabi aks- 
lantirish gradiyenti bilan bo‘yash; 5) Diamond gradiyent (Ромбо­
видный градиент) — ajratilgan sohani rombsimon gradiyent bilan 
bo‘yash.

Parametrlar panelida yana quyidagi parametrlami kiritish mumkin 
(88-rasm):

Mode — gradiyentning tasvir ustiga qo‘yilish turini tanlash;
Opacity (Непрозрачность) — gradiyentning shaffofsizligi 

miqdorini o‘matish;
Reverse (Инверсия) — gradiyentdagi ranglami teskari akslan- 

tirish;
Dither (Дизеринг) — gradiyentdagi ranglarning bir-biriga 

kamroq sondagi o‘tishlari evaziga tekisroq gradiyent olish;
Transparency (Прозрачность) — gradiyentda shaífoflikni qo4- 

lashga ruxsat berish.

Photoshopda rang bilan bo‘yash asbobi

Pbotoshopda rang bilan bo‘yash uchun quyidagi asbobdan 
foydalaniladi:

Ш  Paint Bucket Tool (Заливка) [G] — ajratilgan sohani 
bitta rang yoki naqsh bilan bo‘yash.

Parametrlar panelida quyidagi parametrlami kiritish mumkin 
(89-rasm):

Fill (Заливка) — rang bilan bo‘yash turini tanlash: Foreground 
(Основной цвет) — rang yoki Pattern (Узор) — naqsh bilan bo‘yash;

Mode (Режим) — rangning tasvir ustiga qo‘yilish turini tanlash;
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89-rasm. Rang quyish asbobi parametrlar paneli.

Opacity (Непрозрачность) — rang bilan bo‘yalgan sohaning 
ko‘rinish darajasini o‘zgartirish;

Tolerance (Допуск) — sezuvchanlik — rang bilan bo‘yashda 
chegaralar sezuvchanligini o‘zgartirish;

Anti-Aliased (Сглаживание) — chegaralarning yoyilishi — rang 
bilan bo‘yaladigan soha chegaralarining mayinroq chiqishi;

Contiguous (Смежные пикселы) — faqat ajratilgan sohani rang 
bilan bo‘yash;

All Layers (Все слои) — ajratilgan soha chegarasida barcha 
qatlamlarni bo‘yashni amalga oshirish.

Bu asbobning qo41anilishi juda oson: ranglar palitrasidan kerakli 
rangni tanlab olamiz va shu rang bilan qatlamni bo‘yaymiz, ya’ni 
qatlam ustiga kursorni olib kelib, sichqonchani bosamiz. Shuning- 
dek, qatlamni naqsh bilan ham bo‘yash mumkin (90-rasm).

Bo‘yash uchun joriy naqshdan boshqa naqshni tanlash uchun 
naqshlar palitrasini unga mos tugmachani bosib chiqarish kerak 
(91-rasm). Naqshlar ustida naqsh yaratish, yuklash, saqlash kabi 
amallarni bajarish uchun naqshlar palitrasining chetidagi strelkani 
(91-rasmda strelka bilan ko‘rsatilgan) bosib chiqariladigan menyu 
buyruqlaridan foydalanish kerak.

90-rasm. Rang bilan bo'yash turini tanlash.

91-rasm. N aq sh lar  palitrasi.
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Shuningdek, Photoshopda bokyashni asosiy menyuning 
Правка > Выполнить заливку buyrugini bajarish bilan ham 
amalga oshirsa boladi. Bunda bo'yash (Заливка) muloqot oynasi 
(92-rasm) ochilib, u yerda bizga bokyash uchun rangni tanlash 
taklif qilinadi: asosiy yoki fon rangi, rang (ranglar palitrasi ochiladi), 
naqsh, qora, 50% kulrang yoki oq. Shuningdek, bu yerda rejim 
va shaffofsizlik darajalarini ham o‘rnatsak bo4adi.

г- Содержиное

Использовать: Цвет... Æ
Заказной узор: п \

Отмена

г- Наложение

Режим: Нормальный

Непрозрачность: 1100 | %

i Сохранить прозрачность

|— Содержиное 

Использовать:

-  Наложение —  

Режим: 

Непрозрачность:

Сохранить про

Цвет... &
Основной цвет
Фоновый цвет
Цвег...

1 1

Узор
История

Черный
Серый 50%
Белый

OK

Отмена

92-rasm. B o 'yash  m u lo q o t oynasi.

±Л Nazorat savollari

1. Nyutonning yorugMik nurini ranglarga boMish tajribasi mohiyatini 
aytib bering.

2. RGB, CMYK, HSV rang modellari haqida ma’lumotlar bering.
3. Gradiyent va rang bilan bokyash (zalivkalar) asboblarining vazifa- 

larini aytib bering.
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VII BOB. QATLAMLAR BILAN ISHLASH

7.1. Asosiy tushunchalar

Layer (Слой) — qatlamlarning bir nechtasini ustma-ust joy- 
lashishi natijasida tasvir hosil boMadi. Ba’zi dasturlarda bir qatlamda 
faqat bitta, ba’zi dasturlarda esa bir nechta obyekt joylashishi mum- 
kin. Adobe Photoshop dasturida Layers (Слои) palitrasi, asosan, 
faylda mavjud qatlamlami ko‘rsatish uchun xizmat qiladi. Dasturda 
qatlamlami yashirish va ko‘rsatish quyidagicha amalga oshiriladi: 
palitraning chap tomonidagi vertikal qatorda qatlamlarning nomi 
to‘g‘risida «ko‘z» piktogrammasi bor boMsa, demak, qatlamlar ko‘- 
rinadigan holatda turgan boiadi. Ushbu piktogrammalami sich- 
qoncha yordamida o‘chirib-yoqish orqali qatlamlarning ko‘rinishini 
bilib olish mumkin. Sichqoncha bilan ushbu vertikal qator bo‘ylab 
yurib, qatlamlami yashirish yoki ko‘rsatish mumkin:

1) agar barcha qatlamlar ko‘rinadigan holatda bo‘lsa, vertikal 
qator bo‘ylab yuqoridan pastga (yoki pastdan yuqoriga) qarab 
«ko‘zlar»ning ustidan sichqonchani yurgazilsa, hamma qatlamlar 
ekrandan yo‘qolib qoladi. Hamma qatlamlar yashirilgan holatda 
bo‘lsa, tasvirlar joylashgan soha shaffof (shaxmat doskasi kabi) 
holda ko‘rinadi;

2) takror «ko‘zlar» ustidan tortsangiz — qatlamlar yana 
ko‘rinadi;

3) Alt tugmasini bosib turgan holda sichqoncha bilan kerakli 
qatlamning «ko‘zini» bossangiz, shu qatlamdan boshqa qolgan 
qatlamlar yashiriladi; qolgan qatlamlarning yana ko‘rinishi uchun, 
Alt ni bosgan holda, shu qatlamning «ko‘zi»ga sichqonchani takror 
bosish kerak.

Qatlamlar bilan turli amallami bajarish, ya’ni bir nechta qatlamni 
ko‘rsatish, turli stillar va effektlar qo‘llash orqali tasvimi yanada 
sifatli holatga keltirish mumkin.

Qatlamlar bittalab belgilanadi va tahrirlanadi. Belgilangan qatlam 
faol qatlam deyiladi. Qatlam faollashganda uning nomining yonida, 
«ko‘zdan» o‘ng tomonda mo‘yqalam piktogrammasi paydo bo‘ladi.

Qatlamlarning ketma-ketligini o‘zgartirish bilan tasvirdagi ele- 
mentlarning joylashish tartibini o‘zgartirish mumkin.

Layer Options (Параметры слоя) — qatlamlar parametrlari 
oynasi qatlamlarning nomini o‘zgartirishga imkon beradi, buning 
uchun:
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Layers 1
(Normal M  OmcHy: liOOK I» I D ock to Po'ettf? '-.Veli

Leek: . | у Л FI: llOOK F I New Layer...
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Dupfcate Layer... 
Delete Layer

И г | 'Г  jnovtr Delete L inked Layers 

Delete Hidden Layersml r Г®1®| |LeyA1 kl 1 C-i
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New Set From Linked...

Lock All Layers In Sc-t...

Layer Properties...
® . О  □  © . EU & u. Blencfrig Options...

Merge Layers 

Merge VisUe 
Flatten Image

Palette Options...

93-rasm. Layers palitrasi.

1) Layers palitrasida biror qatlamning ustida sichqonchaning 
chap tugmasini ikki marotaba tez bosing;

2) ochilgan Layer Options (Параметры слоя) oynasiga yangi 
nom berib, OK tugmachani bosing.

Layers (Слои) palitrasi qatlamlarni qo‘shish, o‘chirish, kobr- 
satish/yashirish, nusxalash, guruhlash, bogMash va orqa fondan 
yuqorida joylashgan qatlamlarning joylashish tartibini o‘zgartirish 
imkonini beradi (93-rasm). Har bir qatlamga qo‘yilish va shafioflik 
rejimlarini qo‘llab, har bir qatlamni boshqa qatlamlarga qo‘yilishini 
boshqarish imkoniyati mavjud. Shu bilan birga, qatlamlarni maska 
(mask)ga bog‘lasa ham bo‘ladi.

Standart turdagi qatlamlardan tashqari, Photoshop dasturida 
yana ikki xil turdagi qatlamlarni yaratsa bo‘ladi: korrektirov- 
kalanadigan qatlam (adjustment layer) — vaqtincha ranglardan 
foydalanishda yoki qatlamdagi ranglarni korrektirovkalashda 
ishlatiladigan qatlam va tahrirlanadigan matn qatlami (editable 
type layer), bu qatlam Type (Tekst) yoki Vertical Type (Верти­
кальный текст) asboblarini ishga tushirganda avtomatik ravishda 
paydo boMadi. Agarda qatlamga qandaydir effekt qoMlanilsa (masa- 
lan, Inner Glow (Внутреннее свечение), Drop Shadow (Отбро­
сить тень)), qatlam nomi yonida effekt piktogrammasi 2  va 
qoMlanilgan efifektlarni ko‘rsatuvchi menyuni chiqarish tugmasi 
paydo boMadi.
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Faqat joriy qatlamnigina tahrirlasa boladi. Qatlamni tanlash 
uchun Layers palitrasidagi qatlam nomiga sichqonchani bosish 
kerak.

Yangi faylning foni shaffof rangda bolishi uchun File > New 
(Файл > Новый) buy rug1 ini bajarib, ochilgan muloqot oynasida 
Contents (Содержание) maydonida Transparent (Прозрачный) 
bandini tanlash kerak.

Наг bir qatlam uchun Blending Options (Опции смещивания) 
buyrug‘ini qo‘llab, ochilgan Layer Style (Стил слоя) paneli mulo­
qot oynasi orqali turli qo‘shimcha effektlar (stillar) qollash mumkin 
(94-rasm). Bu muloqot oynasi Layers palitrasida biror qatlamning 
ustida sichqonchani ikki marta tez bosish bilan chiqariladi. Agar 
avvalroq biror qatlamga ushbu panelning biror effekti qo‘llangan 
bo‘lsa, u holda bu qatlam nomining yonida paydo boMadigan effekt 
piktogrammasi ni bosish bilan shu qo‘llangan effektlar ro‘yxatini 
ochish mumkin. Ro‘yxatdagi istalgan effektni tanlash bilan Layer 
Style paneli oynasini toliq holda ochish mumkin.

Ushbu panel obyektlar uchun tayyor effektlarni qoMlash im- 
konini beradi. Ushbu effektlar bilan tanishib chiqaylik:

Drop Shadow (Наружная тень) -  tashqi soya -  obyektga 
tashqi soya berish;

— P lM fci  Options -  
— 6tM ral

I OK

Cancel I 

New Style.,. |

|— Adf«c«4BMh| |7  Preview
Г” Outer Glow 

|7  Inner Glow 

|7  Bevel end Emboss W Blend Interior Effecli as Group 
r  Blend Clipped Layers ex Group 
[7  Transparency Shapes Layer 
r  Layer Mask Hides Effects 
r  Vector M *ik Hides Effects

■Ct-i fei %

H

P Texture 

17 Setin

|7  Color Overlay 

Г  Gradient Overlay 

Г  Pattern Overlay 

Г  Stroke

Blend f t  |<3rav

This Layer i 255

H

Underlying Layer i 255

94-rasm. Layers Style paneli.



Inner Shadow (Внутренняя тень) — ichki soya — obyektga 
ichki soya berish;

Outer Glow (Внешнее мерцание или лучь) — tashqi miltillash — 
obyektga tashqi miltillash yoki nur effektini qoMlash;

Inner Glow (Внутреннее мерцание или лучь) — ichki miltillash — 
obyektga ichki miltillash yoki nur effektini qo‘llash;

Bevel and Emboss (Луч и тень) — nur va soyalar — obyektga 
nur va soyalar effektini berish;

Color Overlay (Наложение цвета) — rang bilan qoplash — 
obyektni biror rang bilan qoplash;

Gradient Overlay (Наложение градиента) — gradiyent bilan 
qoplash — obyektni gradiyent bilan qoplash;

Stroke (Обводка) — olrab chiqish — obyektning chetlarini 
chiziq bilan o‘rab chiqish.

Har bir effektning olziga xos sozlash parametrlari mavjud 
boMib, ularni o‘zgartirish orqali olinayotgan natijani turlicha ko‘ri- 
nishga keltirish mumkin.

Obyektga ma’lum bir effekt qo‘llangandan so‘ng Layers panelida 
ular haqidagi ma’lumot ko‘rinib turadi. Effekt ustida sichqonchani 
ikki marta bosish orqali o‘matilgan parametrlami o‘zgartirish mumkin.

«Sehrli tayoqcha» asbobi tanlanganda parametrlar panelida Use 
All Layers parametrining tanlanishi ushbu asbobning hamma qat- 
lamlarga, aks holda faqat joriy qatlamga qo‘llanishini ta’minlaydi.

7.2. Unsharp Mask filtridan foydalanish

Agarda tasvir o‘lchamlari yoki ruxsat etilgan qobilligini o‘zgar- 
tirsangiz, bunda Image > Image size buyrug‘i muloqot oynasidagi 
Resample Image (Интерполяция) maydonida bayroqcha qo‘yilgan 
boMsa, so‘ngra tasvirni CMYK rejimiga o4kazsangiz yoki tasvirda 
okzgartirishlarni (трансформация) amalga oshirsangiz, u holda 
interpolatsiya natijasida tasvir aniqligi yo‘qoladi.

Unsharp Mask (Маска нерезкости) filtri yordamida tasvir- 
larning ravshanligi (резкость) fokusirovka (aniqlashtirish) qilinadi. 
Bu filtr yorqinliklari farqi siz ko‘rsatgan qiymatga teng bo‘lgan 
barcha qo‘shni piksellarni topib, ularni siz ko‘rsatgan qiymatgacha 
orttiradi. Bu filrtning quyidagi sozlash parametrlari mavjud: Amount 
(Количество) — ravshanlik darajasi; Radius (Радиус) — ravshanlik 
darajasi qoMlaniladigan qo‘shni piksellar miqdori; Threshold (Порог) — 
filtr qo‘llanilishi uchun piksellarning yorqinlik darajasi farqi qanday
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bolishi kerakligini kobrsatuvchi parametr, bu parametr qiymati 
qanchalik kichik bolsa, shuncha ko‘p piksellar ravshanligi oshi- 
riladi.

Unsharp Mask filtrining parametrlarini turlicha qiymatlar bilan 
sozlab qolllanilishiga misol kobrib chiqaylik.

1. Biror rasm tanlaymiz (95-rasm).

95-rasm.

2. Filter > Sharpen > Unsharp Mask (Фильтр > Резкость > 
Нерезкое маскирование) buyrugbini tanlaymiz, filtrni quyidagi para- 
metrlar: Amount — 160%, Radius — 1,5, Threshold — 0 (96-rasm) 
bilan rasmga qollab, quyidagi natijani olamiz (97-rasm).

100N *1

¿mount: flM X
-----a----------- -

Badlus: [15 pixels
■—q-------------------

HfeshoU: pi levels
Q------------------------------------- —

96-rasm. Unsharp Mask filtri m uloqot  oynasi.
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Amount parametri piksellarning kontrastligi qanchalik yuqori 
boMishini belgilaydi. Amount parametrining qiymati katta boblganda, 
yuqori kontrastli sohalarda oreol (yorug‘ gardish) paydo bo4adi. 
Yuqori sifatli bosma tasvirlarni olish uchun uning qiymatini 150— 
200% oraliqda olish tavsiya etiladi.

3. Radius parametrini sozlash birmuncha qiyin bo‘ladi, buning 
uchun tasvirning natijaviy oMchami, tasvirda nima berilganini aniq 
bilish lozim. Radius parametrining qiymatini 0,1 dan 250 gacha 
oraliqda berish mumkin. Yuqori ruxsat etilgan qobillikka ega tas- 
virlar uchun uning qiymatini 1 va 2 qilib olish tavsiya etiladi. Bu 
parametrning kichik qiymatlarida faqat chegaraviy piksellar, katta 
qiymatlarida esa kokproq sohadagi piksellar ravshanlashtiriladi. Bu 
parametrning efTekti printerga qaraganda ko‘proq ekranda bilinadi.

Kontrastligi past boMgan tasvirlar uchun katta qiymatli radius 
va murakkab boMgan yuqori kontrastdagi tasvirlarga esa kichik 
qiymatli radius berish kerak.

Radius parametrining qiymati qancha katta bo‘lsa, Amount 
parametrining qiymatini shuncha kichik olish kerak va aksincha.

Misol uchun, yuqoridagi rasmga Unsharp Mask fiItrini quyidagi 
parametrlar: Amount -  130%, Radius — 6,0, Threshold — 0 
(98-rasm) bilan qoMlab, quyidagi natijani olamiz (99-rasm).

4. Threshold (Порог) parametrining qiymatlari qancha kichik 
tanlansa, shuncha kolp piksellar okzgartiriladi. Agarda qiymati 0 
qilib olinsa, tasvirdagi barcha piksellar ravshanlashtiriladi. Qiymati 
qancha katta bolsa, yuqori kontrastli joylarning chegaralariga yaqin 
joylarda ravshanlik yuqorilashadi va past kontrastlilarda ravshanlik 
kam miqdorda olzgaradi.

97-rasm. Filtrni qoMlagandan keyingi natija.
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98-rasm. Unsharp Mask filtrining parametrlarini sozlash.

i s

99-rasm. Filtrni qo'llagandan kcyingi natija.

Agarda Threshold parametri qiymatini olzgartirsak, Amount 
va Radius parametrlarining qiymatlari ham kokp boMadi, bunda 
chegaraga yaqin joylardagi kontrastlik ortadi.

Tasvirda nosozliklarni (шум — shovqin) yo'qotish uchun, 
Threshold parametr qiymatlarini 8—20 oraliqda berish kerak.

Unsharp Mask filtrini quyidagi parametrlar: Amount — 160%, 
Radius — 1,5, Threshold — 15 (100-rasm) bilan qo41ab, quyidagi 
natijani olamiz (101-rasm).
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Unshaip  Mask

100-rasm Unsharp Mask fillrining parametrlarini sozlash.

101-rasm Filtrni qcVllagandan kcyingi natija.

I—=-11 N azorat savollari

1. Yangi qatlam qanday varatiladi?
2. Layer Style panelida qoMlash mumkin boMgan efTektlarga izoh 

be ring.
3. Unsharp Mask filtridan nima uchun foydalaniladi? Lining qanday 

parametrlari mavjud va ular qanday vazifani bajaradi?
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VIII BOB. FILTRLAR УА MAXSUS EFFEKTLAR

Photoshop dasturidagi flltrlar tasvirga bujmaytirish, o‘zgartirish, 
turli rassomchilik usullarini qo‘llash, mozaika yoki oynavand vitraj 
holiga keltirish kabi turli xil maxsus effektlarni qo‘llash, kontrast 
va aniqlikni oshirish kabi imkoniyatlarni beradi. Photoshop 
dasturiga juda ko‘plab flltrlar to‘plami kiradi. Unga yana boshqa 
qo‘shimcha filtrlarni qo‘shish mumkin. Biror filtrni faollashtirish 
uchun asosiy menyuning Biter (Фильтры) bandiga kirib, u yerdan 
kerakli flltrlar guruhini tanlab, so‘ngra filtrning o‘zini tanlash 
kerak. Tanlab olingan filtrni tasvirga yoki belgilangan sohaga qo‘l- 
lash mumkin.

Ko‘p filtrlarda sozlash oynachalari mavjud bo‘lib, unda bir 
vaqtning o‘zida filtrni sozlab, natijasini kuzatish mumkin.

Asosiy flltrlar guruhini ko‘rib chiqamiz va ularga qisqacha 
izoh beramiz. Ochig‘ini aytganda, filtrlarni ta’rifiashdan ko‘ra, 
ularning natijasini ko‘rish samaraliroq bo‘ladi.

Artistic (Имитация разных приемов рисования) — turli 
rassomchilik usullarini qo‘llash.

Blur (Размытие) -  kontrastni kamaytirish yoki ranglarni 
yoyish.

Brush Strokes (Имитация работы кисти) — mo‘yqalam bilan 
ishlash imitatsiyasi.

Distort (Деформация) — deformatsiyalash.
Noise (Работа с шумом и дефектами) — shovqin va defektlar 

bilan ishlash, ulami qo‘shish yoki olib tashlash.
Pixelate (Работа с пикселями) — piksellar bilan ishlash, ulami 

turli qonuniyatlar bo‘yicha birlashtirish.
Render (Всякие исскуственные эффекты) — turli sun’iy 

effektlarni qo‘llash, axborotni grafik ko‘rinishda aks ettirish jarayoni.
Sharpen (Резкость) — tasvirni aniqroq qilish.
Sketch (Имитация всяких стилей и приемов) — turli stillar 

va usullami qollash.
Stilize (Стилизация) -  turli stillar imitatsiyasi.
Texture (Создание текстур) — teksturalar yaratish.
Filtrlarning qoMlanilishiga biror misol korib chiqamiz. Ushbu 

misolni turli rasmlarning kompozitsiyasi sifatida bajaramiz. Bu 
kompozitsiyaning natijaviy ko‘rinishi 102-rasmda keltirilgan.
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102-rasm. Bajarilishi kerak bo'lgan kompozitsiya ko‘rinishi.

Kompozitsiyani bajarish uchun quyidagi ketma-ketlikdagi ish- 
larni bajarishimiz kerak:

1) ikkita — tog‘ va dengiz tasvirini olish;
2) tasvirlarni bir-birining ustiga qo‘yish va vektor maskani 

gradiyent bilan qo'llab, ikki tasviming estetik qo‘shilishiga erishish;
3) ayiqlar, delfmlar va qushlar rasmini q o ‘y is h ;

4) hajmli zarhal yozuv yaratish;
5) bajarilgan ishni psd va jpg formatlarida saqlash.
Ishni boshlaymiz:
1) ikkita tasvimi olamiz (103-rasm);
2) Lasso asbobini tanlab, tuslash (Растушевка) maydonida 

20 piksellik qiymatni o‘matamiz (104-rasm);
3) Lasso asbobi yordamida biror sohani belgilaymiz va shu so- 

hani Move asbobi yordamida ikkinchi tasvirga o‘tkazamiz ( 105-rasm);
4) o‘tkazilgan rasmni kerakli joyga va kerakli o‘lchamlar bilan 

joylashtiramiz (106-rasm);
5) hosil boMgan Qatlam 1 (Слой l)ga vektorli maskani qo‘l- 

laymiz (107-rasm);
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103-rasm. Tanlangan tasvirlar.

С  Adobe Photoshop

Файл Редактирование Изображение Слой Вы

'  I ü JIC J ®  Растуилмты I 20 пке

104-rasm. Lasso asbobini tanlash va 
kerakli parametrlarni olrnatish.
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WÎ Adobe Photoshop

Файл Редактцхвание Изображение Слой Выделение Фильтр Просмотр Окно Справка

0  Настраивать размер оком 0  Б «  учета палитр О  Во всех окнах | Реальный раа»#

Я Е З С

Файл Реажтцю в»*« Иэобрвш*« СлоА Выделоме Фи/ътр Присмотр О хо  Слраа'л 

•  . J  V J Ö* -Öj Рктуимак»: 0 пике Стил»: нормдльмми

t' zimniye fantazii.psd ç> 50% (RGB/8)

105-rasm. Lasso yordamida kerakli sohani belgilab, ikkinchi tasvirga
o ‘tkazish.
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106-rasm. 0 ‘tkazilgan rasmni joylashtirish.

107-rasm. Q atlam  I ga vektor maskani q o ‘ llash.
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6) Gradient asbobini tanlab, gradiyentlar palitrasidan Black, 
White (qoradan oqqa oktish) gradiyentini tanlaymiz (108-rasm);

C, Adobe Photoshop

Файл Редактирование Изображение Слой Вь

S o a s a

108-rasm. Gradiyentlar palitrasi.

I Й П В В П I

7) Parametrlar panelidan chiziqli gradiyent turini
tanlab, tasvirimiz ustidan gradiyent tortamiz (109-rasm);

С1111ИИЦЧ1Ш« lUeOpm n « . Слой IW w n »  a m ip  r^nooip amo О щ а

109-rasm. Gradiyent tortish.
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8) qatlamlami birlashtiramiz (Слой > Объединить с видимым);
9) ayiqlar, delfînlar va qushlar rasmini Magnetic Lasso (magnitli 

lasso) asbobi (20 piksellik tushlash parametri) bilan kesib, tasvirga 
qo‘yamiz (110-rasm);

Файл Ремспфопм« ItaoSparaig Свой ftwwnitf смотр Г^юоетр t e «  Гцич »

* *  А У.
АЖ
.̂1Я) 

Û. •>. 
S. т. 
4 .4
'Ж ло ^

р а
вва|

щ о я а а  ! р—■ | ¿ 1 н̂ яр.11

zininiye fdntazii.psd (S 50% (RGB/8) 

« H t « —к а п ш а а р ш а а н ц а

v t >

а Дам2Д>УМЧ

110-rasm. Ayiqlar, delfinlar va qushlar rasmini qo‘yish.

10) endi yozuvni qo‘shamiz. Type (Текст) asbobini tanlaymiz, 
parametrlar panelida shriftning o‘lchamini 72 pt va rangini sariq 
qilib o‘rnatamiz hamda yozuvni kiritamiz (111-rasm);

111 -rasm. Yozuvni kiritish.
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11) Слой > Эффекты слоя > Тень (soya) buyrugMni tanlab, 
quyidagi sozlashlarni kiritamiz: м у т н о в а т о с т ь  (xiralik) -  75%, 
расстояние (masofa) -  16 pks, разброс (siyraklik) -  10%, размер 
(oMcham) -  7 pks va yozuvga soya effektini qoMlaymiz (112-rasm);

Pk CT W W I ^ -----------------------  I ц  |rwc

Ptt6poci -----------------  [ 10 I »
P « M P I J --------------------------  I 7 \mc

KoHtfpn l á ú  O —
I Шу»' 2-----------------  [• I»

(0СЯвй УМММШ»А nUWIM т**«

112-rasm. Yozuvga soya efTektini qokIlash.

12) Слой > Эффекты слоя > Внешний свет (tashqi nurla- 
nish) buyruglni tanlab, quyidagi sozlashlarni kiritamiz: полупроз- 
рачность (yarim shafToflik) — 75%, texnika -  мягкий (yumshoq), 
разброс (siyraklik) — 7%, размер (o‘lcham) — 114 pks, область 
(soha) -  50% (oblast) soha va yozuvga tashqi nur efTektini qoMlaymiz 
( 113-rasm);

12) Слой > Эффекты слоя > Рельефность (relyeflik) buy- 
rugMni tanlab, muloqot oynasida rasmdagi kabi sozlashlarni ki- 
ritib, yozuvga relyeflik effektini qoMlaymiz (114-rasm);

13) Слой > Эффекты слоя > Штрих (shtrixlash) buyrugMni 
tanlab, muloqot oynasida rasmdagi kabi sozlashlarni kiritib, yozuvga 
shtrixlash effektini qoMlaymiz (115-rasm);

14) kompozitsiyamiz tayyor boMdi, uni psd va jpg formatlarida 
saqlab qo‘yamiz (10-rasmga q.).
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115-rasm. Yozuvga shtrixlash ciTcktini qoMlash.

116-rasm. Tayyor kompozitsiyaga yana bir misol.

Nazorat savollari
\

1. Filtrlarning vazifalari nim alardan iborat?
2. Asosiy filtrlar guruhlarin i ayting va ularga qisqacha izoh bering.
3. M atnga qanday  efiektlar qoMlash m um kin?
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IX BOB. ADOBE PHOTOSHOP DASTURNING 
INTERFEYSI

9.1. Asosiy tushunchalar

Adobe Photoshop dasturida matn bilan ishlashning bir qancha 
imkoniyatlari mavjud.

i l  Type (Текст) matn bilan ishlash asbobi yordamida ekranga 
yozuvlarni chiqarish mumkin. Asbob tanlangach, ishchi varaqning 
yozuv yozilishi lozim bolgan qismida sichqoncha bir marta bosilib, 
yozuv kiritiladi.

Yozuv kiritib bo‘lingach parametrlar panelida chiqadigan bu 

asbobga tegishli bolgan Q y | tugmalari orqali matnga kiritilgan
yozuvni qabul qilish yoki bekor qilish mumkin. Matnga oid barcha 
parametrlarni o‘rnatish Character (Символ) paneli yordamida 
amalga oshiriladi (117-rasm). Bu yerda shrift, uning oMchami, 
so‘zlar orasidagi masofa, simvollarning balandligi, terish qatoridan 
baland yoki pastda (daraja ko‘rsatkichi yoki indeksda) joylashishi, 
qatorlar orasidagi interval, simvollar orasidagi masofa, simvol keng- 
ligi, rangi kabi parametrlarni o‘rnatish mumkin.

Bu asbobning quyidagi xillari . Horizontal Typ. Tool T

mavjud: H orizontal Type Tool iTv*rtieiiTyp*Tooi т
(ГорИЗОНТаЛЬНЫЙ ТеКСТ) — gori- ĤorfaonUl Typt M*k Tod т

zontal holatda matn kiritish; Vertical дрлгиягтурвмлтоы т 
Type Tool (Вертикальный текст) -
vertikal holatda matn kiritish; Horizontal Type Mask Tool (Гори­
зонтальный текст-маска) — gorizontal holatda matn-maska ki­
ritish; Vertical Type Mask Tool (Вертикальный текст-маска) —
vertikal holatda matn-maska kiritish.

Parametrlar panelida quyidagi parametrlarni berish mumkin: 
matn yo‘nalishini o‘zgartirish; 
matnning shriftini o‘zgartirish;
simvollarning ko‘rinishini o‘zgartirish (qalin, yotiq, tagi chizilgan); 
shift oichamini o‘zgartirish; 
simvolning chetlari ko‘rinishini o‘zgartirish; 
matnning abzasda joylashishi: chap, markaz yoki o‘ng tomon 

bo‘yicha tekislash holatini o‘zgartirish; 
matn rangini o‘zgartirish;
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ВЕЛ

|  Character

[Myriad Pro ^ | [Regular j r J

•ff f72pl 3  it | (Auto) 3
%  | Metrics _ J  g  10 _ J

r r  r  100% 1100%
| Opt Colon m m i

T T  TT Ik T1 Tt I T

I English; USA  *■ | i j | s h a r p  _»J

117-rasm. Character pancli.

Paragraph (Абзац) paneli yordamida matnning biror abzasiga 
tegishli parametrlarni: matnni okng, chap chegara yoki markaz bo‘- 
yicha tekislash, abzas va otstuplarni o‘rnatish mumkin (118-rasm).

Type asbobi ishlatilganda yangi matn qatlami paydo boMadi 
(Text Layer).

9.2. Matnni deformatsiyalash va 
unga turli effektlar berish

Tashrif qog‘ozlari (vizitka), reklama afishalari va shu kabilardagi 
matnga turli dizayn va ishlovlar berishga ehtiyoj boMadi.

Warp Text paneli yordamida matnni turli xil trayektoriyalar 
bolyicha deformatsiyalash mumkin (119-rasm). Bu panel chiqa- 
rilgach, uning muloqot oynasida matnni qanday trayektoriya bo‘- 
yicha joylashtirish kerakligi, egrilik radiusi, gorizontal va vertikal 
og‘malik darajasi olrnatiladi. Solngra OK tugmasini bosish bilan 
ko'rsatilgan parametrlar matnga qo‘llanadi.

Matnni belgilab Styles panelidan kerakli texturani tanlab, matn­
ni shu texturada bo‘yash mumkin (120-rasm).

Biror misol kokrib chiqaylik. «TUTS.KHK.UZ» matnini kiritib, 
unga turli effektlar qoMlash orqali, «tuproqli» matn (121-rasm) 
tayyorlash ketma-ketligini bajaramiz:

1) oq fonda xohlagan oMchamda yangi oyna ochamiz va qora 
rangda matnimizni yozamiz:

Character

[21 Hyphenate 

118-rasm. Paragraph paneli.

T U T S .K H K .U Z
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119-rasm. Warp Text paneli. 120-rasm. Styles paneli.

121-rasm. «Tuproqli» matn ko‘rinishi.

2) Filter > Stylize > Diffuse filtrini qo‘llaymiz. Bu filtr sifatli 
tasvirlar hosil qilishning usullaridan biri bo‘lib, sochiluvchan (dif- 
fuz) dizering (diffused dithering) asosida ishlaydi. Uning mohiyati 
shundan iboratki, piksellar tasodifiy (yoki psevdotasodifiy) ravishda 
hosil qilinadi.

Agar har bir gradatsiya uchun tasodifiy piksellar hosil qilsak, 
unda hatto rastrlaming doimiy rangli piksellari uchun ham tartib- 
lashgan struktura hosil boimaydi. Bu notekis (matoviy) sirtdan 
numing sochilib qaytishiga o ‘xshash effekt beradi (122-rasm).

Matnimizga boshqa filtrlami ham qo‘llaymiz:
3) Filter > Stylize > Emboss filtrini quyidagi parametrlar bilan 

qo‘llaymiz: Angle (burchak) — 90°, Height (balandlik) — 2 pks 
(123-rasm);

4) Filter > Texture > Grain filtrini qo‘llaymiz (124-rasm);
5) Layer > Layer style > Drop shadow effektini qo‘llaymiz 

(125-rasm);
6) Layer > Layer style > Inner Glow effektini qo‘llaymiz 

(126-rasm);
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122-rasm. filter > Stylize > Diffuse filtri.

r  - r

L B  O

123-rasm. Filter > Stylize > Emboss filtri.

7) Layer > Layer style > Satin effektini qo‘llaymiz (127-rasm);
8) Layer > Layer style > Stroke effektini qo‘llaymiz (128-rasm) 

va yakuniy natijani olamiz.
Shunday qilib tuproqli matn bajarildi (129-rasm).

107



124-rasm. Filter > Texture > 125-rasm. Layer > Layer style > Drop 
Grain filtri. shadow effekti.

126-rasm. Layer > Layer style > Inner Glow effekti.
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127-rasm. Layer > Layer style > Satin effekti.

128-rasm. Layer > Layer style > Stroke effekti.

m if f l iu z

129-rasm. Yakuniy natija — «tuproqli» matn.

L=i=jl Nazorat savollari
f»ssss\

1. Matn kiritish asbobining qanday turlari mavjud? Ularga izoh bering.
2. Character va Paragraph panellariga qisqacha izoh bering. Ular 

orqali matnning qanday parametrlarini o‘matish mumkin?
3. Matnlami biror trayektoriya bo‘yicha joylashtirish qanday amalga 

oshiriladi?
4. Matnlarga qanday effektlami qo‘llash mumkin?
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X  BO B. BIR XIL VA RANGLI KORREKSIYA

Photoshop dasturi nuqtayi nazaridan, har bir piksel 0 (qora) dan 
255 (oq) gacha boMgan yorugMik qiymatiga ega. Tasvirda qo‘llanilgan 
to‘liq yorugiik qismi tasviming bir xil diapazoni deb yuritiladi. Bir 
xil diapazon qancha keng bo‘lsa, detallami qayta ishlash shuncha 
yaxshi va ranglar «chuqur» boMadi. Ushbu masalani yorug‘lik va 
soyalar korreksiyasi yechadi.

Agarda bir xil diapazonni uchta boMakka boMsak, unda eng 
qorong‘i qismi soya (shadows), eng och qismi yorug‘lik (highlights), 
ular orasida joylashgan qism o‘rta tonlar (midtones) deb ataladi. 
Tasvirning eng kerakli fragmenti ushbu uchta qismdan birida 
joylashgan bo‘lib, u yerda ottenkaning eng maksimal miqdori 
boMishi kerak. Muhim tonal diapazonning kontrastini ko‘paytirish 
tonal korreksiyani tashkil qilishdan iborat boMadi.

Bosma qurilmalari juda qora va juda och tonlarni yomon qabul 
qiladi. Odamning ko‘zi o‘rta yorug‘lik sohalami yaxshi qabul qiladi. 
Shuning uchun korreksiya tushunchasi, agarda eng kerakli detallar 
yorug‘lik va soyalardan uzoqda joylashgan bo‘lsa, tonal diapa­
zonning o‘rta ton tomonga silijishini o‘z ichiga oladi.

Rasmlaming oqarib ketishi, noto‘g‘ri skanerlash, tasvirga olish 
sharoitining buzilishi va boshqa holatlarda tasvirlar xira chiqishi 
mumkin. Bu nuqsonlarni tuzatishga bir misol ko‘rib chiqamiz.

Bizga bir xonadonning juda qorong‘i ekspozitsiyasi berilgan 
(130-rasm). Bunday tasvir nuqsoni amaliyotda juda kolp uchraydi. 
Bunday nuqsonli tasvirlarni korreksiyalash gammani (gamma 0 
dan 10 gacha shartli birlikda oMchanadi), ya’ni tasviming o‘rta 
tonlarini o‘zgartirishdan iborat boMadi. Buning uchun o‘rta tonlar 
katta yoki kichik yorugMik tomonga siljitiladi. Shunga qaramasdan, 
tonal diapazon o‘zgarmasdan qoldi. Tonal diapazonni korreksiyalash 
algoritmini bajaramiz:

1. 130-rasmdagi gistogrammadan ko‘rinib turibdiki, butun yorug‘- 
lik intervalida detallar mavjud, shuning uchun bu sathni kesib 
tashlash yorugMik qismidagi detallarning yo‘qolib ketishiga olib 
keladi. Ammo pik gistogrammalar soyalarda joylashgan. Agarda 
tasvir bir necha barobar yorug‘roq boMsa, tasvirning sifati bundan 
yutishi mumkin. Tasvirni gamma korreksiyalash uchun Levels 
(Уровни) buyrug‘i muloqot oynasidagi gistogrammadan foydala- 
namiz (131-rasm). Histogram (Gistogramma) buyrug‘i faqat tonal
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130-rasm. Berilgan rasm va lining gistogrammasi.

Chamel ! RGB v

r p jt  Levels ¡0 3.34 255

Output Levels 0 ; 255

1

AlitO ]

Options . 1

Ш Ш
0 P r e v i e w _______________________________

a b

131-rasm. Gammani korrcksiyalash va korreksiyalangan tasvir.

diapazon tolg‘risida axborot olish uchungina qoMlaniladi va undan 
korreksiyalash uchun foydalanib boMmaydi.

Tasvirning eng qorongki piksellariga nollik yoruglik beramiz, 
eng ochlariga maksimal yoruglik beramiz. Shunda tasvirning ton- 
lari toliq diapazonli yorugllikka chokziladi. Bunday amal tonal 
diapazonning kengayshi deyiladi.

2. Levels (Уровни) buyrugli oynasini ochamiz. Kulrang sil- 
jitgich (131-я rasm) okrta tonlarni ko'rsatib turibdi. Oyna ochi- 
lishida gamma birga teng, Input Levels (Входные уровни) guruhi 
o‘rta maydonchasida akslantirilgan.

3. Siljitgich soyalar tomonga suriladi. Gamma kattalashadi, 
tasvir yorqinlashadi (131-A rasm). Bu yerda soyalar va yorugiiklar 
o'zgarmaydi.

4. Tasvirni keraki formatda saqlaymiz.

Nazorat savollari

1. Levels buyrug‘ining vazifasi nim adan iborat?
2. Histogram buyrugMning vazifasi n im adan  iborat?
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X I BO B . RASMLARNI RETUSHLASH VA 
TIKLASH

11.1. Yuvilish effektini bemvchi filtrlar

Yuvilish filtrlari belgilash yoki tasvirni yumshatish yoki tasvir- 
ning o‘zini retushlash uchun qoMlaniladi. Ular tasvirdagi ma’lum 
chiziqlar va soya joylarning keskin chegaralari yonidagi piksellami 
obrtachalashtirish hisobiga o‘tishlarni yumshatadi.

Yuvilish filtrlarini tanlash uchun asosiy menyuning Filter 
(Фильтр) bandi Blur (Размытие) buyrug‘ini tanlab, ochilgan 
ro‘yxatdan tegishli yuvilish filtrini tanlaymiz. Ular bilan tanishib 
chiqaylik:

Smart Blur (Умное размытие) — «aqlli» yuvilish filtri asosan 
tasvirning yengil timdalangan va donadorlik (зернистость) kabi 
mayda kamchiliklarini bataraf qilish uchun qoMlaniladi. Bu kam- 
chiliklar ko‘pincha ayrim piksellarning kattalashishi bilan ular kon- 
trastining keskin farq qilishi bilan bogMiq. Ushbu filtr tasvirning 
keskin tonli va rangli o‘tishlar mavjud bo‘lmagan sohalarni yum­
shatadi. Tasvir chetlari qoniqarli darajada qoladi, lekin mayda 
detallari yo‘qoladi. Kuchli yuvilishda tasvir xuddi bo‘yoq bilan 
bajarilgan rasmga o‘xshash bo‘lib qoladi. Quyidagi sozlash para- 
metrlari mavjud:

Radius (Радиус) — siljitgich yordamida yuvilish uchun nuq- 
talarni topish sohasi aniqlanadi. Radiusning qiymati kattalashishi 
bilan yuvilishning holati asta-sekin kattalashib boradi, so‘ngra 
yuvilish darajasi o‘zgarmas bo‘lib qoladi.

Threshold (Порог) — piksellar orasidagi tonli farq ulami bartaraf 
etishgacha qanday boMishini belgilaydi. Bu parametr qiymati qancha 
katta bo‘lsa, shuncha ko‘p tasvir sohasi yuvilishga uchraydi.

Quality (Качество) — yuvilish sifatini belgilaydi. Uning 3 ta 
turidan bittasini tanlab olish mumkin: Low (Низкое) — past; 
Medium (Среднее) — o‘rta va High (Высокое) — yuqori sifatli 
yuvilish.

Mode (Режим) — yuvilish uchun sohani belgilaydi. Uning, 
o‘z navbatida, 3 ta rejimi mavjud: Normal (Нормальный) — butun 
tasvir; Edge Only (Только края) — faqat chegaralar, natijada oq- 
qora tasvirni olish mumkin; Overlay Edge (Совмещение) — 
yuqoridagi ikki rejimning ikkalasini qo‘llash.
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Gaussian Blur (Размытие по Гауссу) — Gauss bo‘yicha 
yuvilish ko‘p ishlatiladigan filtrlardan bin boMib, u bilan ko‘rsatilgan 
radius qiymati bo‘yicha tez yuvilish amalga oshiriladi. Bu filtr 
tasvirni past chastota bilan detallashtirib, tuman effektini berishi 
mumkin. Bundan tashqari, bu filtr bilan tasvirda qandaydir ele- 
mentni olib tashlash qulaydir, masalan, skaner orqali yaratilgan 
rastr polosasini yo‘q qilish uchun tasviming rastrli strukturasini 
o‘zgartirish. Buning uchun katta bo‘lmagan radius beriladi.

Lens Blur (Размытие при малой глубине резкости) — rav- 
shanlikning kichik darajadagi yuvilish filtri tasvirga hajm effektini 
yaratishga yordam beradi, ya’ni bosh ko‘rinishdagi obyektlar o‘z- 
garmay qoladi, ammo orqa plandagi ko‘rinish yuviladi va tasvir 
xuddi optik linza orqali ko‘ringandek efiekt beradi.

Ushbu filtr alohida muloqot oynasiga ega bo‘lib, unda quyidagi 
sozlash parametrlarini berish mumkin: Preview (Просмотр) 
parametrida natijani aniqroq ko‘rish uchun More Accurate (Точнее) 
bandi, tezroq ko‘rish uchun esa Faster (Быстрее) bandi tanlanadi. 
Bundan tashqari, boshqa sozlash parametrlari ham mavjud bo‘lib, 
ularning tasvirga ko‘rsatadigan ta’sirini o‘zingiz mustaqil ko‘rib 
chiqishingiz mumkin.

11.1. Oq-qora tasvirlami qayta ishlash, 
eskirgan rasmlami tiklash

Biror rasmni retushlash algoritmini ko‘rib chiqamiz (132-rasm).

132-rasm. Berilgan rasmning asli va retushlashdan keyingi ko'rinishi.
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132-rasmdagi fotosuratning asi ko‘rinishining pastki qismi chap 
tomonida ko‘rsatilgan qizchadagi defektlar olib tashlangan va 
retushlangan.

Bajarilish tartibi quyidagicha:
1) skanerlangan rasmni oq-qora rejimga o‘tkazamiz: Изобра­

жение > Режим > Черно белый;
2) rasm joylashgan qatlamning nusxasini yaratamiz, buning 

uchun qatlamlar palitrasida qatlamning nomi ustida sichqonchaning 
o‘ng tugmasini bosib, hosil bo‘lgan menyudan Дублировать слой 
buyrug‘ini bajaramiz;

3) keskin kontrastlik va yorug‘likni boshqarish buyrug‘ini 
(Изображение > Коррекция > Яркость/Контрасность) tanlab, 
bir qatlamda ochroq obyektlarni va ikkinchi qatlamda esa to‘qroq 
obyektlarni sozlaymiz;

4) ochroq obyektlar sozlangan qatlamni asosiy qatlam qilib 
olamiz;

5) yumshoq o‘chirg‘ich asbobini qo‘llab, asosiy qatlamning 
to‘qroq joylarini tozalaymiz va ikkinchi qatlam bilan hosil bo‘lgan 
tasvimi ko‘rsatamiz;

6) \ f \  tiklash mo‘yqalami asbobi bilan asosiy qatlamning katta 
va o‘rta defektlami olib tashlaymiz;

7) asbob yordamida retushlanayotgan obyektdan g‘adir- 
budurliklami olib tashlaymiz;

8) qatlamlarni birlashtiramiz: Слой > Объеденить с виды мим;
9) rasmni RGB rejimiga o‘tkazamiz: Изображение > Режим > 

RGB цвет. Ranglar balansini sozlash buyrug‘ini qo‘llab, rasmni 
ranglashtirish mumkin: Изображение > Регулировки > Баланс 
цветов;

10) natijani jpg formatida saqlaymiz.

Nazorat savollari

1. Qanday yuvilish filtrlarni bilasiz?
2. Smart Blur filtriga izoh bering. Uning qanday parametrlari mavjud?
3. Gaussian Blur filtriga izoh bering.
4. Lens Blur filtriga izoh bering.
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X II BOB. KOMPOZITSIYALI TASVIRLARNI 
YARATISH

Fotomontaj ishlari o ‘z ichiga quyidagi kabi ishlarni oladi: fonni 
okzgartirish, ramkaga rasmni qo‘shish, kiyimning rangini o ‘zgar- 
tirish, rasmdan sanani o ‘chirish, sochni tiklash, effektlar qo‘shish, 
kollajlar, kompozitsiyali tasvirlar yaratish, jismlar, odamlarning 
joyini olzgartirish va boshqalar.

Misol ko‘rib chiqaylik. Bizning misolda kompozitsiyali tasvir 
yaratish uchun uchta obyekt kerak bo‘ladi (133-rasm).

133-rasm. Kompozitsiya uchun tasvirlar (dengiz, flamingolar, oy).
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Yuqorida ko‘rsatilgan uchta tasvirdan kerakli holatlarni kesib 
olib, bitta umumiy kompozitsiyali tasvir hosil qilamiz (134-rasm).

Ushbu tasvirdan ko‘rinib turibdiki, dengiz tasviriga turli asbob- 
larni qoilab flamingo va oy tasvirlarini qo‘shdik.

Bunda quyidagi amallar bajarildi:
1) flamingolar tasviridan flamingo kesib olindi va dengiz tasviriga 

ikki marta nusxalanib, kerakli joylarga qo‘yildi;
2) xuddi shuningdek, oy tasviridan oy kesib olindi va dengiz 

tasvirining yuqorisiga joylashtirildi.

___  Nazorat savollari
f5555̂

1. Fotomontaj ishlari o‘z ichiga qanday ishlami oladi?
2. 0 ‘zingiz mustaqil ravishda biror kompozitsiyali tasvir yaratish 

algoritmini tuzib chiqing.
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X III BOB. TASVIRLARNI CHOP ETISH

13.1. Bosmaga chiqarish oldidan tasvirning o‘lchamini
o‘zgartirish

Tasvirni bosmaga (printerga) chiqarishdan oldin tasvirning o4- 
chamlarini o‘zgartirish uchun quyidagi amallar bajariladi:

1) Image > Image Size (Изображение > Размер изображения)
buyrugkini tanlang va paydo bolgan muloqot oynasida kerakli 
parametrlarni kiriting;

2) agarda tasvirning eni va bo‘yi uzunliklari nisbatini (propor- 
siyasini) o ‘zgarishsiz qoldirish kerak bolsa, Constrain Proportions 
(Сохранить пропорции) maydoniga bayroqchani qo‘ying (135-rasm).

Image Size

Pixel Dimensions: 628K 

£ktth: [iôô

Height: '

percent

100 percent
] i

OK

Reset

Ayto...

- Document Size: 

Wlflth 

Height 

Beso lut ion

|490

(27,33

points

picas !>
28.346 □

F  Constrain Proportions 

W Resample Image: | Bicubic 1Г
135-rasm. Kompozitsiyuli tasvirning ko‘rinishi.

Agarda tasvirning enini bo‘yining uzunligiga bogliq bolmagan 
tarzda o‘zgartirmoqchi bo‘lsangiz, bu bayroqchani olib tashlang;

3) chop etish oichamlarini va tasvirning umumiy piksellari 
sonini proporsional ravishda olzgartirish uchun Resample Image 
(Отслеживать изменения) maydoniga bayroqcha qo‘ying (135- 
rasm) va berilgan interpolatsiya usullaridan birini tanlang: Nearest 
Neighbour (По соседним), Bilinear (Билинейный) yoki Bicubic 
(Бикубический). Bikubik interpolatsiya tasvirning sifatiga kamroq 
ta’sir qiladi;



4) muloqot oynasida Document Size (Размер документа) 
guruhida joylashgan Width (Ширина) va Height (Высота) may- 
donlariga kerakli qiymatlami kiriting. Agarda Resample Image 
(Отслеживать изменения) maydonida bayroqcha qo‘yilmagan 
bo‘lsa, chop etish o‘lchamlari va tasvirning umumiy piksellari 
soni proporsional ravishda o‘zgarmaydi;

5) OK tugmasini bosing va natijani oling.
Agarda awalgi parametrlarini qayta tiklamoqchi bo‘lsangiz, 

Image Size (Размер изображения) Alt tugmasini va bir paytda 
Reset (Восстановить) tugmasini bosing.

Shuningdek, tasvirning o‘lchamlarini o‘zgartirish uchun File > 
Print with Preview (Файл > Печать с с предварительным прос­
мотром) buyrug‘ining muloqot oynasidan ham foydalansa bo‘ladi.

136-rasm. Tasvimi bosmaga chiqarishdan oldin ko‘rish 
buyrug‘ini tanlash.
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13.2. Tasvirni bosmaga chiqarishdan oldin uni ko‘rish

Bosmaga chiqariladigan tasviming o‘lchamlari u chiqariladigan 
qog‘oz o‘lchamlari bilan mos kelishini bilish uchun sichqonchani 
tasvir ochilgan oynaning pastki qismida joylashgan holat satriga 
olib borib bossangiz, tasviringizning qog‘ozda egallaydigan joyini 
aks ettiruvchi tasvir paydo bo‘ladi. Yana boshqa usuli: File > 
Print with Preview (Файл > Печать с с предварительным прос­
мотром) buyrug‘ini tanlab, ochilgan muloqot oynasidan tasviringiz 
qog‘ozda qandayjoy olishini ko‘rishingiz mumkin. Agar tasviringiz 
bosmaga qanday chiqarilsa, ekranda ham shunday ko‘rinishi kerak 
bo‘lsa, View > Print Size (Вид > Размер при печати) buyrug‘idan 
foydalanish kerak (136-rasm).

13.3. Adobe Photoshop dasturida veb-sahifa dizaynini
yaratish

Bu bandda Adobe Photoshop dasturida varaqlararo murojaat- 
larni yaratish usullari haqida ma’lumot berilib, ularning imko- 
niyatlari ko‘rib chiqiladi.

Photoshop dasturi asboblar pane- М Н Ц П Щ П  
lida Slice Tool asbobi mavjud bo‘lib, 
uning yordamida tasvirni bir nechta 
bo‘laklaiga ajratish mumkin. Ajratilgan
qismlaming har biri o‘z tartib raqamiga ega bo‘ladi. Slice Select 
Tool asbobi yordamida boiakni yana bir nechta bo‘laklarga ajra­
tish yoki bir nechta bo‘laklarni o‘zaro qo‘shish mumkin bo‘ladi. 
Bo‘laklarning har biri tugma vazifasini bajarib, boshqa bir sahifaga 
o‘tish imkonini beradi. Bu turdagi fayllar bilan ishlaganda tasviming 
ruxsat etilgan qobilligi (resolution) 72 dpi bo‘lishiga e’tibor berish 
lozim.

Photoshop dasturining o‘zida nafaqat veb-sahifa dizaynini, balki 
sahifaning o‘zini to‘liq yaratish imkoni ham mavjud.

File menyusining Save for Web buyrug‘i aynan shu vazifani 
amalga oshiradi. Ammo aytib o‘tish lozimki, Photoshop dasturi 
rastr grafikasi bilan ishlaganligi sababli, fayllami saqlashda har bir 
pikselning parametri bevosita hisobga olinadi, bu esa, o‘z navbatida, 
yaratilayotgan fayl hajmining ortishiga, keyinchalik esa veb- sahi­
faning sekin ochilishiga sabab bo‘lishi mumkin (137-rasm).
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137-rasm. Veb-sahifa dizaynini yaratish.

Veb-sahifa (137-rasm) yaratish uchun quyidagi ishlar algoritmi- 
ni bajarish kerak:

1) Мои документы papkasida «Veb-sahifa» nomli yangi papka 
yaratiladi;

2) yaratilgan papkaga bir ncchta tasvirli fayllar joylashtiriladi 
(masalan, univer.jpg, library jpg, my teacher.jpg, post.jpg);

3) Photoshop dasturi ishga tushiriladi, 600x800 pks o‘lchamda 
yangi fayl yaratiladi;

4) amaliy darslarda olingan bilimlami va dizaynerlik mahoratini 
qoilab, shaxsiy veb-sahifa dizayni yaratiladi;

5) chiroyli tugmalar yaratish uchun Styles (Стили) paneli 
elementlaridan yoki Blending Options buyrug‘i elementlaridan foy- 
dalaniladi;

6) tasvirlarga badiiylik berish uchun Effects (Фильтры) menyusi 
buyruqlarini qo‘llash lozim. Rang yorqinliklarini o‘rnatish uchun 
Image menyusi bo‘limlaridan foydalaniladi;

7) qo‘yilayotgan har bir matn shrifti va tanlangan ranglaming 
mavzuga qanchalik mos ekanligiga ahamiyat berish lozim;
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138-rasm. Slice tool asbobi muloqot oynasi.

8) biror tugma orqali boshqa faylga murojaat etishni o‘rnatish 
uchun:

Slice tool asbobini tanlab, tugma sohasini ko‘rsatish kerak 
(bizning holda 1-tugma);

9) hosil bo‘lgan bo‘lak ustida sichqonchani ikki marta bosib, 
ochilgan muloqot oynasida quyidagi parametrlarni o‘rnatish kerak 
(138-rasm);

10) Name: 1, URL maydonida post.jpg tugmasi bosilganda 
ochilishi kerak bo‘lgan fayl nomi ko‘rsatiladi;

11 ) File menyusining Save for Web buyrug‘i orqali faylni «Veb- 
sahifa» papkasiga saqlash kerak;

12) Photoshop dasturidan chiqib, yaratilgan sahifaning ishla- 
shini tekshirib ko‘rish kerak;

13)xuddi shu usul bilan boshqa tugmalarga ham murojaatlar 
olrnatish kerak.

Sayt uchun tekstura yaratish

100x100 pik oMchamli yangi qatlam yaratamiz, so‘ngra quyi­
dagi amallami bajaramiz:

1) ikkita rang tanlab, gradiyent asbobini qo‘llaymiz;
2) Filtr > Render > Fibirs buyrug‘ini tanlab, yuqoridagi may- 

donga kiramiz;
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139-rasm. Teksturalarga misollar.

3) son‘gra Filtr > Texture > Texturizer buyrug‘ i muloqot 
oynasida yuqoridagi maydonga kirib, kerakli teksturani tanlaymiz;

4) yaratilgan teksturani jpg formatida saqlab qo‘yamiz.

L iJI Nazorat savollari

1. Tasviming o‘lchamlarini o‘zgartirish uchun qaysi buyruqlardan 
foydalaniladi? Ularga izoh bering.

2. Image Size buyrug‘i sozlash parametrlariga izoh bering.
3. Tasvimi printerga chiqarishdan oldin ko‘rish uchun qaysi buyruqdan 

foydalaniladi?
4. Veb-sahifa yaratish uchun qaysi asboblardan foydalaniladi? Ularga 

izoh bering.
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Glossariy (qisqacha izohli lug‘at)

API (Application Programme Interface) -  amaliy dasturlar 
ishlab chiqish uchun interfeys.

Bitli massiv (bitmap -  битовый массив) -  kompyuter xoti- 
rasida yoki diskda saqlanadigan rastr.

Dizering (dithering -  дизеринг) — turli ranglardagi bir-biriga 
yaqin joylashgan va nuqtalarni qo‘shib yuborish natijasida hosil 
bo‘lgan ranglarning jilolanish illuziyasi.

Dpi (dots per inch) — bir duym uzunlikdagi piksellar soni. 
Rastrda ruxsat berilgan qobillikni o‘lchash birligi sifatida qo‘llanadi.

FIF (Fractal Image Format) -  fraktal siqish usuli bilan siqilgan 
tasvirlar uchun grafik formati.

Foydalanuvchining grafik interfeysi (Graphical User Interfase -  
графический интефейс полльзователя) — grafik elementlar to‘p- 
lami bolib, u foydalanuvchiga kompyuter tizimlarida qandaydir 
operatsiyalarni bajarish uchun xizmat qiladi.

Fraktallar (fractals -  фрактал) -  murakkab formadagi obyekt 
bo‘lib, u oddiy iteratsiya sikllari bilan tasniflanadi.

GIF — Internet tarmog‘ida keng foydalaniladigan rastrli grafik 
format. CompuServe firmasi tomonidan ishlab chiqilgan.

Grafik qurilmaning interfeysi (Graphic Device Interface — 
интерфейс графического устройства) -  Windows operatsion 
tizimning osttizimi (tizimchasi).

JPEG (Joint Photographie Experts Group) -  rastrli tasvimi 
samarali siqish usuli ishlatiladigan grafik format.

Kompyuter grafikasi (Computer graphics — компьютерная 
графика) -  kompyuter yordami bilan tasvimi hosil qilish.

LAW -  axborotni siqish usuli boiib, undan GIF formatli 
fayllarda foydalaniladi.

Liniatura — bir birlik uzunlikdagi nuqtalar soni. Dizering usuli 
bilan rastrlashni tasvirlash uchun foydalaniladi.

MIP mapping — teksturali sirtlami chiqarish sifatini oshirishni 
ta’minlash maqsadida turli rakurslar, ko‘rsatish masshtablari uchun 
bir nechta tekstura variantlarini saqlash.

Oyna (window — окно) — grafik obyekt chiqariladigan soha.
Palitra (palette — палитра) — ma’lum bir tasvir uchun muhim 

bo‘lgan ranglar to‘plami.
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PDF (Portable Document Format) — elektron hu[jat fayllari- 
ning formati.

Piksel (pixel — пиксель) — rastr elementi.
Plotter (plotter — плоттер) — tasvimi qog‘ozga aks ettirish 

uchun mo‘ljallangan vektor tasvirlar bilan ishlovchi qurilma.
Rastrlash (rasterization — растеризация) — tasvir elementlari- 

ning vektor (yoki boshqa) tasnifi asosida rastrli tasvimi hosil qilish.
Rastrda ruxsat berilgan qobillik (resolution -  разрешающая 

способность растра) — rastrlar va rastrli qurilmalarning xarak- 
teristikasi. Bir birlik, masalan, bir duym, uzunlikdagi piksellar 
soni bilan o ‘lchanadi.

Rastrli grafika (raster graphics -  растрная графика) — o‘zaro 
yaqin joylashgan turli rangdagi nuqtalar (piksellar) to‘plami asosida 
tasvimi hosil qilish.

Rastrli shrift (raster font — растровый шрифт) — simvollarning 
rastrli tasvirlar to‘plami.

Rendering (rendering — рендеринг) — axborotni grafik ko‘- 
rinishda aks ettirish jarayoni.

RGB (Red, Green, Blue) — rangning additiv modeli.
Skaner (scanner — сканер) -  grafik tasvirlarni kompyuterga 

kiritish uchun mo‘ljallangan qurilma.
Sprayt (sprite -  спрайт) — rasmning ma’lum bir obyektining 

rastrli tasviri bo‘lib, u bitlar massivida saqlanadi va nusxasi zarur 
joyga tezda ko‘chiriladi.

Teksel (texel (texture element)— тексель) — rastrli tekstura 
sirtida relyeflilik illuziyasini hosil qiladi.

Tekstura (texture — текструа) — bo‘yash stili boMib, obyekt 
sirtida relyeflilik illuziyasini hosil qiladi.

Teksturani filtrlash (фильтрация текстур) — obyektlar sirtiga 
tekstura qo‘yishda tasvirni interpolatsiyalash, o ‘zgartirish usuli.

VMR -  Windows operatsion tizimidagi dasturlarda keng 
foydalaniladigan rastrli grafik format. Tasvir bit shaklidagi massiv- 
larda saqlanadi.

XYZ — Yoritish bo‘yicha Xalqaro komissiya tomonidan qabul 
qilingan rang modelining nomi.

Shrift (font — шрифт) -  kompyuter tizimlarida matnni tas- 
virlash uchun simvollar to‘plami bo‘lib, ular bir xil stilga, o ‘l- 
chamga, akslantirish usuliga ega.

CMY (Cyan, Magenta, Yellow) — subtraktiv rang modeli.
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